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Preface

Welcome to the TB9100 Customer Service Software User’s Manual. This 
manual provides information about the Tait TB9100 Customer Service 
Software in PDF format. You can view it online or print it to obtain want a 
paper copy. It describes how to use Version 3.05 of the Customer Service 
Software. 

■ New users should begin at Part B: Getting Started.

■ For explanations of essential concepts, look in Part A: Introduction. 

■ The rest of the manual assumes that you are familiar with Part C: Basic 
Tasks.

Associated Documentation
The current set of TB9100 product documentation is provided in PDF format 
on the product CD. Updates are made available on the Tait support web. Print 
copies of the documentation are available on request.

Online Help. The CSS also has online Help. It contains more or less the same 
information as this manual. To view it, start the CSS, then press F1 or click the 
Help icon on the toolbar. If you are in a dialog box, click the Help button. The 
Calibration Software also has online Help.

Technical notes are published from time to time to describe applications for Tait 
products, to provide technical details not included in manuals, and to offer 
solutions for any problems that arise. The product CD includes technical notes 
that were available at the time of release. Look for new or updated technical 
notes on Tait’s technical support website. 

Typographical Conventions
‘File > Open’ means ‘click File on the menu bar, and then click Open on the 
list of commands that pops up’. ‘Monitor > Module Details > Channel Module’ 
means ‘click the Monitor icon on the toolbar, then in the navigation pane find 
the Module Details group, and select Channel Module from it.’ 

Within this manual, the following types of alerts are used: Important, Note, and 
Tip. The following paragraphs illustrate each type of alert and its associated 
symbol.

Important: This alert is used to warn about the risk of equipment 
damage or malfunction.

Note: This alert is used to highlight significant information that may 
be required to ensure procedures are performed correctly.

Tip: This alert is used to draw your attention to ways of doing things 
that can improve your efficiency or effectiveness.
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Publication Record

Version Date Description

 MBA-00003-01 January 2005 First release. Describes version 01.00 of 
the CSS.

 MBA-00003-02 January 2005 Describes version 01.01 of the CSS.

MBA-00003-03 March 2005 Describes version 01.10 of the CSS. 

MBA-00003-04 August 2005 Describes version 01.2x of the CSS. 

MBA-00003-05 December 2005 Describes version 2.0x of the CSS. This 
adds the analog gateway, encryption 
support, and a configurable preamble.

MBA-00003-06 May 2006 Describes version 2.1x of the CSS. This 
adds support for an antenna relay, 
configurable digital inputs and outputs, 
the ability to separately configure RF 
repeat and simplex/duplex voting.

MBA-00003-07 March 2007 Describes version 3.05 of the CSS. This 
adds support for the digital fixed station 
interface, for the P25 Console Gateway, 
for RF linking, for the channel coordinator, 
for monitoring the TCCP interface, and for 
centralized voting. Updates to feature 
licenses.
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Part A Introduction

The Customer Service Software (CSS) is a Windows-based 
software program that makes it easy to monitor and configure 
Tait P25 network elements (Tait TB9100 base stations and P25 
Console Gateways). The CSS can also carry out diagnostic tests 
and update firmware. 

The introduction explains fundamental concepts. You need to 
understand them before you can use the CSS effectively.

Topics

Channels

Profiles

Receiver Squelch

Subaudible Signaling

RF Repeat Function

Task Manager

Alarms

Data Logging

Analog Line

Network Element Security

Software Feature Licensing
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Channels

A TB9100 base station consists of the equipment needed to operate on just one 
channel. However, using the CSS you can program up to 255 channels into a 
single base station. This is confusing, until you realize that ‘channel’ has 
different meanings. The one channel is the transmit and receive frequency pair 
and the 255 channels are different channel configurations, each with its own 
number and name. Task Manager selects one of these channel configurations 
and the base station operates according to the settings in it. These consist of a 
transmit and receive frequency pair and many other settings, grouped into a 
number of profiles. The presence of many channels means that base station 
operation can be modified in any of a large number of ways simply by changing 
to a channel with the desired settings. 

 

Channel table Each base station has a channel table. This is the database that stores the channel 
configurations. It is a good idea to maintain a single channel table for the whole 
network of TB9100 base stations. This means that almost the same configura-
tion file can be used for all base stations. To configure a new or replacement 
base station, all you need to do is copy the standard configuration file and make 
a few modifications, for example to the Task Manager statements that select the 
current channel. Working from one configuration file simplifies maintenance. 

Current channel The current channel is the channel that the base station is actually operating on. 
Task Manager action or dispatcher command can select the current channel and 
Monitor > Interfaces > RF Interface displays it. 

Channels in the 
P25 Console 
Gateway

The P25 Console Gateway also has a channel table and a current channel. This 
specifies which channel group the gateway belongs to and which calling profile 
it uses by default. 

Figure 1: Channel terminology

The base station is
equipment for one
channel.

The channel table is a
database with records for up
to 255 channels.

No Name Tx & Rx
Freqs Tx Power Profiles Channel

group
1 Ch 001
2 Ch 002

Channel Table

TB9100

The record  for channel 2
tells the base station
which frequencies and
other settings to use

Task
Manager
selects
channel 2 as
the current
channel

The channel profile (and
other profiles) group channel
settings

The channel group specifies
(for voice calls) which other base
stations this one belongs to
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Profiles

Profiles are groups of settings that configure a network element interface. 

Channel and 
signaling profiles

These profiles configure the RF interface. The channel profile determines 
which modes the receiver supports and (for analog mode) receiver gating and 
channel properties. The signaling profile determines the NAC, any subaudible 
signaling, and transmit tail timers. 

Calling profile The calling profile determines the properties of the analog line as a virtual SU: 
the mode it uses when transmitting, its individual ID, and the group or 
individual that calls are addressed to. The groups it listens to are determined by 
the group membership assigned to the calling profile. The calling profile also 
determines whether calls are encrypted and what key is used. 

Channel group The channel group specifies the group of network elements that this network 
element belongs to. It determines the multicast IP address that the network 
element sends to and receives from. It also configures voting. 

Service profile The service profile determines which digital P25 services are allowed. One 
service profile can be applied to the RF input and another to the analog line input. 

Assigning profiles 
to a channel

Each channel in the channel table must be assigned a set of profiles. Using 
profiles simplifies the work of defining channels. Channels have a large number 
of configuration settings. Instead of configuring them all each time you set up 
a channel, you configure sets of them in profiles. Whenever a different setting 
of a particular configuration parameter is needed, create a new profile. In this 
way, you establish several profiles for each profile type, any of which can be 
selected when defining a channel. Figure 2 shows how different profiles could 
be assigned to channel 2 in the channel table. 

Figure 2: Profiles assigned to a channel in the channel table

No Name Tx & Rx
Freqs Tx power Channel

profile
Signaling

profile
Channel

group
Service
profile

Calling
profile

3 Signaling
profile2 Signaling

profile1 Signaling
profile

3 Channel
profile2 Channel

profile1 Channel
profile

3 Channel
profile2 Channel

profile1 Channel
group

3 Service
profile2 Service

profile1 Service
profile

3 Calling
profile2 Calling

profile1 Calling
profile

1 Ch 001 1 1 1 1 1
2 Ch 002 2 3 2 1 2

3 Group
profile2 Group

profile1 Group
Membership

Group 1 =
Group 2 =
Group 3 =
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Receiver Squelch

The TB9100 supports three basic types of squelch operation. In normal squelch, 
the receiver unmutes if the voice signal has the correct Network Access Code 
(NAC) or subaudible signaling. Selective squelch unmutes only if the voice 
signal is addressed to a specific group or individual. Monitor squelch unmutes 
to almost anything. In addition, for normal and selective squelch in analog FM 
mode, the receiver only unmutes if the voice signal exceeds the configured 
RSSI and/or SINAD levels. You set these levels in channel profiles (Receiver 
gating area). 

The following describes the different types of squelch operation and how to 
configure the TB9100 for them.

Normal squelch In digital P25 mode, the receiver accepts one particular NAC. When an 
incoming signal has that NAC, the receiver unmutes. In analog FM mode, the 
receiver is configured with subaudible signaling (see “Subaudible Signaling” on 
page 6). The receiver only unmutes if it detects the specified CTCSS tone or 
DCS code. You select the NAC, CTCSS, and DCS in signaling profiles.

Selective squelch The base station as a whole does not apply selective squelch. The analog line 
can, in digital P25 mode. This is necessary, because analog console systems 
cannot understand P25 signaling. Accordingly, in the analog line’s calling 
profile you can choose selective squelch.

In analog FM mode, selective squelch can be achieved in subscriber units by 
MDC1200 or Selcall signaling. The analog line simply passes this signaling 
through. The connected analog console system must provide the selective 
squelch, only responding if a configured MDC1200 or Selcall address is 
received. 

Monitor squelch Monitor squelch lets the dispatcher monitor the channel. For received analog 
FM signals, monitor squelch simply provides the demodulated output, 
irrespective of its subaudible signaling. For received digital P25 signals, monitor 
squelch provides any recognizable voice signal addressed to any group or 
individual. To set up monitor squelch, define a calling profile with normal 
squelch and use Task Manager to lock the decoding of the NAC and subaudible 
signaling, so that these squelch mechanisms are bypassed.
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Subaudible Signaling

In analog FM mode, the TB9100 base station can transmit and receive using 
subaudible signaling. Both CTCSS tones and DCS codes are supported. 
CTCSS attaches a subaudible tone to the carrier signal. DCS attaches a digital 
code. A receiver programmed with a particular tone or code will not unmute 
unless that tone or code is presented with the RF signal. 

CTCSS tones and DCS codes are referred to collectively as subtones. Subtones 
make it possible for different groups of users to operate on the same channel 
without hearing or disturbing each other. The base station and the SUs that use 
it need to be programmed with the same subtone(s). 

Important: In some parts of the world, the use of subtones is 
regulated. Confirm with the relevant regulatory authority whether 
and how you can apply subtones.

Assigning 
subtones

You assign a receive and a transmit subtone to signaling profiles, then assign a 
signaling profile to a channel by editing the channel table. When the base 
station is operating on that channel, it opens the receiver gate to signals with 
the receive subtone and transmits using the transmit subtone.

Matching DCS 
codes

Matching the base station’s DCS code to the code programmed into a group of 
SUs can be tricky. This is because the polarity of a DCS code can become 
inverted. For example, a SU has a DCS code of 017 but the base station may 
need to be programmed with 050 (017 inverted). Use simple trial and error to 
see which code works.

Advanced options When using DCS, the base station always transmits a DCS end tone for muting 
the receive audio, but transmitting a CTCSS reverse tone burst is optional and 
configurable.
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RF Repeat Function

A repeater re-transmits what it has received on its RF interface. In the TB9100 
base station, this repeat function is enabled by default but it can be disabled or 
put under the control of the dispatcher. When the repeat function is enabled, a 
standalone TB9100 repeats what it receives, unless it is handling a call from the 
dispatcher or the maintainer at the control panel microphone.

Repeat function 
of a channel 
group

If the TB9100 is part of a channel group, the repeat function is modified. 
Instead of only repeating what it receives on its RF interface, the base station 
repeats the vote-winning signal out of all the valid RF signals that the base 
stations in the channel group receive. A voting process (each base station has its 
own built-in voter) selects the signal to repeat. In effect, the channel group is a 
wide-area repeater; each base station in the channel group repeats the same 
signal. 

If a dispatcher call is in progress, the channel group broadcasts it and does not 
repeat any SU calls. However, if the channel group is duplex, the vote-winning 
SU call is forwarded to the dispatcher.

Configuring the 
repeat function

The repeat function can be enabled or disabled in the channel table. 

Alternatively, the repeat function can be put under dispatcher control, so that 
the dispatcher can turn it on and off as needed. If the dispatch equipment 
connects via the analog line, the command is a tone remote function tone. A 
Task Manager task is needed to detect the tone and enable the repeat. If the 
dispatch equipment is digital and connected via a DFSI, the dispatch command 
operates directly. For dispatcher control of RF repeat in channel groups, see the 
TaitNet P25 System Manual.

It is not possible to configure a base station in a channel group to repeat only 
locally received RF; it must repeat the vote winner. Normally, all base stations 
in the channel group have the same repeat setting. However, it is possible to 
generally enable repeat yet disable it in individual base stations (for example, 
those on solar-powered sites) without disrupting channel group operation.

If pin 1 of the system interface is configured for antenna relay and the receive 
and transmit frequencies are the same, the base station will not attempt to 
repeat. 
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Task Manager

Task Manager is a powerful processing engine that adds intelligence to each 
network element, enhancing its flexibility and configurability. Part of the 
firmware running on the channel module's digital board, Task Manager is able 
to respond to various inputs or operating parameters. Task Manager monitors a 
wide range of network element parameters. If one of them changes, Task 
Manager can take appropriate action, for example by changing channel, setting 
the digital output, or locking a function. A locked function cannot operate.

What action (if any) Task Manager takes depends on the tasks it has been given. 
Using the CSS, you are able to define these tasks. Tasks are statements in a very 
simple programming language. Tasks say what action is to be carried out when 
a monitored parameter changes. All tasks have one of two forms: 

IF input, THEN action

IF NOT input THEN action.

For example: 

IF Tone remote detected (550) THEN Go to Channel 3.

This means that when the analog line receives a tone remote function tone of 
550 Hz, the network element changes to channel 3. 

To define a task, you combine an input with an action, using an intuitive set of 
drop-down menus. No programming expertise is required. The list of tasks, 
defined in this way, is the ‘computer code’ that Task Manager processes. In 
effect, this means that you can modify the network element's firmware-based 
operation without needing to compile new firmware. 

Task Manager is often used for selecting a channel. Task Manager actions can 
select a channel whenever the base station enters Run mode, when a tone 
remote function tone is received from the console system, or when the 
combined value of selected digital inputs changes. 

Task Manager only operates when the network element is in Run mode. 
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Alarms

The network element monitors a large number of conditions. When a 
condition rises above or falls below a defined threshold, the network element 
generates an alarm and stores it in its log. Using the CSS, you can view the 
current status of all alarms (Monitor > Alarms > Status) and a log containing 
recent alarms (Monitor > Data Logging > System Log).

You can also disable any alarms that you do not want (Configure > Alarms > 
Control).  Disabled alarms are disabled in the Alarm status form and do not turn 
on the control panel alarm LED.  However, they still generate a syslog message 
(at the level of Notice) and are inputs into Task Manager. 

Most alarms indicate a fault condition, but some are generated by conditions 
external to the network element, such as mains power failure or high BER on 
the RF input. 

The network element can send alarm (and other) messages to a central message 
collector. 

All alarms are inputs into Task Manager. You can create tasks that tell the 
network element what to do when an alarm is triggered.
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Data Logging

The TB9100 logs events such as alarms, calls, Task Manager actions, and 
signaling events in syslog format. The system log (up to 1000 records) stores 
events at level Notice and above. The trace log (up to 1000 records) stores 
events at Information level. The CSS can view these logs and save them to a file. 

If the TaitNet P25 digital network is set up with a PC running syslog collector 
software, you can configure the network element to send syslog messages to the 
syslog collector. In the CSS (Configure > Alarms > Logging), specify the IP 
address of that PC and select a significance level. Messages with that level or 
higher are sent and messages below that level are not.

In addition, the CSS has its own log: Application.log (the log of the previous 
CSS session is Previous application.log). These log files are in the Log Files 
folder and you can view them in a text editor. 
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Analog Line

The analog line is a 4-wire E & M interface that is usually used to connect 
analog dispatch equipment to a single TB9100 base station or to a P25 Console 
Gateway that is part of a channel group. It can also be used to connect another 
base station, external voting equipment, or recording equipment.

TB9100 base stations and P25 Console Gateways have an analog line. Console 
Gateways are used if the analog line is to serve as an encryption/decryption 
point. 

If a network element will use its analog line in digital P25 mode, it needs an 
analog line license. Additional licenses are required for MDC1200 signaling and 
for encryption. A P25 Console Gateway only needs an additional license for 
AES encryption. 

Install-time configuration of the analog line determines the following:

The type of signaling that is used (E & M, keytone, tone remote function 
tones, MDC1200). 

The expected characteristics of keytone and tone remote function tones

Calling profiles (assigned to channels but also selectable by the dispatcher) 
determine the operating configuration:

Whether calls originating from the analog line are transmitted as analog FM 
or digital P25 calls. 

What source ID is given to calls originating from the analog line, when they 
are transmitted in digital P25 mode.

Which calls are passed to the analog line (which individual ID and group 
IDs are assigned to the analog line).

Whether calls are encrypted and which encryption key is used (applies only 
to P25 Console Gateways).

From the point of view of the radio network, the analog line can be thought of 
as a logical P25 subscriber unit. It is an end-point for calls. It has an individual 
ID and can belong to a number of talk groups. 



 

12 Part A: Introduction    © Tait Electronics Limited March 2007

Network Element Security

Security is protected at the network element and at the CSS. The network 
element is protected through a password. The CSS is protected through access 
codes to privileges. Both protections are optional.

By default, the base station or P25 Console Gateway has no password, but you 
can use the CSS to give it one. The CSS then remembers the password. Each 
time you connect to the the network element, the CSS must authenticate itself. 

The CSS has three different privileges: Guest, Maintainer, and Administrator. 
On starting the CSS, you automatically have the Guest privilege. If access codes 
have been set, when you try to carry out an operation requiring the Maintainer 
or the Administrator privilege, the CSS asks for the corresponding access code. 
If access codes have not been set, you automatically have all privileges. An icon 
on the toolbar indicates your current privileges. 

Access codes can be set at installation time or during any CSS session. 

The following operations require Maintainer or Administrator privileges:

All other operations only require Guest privilege. 

Operation Maintainer Administrator

Save configuration files X

Program configuration X

Change mode X

Perform diagnostics X

Change network element password X

Reset network element X

Edit connections file X

Download firmware X

Enable additional features X

Change privilege access codes X

Zeroize encryption keys X
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Software Feature Licensing

The TB9100 base station and the P25 Console Gateway have many capabilities, 
but some of them require a license before you can use them. Without any 
licenses at all, these network elements can communicate with the CSS but can 
only operate in Standby mode. Using the CSS, you can enable (license) the 
additional features that are required. 

Note: Licensing a feature allows the use of that feature. However, 
you often need to also enable the feature in configuration using the 
CSS before that feature becomes operative. The CSS will let you 

enable or configure a feature even if you do not have a license for it, but the 
feature will not work.

The following features are available:

Default Radio 
System

The default radio system feature allows the base station to transmit and receive 
analog FM transmissions.

P25 Common Air 
Interface

The P25 common air interface feature allows the base station to transmit and 
receive P25 digital voice transmissions.

Note: If neither of the above features are licensed, the network 
element cannot operate in Run mode. 

Analog Line The analog line feature allows the base station or P25 Console Gateway to make 
digital P25 speech calls from the analog line and to pass received digital P25 calls 
to the analog line. This feature is not needed for analog FM mode, for tone 
remote signaling, or for TSBKs.

Networking with 
Distributed Voter

The networking with distributed voter feature enables channel group services. 
It allows the network element to send and receive voice data streams from other 
channel group members and to function as a distributed or a satellite voter.

Packet Data 
(reserved)

The packet data feature allows a network element to pass packet data to a 
destination IP address on the network. (Not currently supported). Packet data 
that is handled by a trunking site controller does not need this license.

MDC1200 
Signaling on 
Analog Line 

The MDC1200 signaling on analog line feature allows the conversion between 
MDC1200 signaling and P25 TSBKs. Console systems can then use MDC1200 
for ANI and other subscriber signaling to and from SUs that are operating in 
P25 digital mode. (In analog FM mode, network elements pass MDC1200 on 
transparently and do not need this feature.) 

Transmit Enable Base stations normally have the transmit enable feature. This allows the reciter 
to provide a signal for transmitting. Receive-only base stations do not need this 
feature. P25 Console Gateways cannot be licensed to transmit.

External Trunking 
Interface 

The external trunking interface feature allows a base station to become a 
trunking master, functioning as an interface between the trunking site 
controller and the channel group. The availability of this feature license is 
restricted.

P25 Base 
Encryption and 
Key Loading

The P25 base encryption and key loading feature allows the P25 Console 
Gateway to encrypt and decrypt speech using the DES algorithm.
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P25 AES 
Encryption

The P25 AES encryption feature allows a P25 Console Gateway with a base 
encryption feature to also encrypt and decrypt speech using the AES algorithm.

SNMP (External 
Trunking)

The SNMP (external trunking) feature allows the base station to accept SNMP 
requests from a SNMP network manager. The base station can then provide 
information from its management information base (MIB) to an external 
management system. The availability of this feature license is restricted.

Digital Fixed 
Station Interface

The digital fixed station interface feature allows a DFSI connection to a digital 
dispatch system (fixed station host), in conventional systems. The base station 
or P25 Console Gateway can then be an interface between its channel group 
and a digital dispatch system. 

Networking with 
Centralized Voter

The networking with centralized voter feature allows the network element to 
act as a central voter within its channel group. This feature also allows voice 
networking. Only network elements that will centrally vote (normally the 
central voter and its backup) need this feature. The other members of the 
channel group only need the networking with distributed voter feature.

Simulcast 
Transmitter

The simulcast transmitter feature (not currently supported) will be required in 
base stations that have transmitters and belong to a simulcast network.
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Part B Getting Started

To establish a CSS session with a base station, connect to it using 
the CSS software. If the CSS PC is physically connected to a 
TaitNet P25 digital network, you can connect remotely to any 
base station in the network.

In a CSS session, you can monitor the base station and carry out 
diagnostic tests. You can also view and modify its configuration.

The CSS can work with TB9100 base stations and with P25 
Console Gateways.

Topics

Connecting

Monitoring Alarms

Monitoring the Base Station

Viewing Configuration Settings

Diagnosing Problems
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Connecting

The following instructions describe how to routinely connect a CSS to a base 
station. For more details, see “Connecting” on page 28 and for information 
about connecting to a network element for the first time, see the Installation 
and Operation Manual. 

To connect to a base station

1. If the CSS is not already running, select Start > Programs > Tait 
Programming Applications > TB9100 CSS vn.nn.nn > TB9100 CSS, where 
n.nn.nn is the current CSS version number.

2. Make sure that the PC running the CSS is connected via an Ethernet cable 
to a hub on the TaitNet P25 digital network or directly to the base station’s 
Ethernet interface. 

3. On the toolbar, click the Connect icon. The Connections dialog box 
appears.

4. Select a row in the list of network elements. If the base station's IP address 
has not been changed, select ‘Default base station.’

5. Click Connect.
If the CSS asks for a base station password and one hasn’t been set, just click 
OK.

The CSS establishes a connection to the selected network element. The 
Status bar displays ‘Connected.’

You can now monitor the base station, conduct diagnostic tests, and read and 
modify the base station configuration.
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Monitoring Alarms

When the CSS is connected to a base station, it regularly polls the base station 
for alarms. If an alarm is detected, a flashing Alarms icon appears in the status 
bar. If the Alarms icon disappears, the CSS has detected that the alarm was 
cleared.

To monitor alarms

1. Check the status bar. If it has a flashing Alarms icon, click the Alarms button 
on the toolbar. This opens the Status form.

2. Look to see which LED is flashing red. A flashing LED means that the alarm 
is on. One problem can set off more than one alarm. A gray LED means that 
the alarm has been disabled (Configure > Alarms > Control) or that the 
function it monitors is unavailable.

Note: Many monitoring forms have an Alarm status LED, which 
indicates whether the module has any active alarms.
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Monitoring the Base Station

Once the CSS is connected to a base station, you can monitor various aspects 
of it. 

To view a monitoring form

1. On the toolbar, click Monitor. The navigation pane displays a menu of 
options. 

2. In the navigation pane, click a subheading (for example ‘Channel Module’).

The main part of the CSS window displays information relevant to the 
subheading.

Options To view the current status of all base station alarms, select Monitor > Alarms 
> Status.

To see what is happening at a base station interface, select an item under 
Interfaces.

To see what is happening inside a base station module, select an item under 
Modules.

To see the voting behavior and configuration settings of all channel group 
members, select Monitor > Channel Group > Status.

To view the contents of a log that the base station has recorded, select an 
item under Data Logging.
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Viewing Configuration Settings

From the CSS, you can view a base station’s configuration settings. Connect to 
the base station and then instruct the CSS to read the configuration.  

To view configuration settings

1. On the toolbar, click Read. 

The Reading dialog box displays progress.

2. On the toolbar, click Configure. The navigation pane displays a menu of 
options. 

3. In the navigation pane, click a subheading (for example ‘Channel Table’); 
the main part of the CSS window changes to display the corresponding 
form. 

In this way, you can view any aspect of the base station’s current 
configuration. 
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Diagnosing Problems

From the CSS, you can carry out a variety of tests on aspects of the base station 
you are connected to. These can help diagnose any problems you may be 
experiencing. 

To carry out a diagnostic test

1. On the toolbar, click Diagnose. The navigation pane displays a menu of 
options. 

2. In the navigation pane, click a subheading (for example ‘Self Tests’); the 
main part of the CSS window changes to reflect your selection. 

3. If the rectangle beside the Start Test button is yellow and gray, click 
Standby on the toolbar to put the base station in Standby mode. 

4. Click Start Test. View the results of the test on-screen.

5. If necessary, click Stop Test.

6. Return the base station to Run mode. 
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Part C Basic Tasks

Before getting down to the real work on a TB9100 base station 
or P25 Console Gateway, you need to know how to carry out 
basic tasks such as setting up a connection, changing mode, and 
reading configuration information. 

The Basic Tasks section explains in detail how to do these and 
other preliminary tasks. 

Topics

Using the Customer Service Software

Network Element Operations

Working with Configurations

Working With Different Network Elements

CSS Tools

CSS Options
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Using the Customer Service Software

The following topics describe starting the CSS, the application window, the 
toolbar and the status bar. 

Starting the CSS
To start the CSS software, select Start > Programs > Tait Programming 
Applications > TB9100 CSS vn.nn.nn > TB9100 CSS, where n.nn.nn is the 
current CSS version number.

Tip: Run multiple instances of the CSS software (supported in 
version 3.00 and above) on your PC and use them for example to 
simultaneously monitor alarms at several network elements.

Application window
When you start the CSS, a splash screen appears, followed by the application 
window. 

By default, the Monitor icon on the toolbar is selected and the navigation pane 
displays options for monitoring. Click an item in the navigation pane and the 
main pane displays the corresponding form.

Navigation pane

Status bar

Menu bar

Main pane

Toolbar
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Toolbar
The toolbar gives quick access to commonly used menu commands. For 
example, instead of selecting Functions > Configure, click the Configure icon 
on the toolbar.

Open Opens a dialog box that lets you open a configuration file that is stored on the 
CSS computer.

Save Saves the open configuration. When saving a configuration file for the first 
time, you are asked to give it a name. 

Connect Opens a dialog box that lets you connect to a network element. See also 
“Connecting” on page 28. If you are connected, this icon displays 
‘Disconnect.’ Click it to disconnect from the network element.

Read Reads in the configuration information of the network element you are 
connected to. See also “Working with Configurations” on page 34.

Program Sends the whole set of configuration information in the CSS to the network 
element. The network element must be in Standby mode. Once the 
configuration has been programmed, the network element operates using that 
configuration. See also “Working with Configurations” on page 34.

Standby Puts the connected network element into Standby mode. 

Run Puts the connected network element into Run mode. 

Monitor Displays the Monitoring navigation pane so that you can monitor the 
connected network element. See also “Monitoring the Base Station” on 
page 19.

Configure Displays the Configuration navigation tree, so that you can view and edit 
configuration information. If a configuration is not already selected, you are first 
given the option of creating a new configuration, opening an existing one, or 
reading the network element’s current configuration. See also “Viewing 
Configuration Settings” on page 20.

Diagnose Displays the Diagnose navigation tree, so that you can carry out diagnostic tests 
on the connected network element. See also “Diagnosing Problems” on 
page 21.

Alarms Turns red when any network element alarm is triggered. Click Alarms to 
display the current status of all network element alarms. See also “Monitoring 
Alarms” on page 143.

Privileges Displays the current privileges. If the keys have the background color, you have 
Guest privilege. If the upper key is yellow, you have Maintainer privilege. If 
the lower key is red, you have Administrator privilege. Click Privileges to 
change privileges. See “Changing Privileges” on page 47.

Help Displays a Help topic for the current form.
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Status Bar
The status bar provides useful information that supplements the display in the 
main pane.

 

Panels in the status bar provide the following: 

CSS status information, for example whether the CSS is reading or 
programming a configuration. ‘Ready’ means that the CSS has completed 
the last user request and is ready to respond to another request.

Flashing alarm icon (when an alarm is triggered).

The mode that the network element is currently in (Run or Standby).

Whether the CSS is connecting, connected, or not connected to a network 
element.

The IP address of the network element.

The name of the network element.

Connection status 
CSS status Current modeFlashing alarm icon Network element IP address

Network element name
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Network Element Operations

The CSS can connect to any base station or P25 Console Gateway in the 
TaitNet P25 digital network. Once connected, you can change its operating 
mode or its password. If the network element is not operating correctly, you 
can reset it. 

Connecting
Before you can work with a network element, the CSS must connect to it. A 
connection establishes a communication session with the network element. 
Data can go back and forth, for example, to display monitoring information or 
to carry out a diagnostic test. However, a further step is necessary before you 
can work with configuration information: you must read the network element 
or open a configuration file, even to view the configuration forms.

To connect to a network element

1. Make sure that the CSS PC is connected physically to the network element. 
It can be connected by an Ethernet cable to a hub on the TaitNet P25 digital 
network or directly to the network element’s Ethernet line. For the direct 
connection, an ordinary or a crossover Ethernet cable can be used; the 
Ethernet interface supports both. 

2. Make sure that the CSS PC has a suitable IP address and subnet mask. The 
network administrator can help with this. You may need to vary the settings 
of your local area connection, depending on whether you are on site or in 
the office. See also “Connecting a Networked PC to a Network Element” 
on page 29. You may also need to tell the PC how to route to the TaitNet 
P25 digital network, see “Defining Routes for a Networked PC” on 
page 29.

3. Run the CSS software.

Important: If the PC is running multiple instances of the CSS, make 
sure that you do not connect a second CSS to the same network 
element. The network element allows this but it is not supported 
and it is likely to cause problems. 

4. On the CSS toolbar, click Connect. The Connections dialog box appears 
and displays a list of network elements that you can connect to.
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5. Click on the row with the network element name and IP address. If the 
network element is not in the list, click Edit Connections and add it. (See 
“Maintaining the Connection List” on page 39 for instructions).

6. Click Connect.

If the CSS does not know the network element password, it asks you to 
supply it. 

If the network element is new, don't enter anything; just click OK. This is 
because network elements are supplied with a null password. (When you 
make subsequent connections, the CSS does not ask for a password, because 
it now knows that the network element password is null.) 

To set a network element password, wait till you are connected, and then 
select Element > Change Network Element Password. You can only set the 
password once the CSS is connected to the network element. 

Once the connection is established, ‘Connected’ appears in the CSS status bar. 
If there is a connection icon in the system tray of the operating system, it 
indicates whether there is any network traffic. Hovering the mouse over it pops 
up information about the connection speed and the number of packets sent and 
received. 

Note: The network element can only have a single CSS session at 
any one time. If you are connected, this prevents other CSS users 
from connecting.

Defining Routes for a Networked PC
You may need to define routes so that the PC uses the correct IP routing path 
to the TaitNet P25 digital network. Without a correct entry in the network 
routing table, the CSS will be unable to remotely connect to the network 
element. To define a route, use the ‘route’ command. The operating system 
Help gives assistance on the use of this command. 

To define a route

1. Select Start > Run.

2. Enter cmd.

3. At the command line prompt, enter route print. 

4. If the displayed list of persistent routes at the bottom of the output does not 
provide a route to the TaitNet P25 digital network, add one or more 
persistent routes in the format:

route -p add destination mask subnetmask gateway

For example: 

route -p add 172.16.16.0 mask 255.255.240.0 172.25.206.252

Connecting a Networked PC to a Network Element
You may want to temporarily disconnect a networked PC from its LAN in 
order to be able to establish a direct connection with the TB9100. A physical 
connection is needed as well as an alternate (Windows XP) or temporary 
(Windows 2000) IP address and subnet mask. 
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To connect from a PC with Windows XP professional 

1. Remove the local area Ethernet connection and connect an Ethernet patch 
cable between the PC and the TB9100. (Either a straight through or 
crossover Ethernet patch cable may be used with the current TB9100 
software.)

2. Click Start > Control Panel.

3. Double-click Network Connections.

4. Double-click the Local Area Network icon.

5. Click Properties.

6. Click Internet Protocol (TCP/IP), and then click Properties.

7. Click Alternate Configuration.

8. Select the User configured option, and then enter a number that is on the 
same subnet as the network element. For example, if the TB9100 has IP 
192.168.1.254, enter 192.168.1.1 for the PC. 

9. Enter a suitable subnet mask, for example 255.255.255.0.

The CSS should now be able to connect to any physically connected 
network element that is on the same subnet.

10.Once the CSS session is finished, re-connect the local area network cable to 
the PC. The PC then uses its normal TCP/IP properties. 

To connect from a PC with Windows 2000

1. Remove the local area Ethernet connection and connect an Ethernet patch 
cable between the PC and the TB9100. (Either a straight through or 
crossover ethernet patch cable may be used with the current TB9100 
software.)

2. Select Start > Settings > Network and Dialup Connections.

3. Double-click the Local Area Connection icon.

4. Click Properties. 

5. Click Internet Protocol (TCP/IP), and then click Properties.

6. Note the current settings so that you can restore them later.
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7. Select Use the following IP address, and then enter a number that is on 
the same subnet as the TB9100 base station or P25 Console Gateway. For 
example, if a TB9100 has IP 192.168.1.254, enter 192.168.1.1 for the PC. 

8. Enter a suitable subnet mask, for example 255.255.255.0.

The CSS should now be able to connect to the network element.

9. When you have finished the CSS session, re-connect the local area network 
cable to the PC and then restore the original PC configuration. When you 
close the Network connection dialog box, the restored configuration is 
applied.

Troubleshooting Connection Problems
If the attempt to connect to a network element failed, consider these possible 
causes.

1. You have just switched the network element on and it is not yet ready. Try 
again.

2. Another CSS is connected to the same network element. A message is 
displayed indicating this.

3. Another CSS was connected to the same network element and the session 
did not complete properly. Wait one minute and try again.

4. You have just calibrated the network element. The network element is still 
in calibration mode and cannot respond to connection requests. Reset the 
network element.

5. You are attempting to connect to the wrong IP address. Check that the 
correct IP address is correct. 

6. The network element is not yet using the IP address you are attempting to 
connect to. A previous session changed the network element’s IP address. 
The network element configuration specifies the new address but the 
network element is still using the old IP address. Reset the network element. 

7. The link to the network element is down. Use ping to check.

8. A router on the link uses network address translation. You need to connect 
using the router IP address, not the network element IP address.

9. The firewall is blocking access to the network element. Ask the system 
administrator to give you access.
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Disconnecting
When you have finished working with a network element, click Disconnect on 
the toolbar. Alternatively, press F9 or select Element > Disconnect. You are 
now ready to connect to another network element.

If the network element is in Standby mode, the CSS reminds you of this and 
asks you to confirm that you want to proceed. This is to make sure that you do 
not inadvertently leave the network element out of service after a CSS session. 
Select No to cancel disconnecting, and then change the network element’s 
mode back to Run before disconnecting. 

Changing Mode
Normally, the network element operates in Run mode. However, some 
functions arae only available in Standby mode.

Run mode is used for normal operation. 

Standby mode takes the network element out of service. It is required if you 
want to program a configuration into the network element or carry out 
invasive diagnostic tests (for example to determine the lock range). In 
Standby mode, a base station cannot repeat across its RF interface or send 
and receive on the digital line. This means that SUs cannot talk to or hear 
each other. Dispatchers and SUs also cannot talk to or hear each other. 
However, the control panel is still effective; the maintainer can talk to and 
hear SUs. If the base station’s channel group interface is duplex, the main-
tainer can also talk to and hear any dispatcher connected to the analog line. 

If the network element is still in Standby mode when you end a CSS session, 
you are asked to confirm. This is so that you do not inadvertently leave the 
network element out of service.

To put a network element in Standby mode

1. Connect to the network element.

2. On the toolbar, click Standby. You are asked for confirmation.

Once the network element has gone into Standby mode, the status bar 
displays the Standby icon. Functions such as programming a configuration 
into the network element are now enabled. 

To put a network element in Run mode

1. If necessary, connect to the network element.

2. On the toolbar, click Run. The network element is now fully operational.

If the network element cannot go into Run mode, the CSS displays an error 
code.

Error codes 1 and 2: Check to see which alarms are displayed and take 
appropriate action.

Error code 4: return the channel module to Tait.

Error code 10: The network element does not have the licenses that enable 
it to operate in Run mode. Obtain one or more licenses and use the 
Software Feature Enabler to let the network element operate in analog FM 
and/or digital P25 modes.
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Assigning a Network Element Password
Each network element can be given a password to safeguard access to it. A CSS 
must know the password before it is able to connect to the network element. 
If you do not give the network element a password, any CSS can connect to it. 
If you assign or change a password, users of other CSS PCs will need it before 
they can connect to the network element. 

To assign or change a network element password

1. Connect to the network element.

2. Select Element > Change Network Element Password. 

3. If requested, provide the Administrator access code. The Password - 
Network Element dialog box appears.

4. If you are changing an existing password, enter that password. Otherwise 
leave the Current password box empty.

Note: If the network element password is lost, contact your Tait 
dealer. 

5. Enter the new password.

6. Re-enter the password in the next box.

7. Write down the new password and do not lose it; there is no other way to 
find out what a password is. 

8. Click OK to change the password and close the dialog box. The CSS sends 
the password to the network element and stores it in an encrypted form. It 
will use this password to authenticate itself when establishing a connection 
to the network element.

9. Inform any other CSS users of the password.

Resetting the Network Element
The CSS can remotely reset the network element. This may become necessary 
if the network element stops functioning properly.

1. Select Element > Reset Network Element.

2. Wait for the network element to restart, and then connect to it again. 
Attempts to connect before the control panel LEDs have been turned off for 
at least 10 seconds will fail.
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Working with Configurations

Network elements are programmed with many configuration settings. Using 
the CSS, you can view these settings, change them, and then program them 
into the network element.

Configuration works differently from other CSS functions. Once you are 
connected to a network element, you can monitor it but you can’t yet view 
its configuration. First you must click the Read icon, which instructs the 
network element to supply its configuration information.

Programming the network element with a new configuration can only be 
done when the network element is in Standby mode.

It is a good idea to always save a configuration to file immediately before 
programming it into a network element. 

The CSS can obtain configuration information from a network element, 
from a configuration file on disk, or from the default configuration template. 

Creating a New Configuration
You can create a new network element configuration from scratch, modify it, 
and save it as a new configuration. This means that you can define a 
configuration without being connected to a network element. This is a good 
way to learn how to use the configuration part of the CSS program. It also 
means that you can do all the work of configuring before a network element is 
delivered. When the network element arrives, you just open the configuration 
file and program it in. (This method completely overwrites the network 
element’s current settings.)

Figure 3: Obtaining and storing configuration information
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To create a new configuration

1. Select File > New. 

2. Click Configure in the toolbar and make the desired configuration 
changes. 

3. Select File > Save As, give the configuration a name, and save it. 

Reading a Network Element Configuration
Before you can view a network element’s configuration settings, the CSS must 
read them. 

Note: If the CSS has an open configuration file, save it first; reading 
a configuration overwrites any configuration that the CSS has in 
memory. 

To read a configuration

1. Connect to the network element.

2. Click Read.

The CSS reads the network element’s configuration information. 

The Reading dialog box displays progress and gives you the option of 
canceling the process. 

Once reading the configuration is complete, click Configure. You can now 
view the current configuration settings, make any configuration changes, and 
save the configuration settings to a file. You can also put the network element 
into Standby mode and program it with the new settings. 

Saving a Configuration
It is a good idea to regularly save your current configuration settings as you 
work on them. Save them just before you program them into a network 
element. This gives you a backup, in case the network element fails or the 
configuration is corrupted.

To save configuration settings

1. After making any changes to configuration settings, click OK to confirm 
them.

2. Click Save on the toolbar.

If the configuration settings are already named, they are saved. If not, the 
Save File As dialog box appears. Continue as follows:

3. Enter a name for the configuration file into the File name box.

4. To save the configuration file somewhere other than in the Configurations 
folder, navigate to another folder.

5. Click Save. The file name appears on the CSS title bar. 
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Programming a Configuration into a Network Element
Any configuration changes made using the CSS only take effect once they have 
been programmed into the network element. Programming only affects the 
settings that you can view after clicking Configure.

To program a configuration into a network element

1. If you have made any changes to the current form, click OK to confirm 
them. 

2. Make sure that the current configuration settings displayed in the CSS are 
what you want.

3. Connect to the network element (if you aren’t already). 

4. Put the network element into Standby mode. 

5. Select File > Save to create a copy of the configuration settings as a file in 
the Configurations folder.

6. Click Program. 

7. If the configuration in the CSS has a different IP address or subnet mask to 
that of the network element, you are asked for confirmation. Click 
Overwrite to change the network element’s IP address or subnet mask. 
Click Keep Existing to program the configuration into the network 
element but keep the network element’s existing IP address and network 
mask. 

The Program dialog box appears and indicates the download progress. 
When the network element has successfully received all the configuration 
settings and programmed them in, the dialog box closes. 

If the download is not completely successful, programming is aborted and a 
message appears. Later, you can open the file you saved and try again. 

8. If you changed the network element’s IP address or subnet mask, reset the 
network element so that the new parameters take effect.

9. Return the network element to Run mode.

Synchronizing a Configuration File
Synchronizing a configuration file with the configuration on a network element 
makes sure that the file has the same settings as are in the network element itself. 

Tip: Synchronizing a configuration file is the quickest way to make 
a network element’s configuration available to the CSS.

To synchronize a configuration file

1. Select File > Open and open the configuration file for the network element.

2. Connect to the network element and click Read on the toolbar.

3. Save the file. 

Handling Older Configuration Versions
If you read a network element configuration (or open a configuration file) and 
its version is older than the CSS, a warning appears. This is because the CSS 
and the network element communicate configuration and monitoring data 
based on a database with a defined structure. If the network element and the 
CSS have the same version, they share the same database structure. 
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Generally speaking, it is best to use a CSS with the same version as the network 
element that you intend connecting to. Use an older CSS whose version 
matches the network element, or upgrade the network element firmware to 
match the CSS. 

If you continue to work with an older configuration, the following occurs.

Reading an older 
configuration

If you read a configuration from an older network element:

The CSS displays new data items and gives them default values.

The CSS cannot display data items that have been removed from the newer 
database. You cannot view or change them. 

Programming If you program this configuration back into the network element, the following 
occurs.

The network element cannot store or use new items. They are ignored. 

Data items that are no longer supported by the new CSS remain unchanged. 

If you save the configuration, the CSS saves it in the new configuration version. 

Handling Newer Configuration Versions
If you read a network element configuration (or open a configuration file) and 
its version is newer than the CSS, a warning appears. This is because the CSS 
and the network element communicate configuration and monitoring data 
based on a database with a defined structure. If the network element and the 
CSS have the same version, they share the same database structure. 

Generally speaking, it is best to use a CSS with the same version as the network 
element that you intend connecting to. Install the new CSS and use it; you can 
have many different CSS versions on your PC at the same time. 

If you continue to work with a newer configuration, the following occurs.

Reading a newer 
configuration

If you read a configuration from a newer network element: 

The CSS cannot display new data items.

The CSS displays data items that the network element no longer supports 
and gives them default values. 

Programming If you program this configuration back into the network element, the following 
occurs.

The network element cannot store or use the data items that it no longer 
supports. They are ignored. 

New data items remain unchanged.

If you save the configuration, the CSS saves it in the old configuration version. 
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Working With Different Network Elements

The CSS can monitor, configure, and carry out diagnostic tests on different 
TaitNet P25 network elements. Network elements include various types of 
TB9100 base station and P25 Console Gateways. These in turn consist of 
various module combinations. The following gives some guidance on how to 
use the CSS with different module combinations.

Single-channel 
Base Station

For a subrack with a PMU and a single reciter and PA, there are no special 
considerations.

P25 Console 
Gateway

The P25 Console Gateway has a channel table and profiles, like a TB9100 base 
station. It has no RF interface, so forms that monitor, configure, or diagnose 
that interface have no effect. There is no PA. Like a TB9100, the gateway oper-
ates on a channel that is selected by Task Manager action. The channel specifies 
the channel group that the gateway belongs to and the default calling profile. 

PMU If present, the PMU is associated with channel module 1 (the right-most reciter 
or gateway module in the subrack, looking from the front). When the CSS is 
connected to another channel module, it cannot monitor, configure, or 
diagnose the PMU. The Alarm Status form will report ‘No PMU detected’ and 
other PMU alarm LEDs will be gray. Power configuration settings (Configure 
> Base Station > Miscellaneous) are editable, but have no effect. PMU control 
tests also have no effect.

Disable the ‘No PMU detected’ alarm for channel modules other than 
channel module 1.

Make sure that any Task Manager actions involving the PMU are 
programmed into channel module 1. 

If there is no PMU, disable the ‘No PMU detected’ alarm on all channel 
modules.

PA Receive-only base stations and P25 Console Gateways have no PA. The Alarm 
Status form will report ‘No PA detected’ and other PA alarms will be gray. PA 
control tests have no effect.

Disable the ‘No PA detected alarm (Configure > Alarms > Control). This 
stops the control panel alarm LED flashing because of this alarm. 

Fan alarms Fan alarms are passed from the fan via the control panel to the channel module 
that is currently selected on the control panel. The CSS cannot monitor fan 
alarms if it is connected to a different channel module. The display of fan states in 
Diagnostic forms will only be correct for the currently selected channel module.

Make sure that any Task Manager actions involving the fans are 
programmed into channel module 1. 

Disable the Fan failed’ alarm for any fan that is not fitted.

Disable the PA ‘Fan failed’ alarm for all channel modules, except (if it has a 
PA) reciter 1.

Disable the PMU ‘Fan failed’ alarm for all channel modules, except (if there 
is a PMU) channel module 1.

We recommend that you select channel 1 on the network element’s control 
panel, so that fans can be remotely monitored by connecting a CSS to 
channel module 1. (Other channel modules can be selected during on-site 
monitoring and diagnostics.) 
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CSS Tools

The Tools menu gathers together less commonly used operations.

Maintaining the Connection List
Select Tools > Connections to open the Connections List dialog box. This is a 
simple text editor for maintaining the list of network elements that the CSS can 
connect to. This list is stored in the host information file (conncfg.dat).

To add a network element to the list

1. Select Tools > Connections.

2. In the Connection List, enter the name of the network element and its IP 
address. The entry should have the following format:

Network element name = 172.25.206.26

3. To avoid confusion, make sure that the same name is programmed into the 
network element (Configure > Channel Group > Network Identity). 

4. If desired, copy the file containing the connection list to other PCs that run 
CSS.

Alternatively, use any text editor to edit the conncfg.dat file.   

Firmware Download
You can use the CSS to update the firmware of network element modules. This 
is a two-stage process. First the CSS downloads the firmware to the network 
element (this can be done in Run mode and does not affect network element 
operation). Then the network element takes itself out of service and activates 
the downloaded firmware. After activation, the network element resets itself. 

Note: The CSS cannot update the network board’s operating system 
kernel and some of its firmware. These items must be updated using 
TFTP, see TN- 977b.

The network element is supplied with all necessary firmware, but it may 
become desirable to upgrade to a newer version. It is also possible to downgrade 
a module to an older firmware version to ensure compatibility with other 
network element modules. The release notes contain a compatibility table 
indicating the hardware versions that are compatible with any particular 
firmware version. The CSS also prevents the downloading of firmware that 
would lead to incompatibility between firmware and hardware or between 
modules.

Important: For security reasons, upgrading or downgrading 
network board firmware zeroizes any stored encryption keys. 
Before upgrading the firmware in a gateway module, make sure that 

you will be able to immediately re-load these keys.

Firmware Download Form
The Firmware Download form (Tools > Firmware Download) displays 
information about the versions installed on the network elements and in the set 
of firmware that you select. You can initiate a download and monitor its 
progress.
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Download
Use the Download area to select a set of firmware for downloading. The area 
displays information about the firmware in the selected set and the hardware 
that it is compatible with. 

In the list box, select a set of firmware. The drop-down list displays the available 
firmware sets. (The CSS looks for firmware files in the folder specified by 
Options > File Folders.) 

The rest of the Download area displays version numbers of the individual items 
of firmware in the selected set: Network board, power amplifier, power 
management unit, digital board, and crypto module (P25 Console Gateway 
only). It also shows the versions of hardware that the firmware can work with. 

When you install the CSS, firmware for the different network element modules 
is copied into a folder that different CSS versions can access. A compatibility 
file is also copied over. Firmware versions are also available from the Tait 
support website. 

Firmware The version of the firmware in the set of firmware that you selected. ‘Loaded’ 
instead of a version number means that the firmware version in the selected set 
is the same as the firmware version already installed in the connected network 
element.

Kernel The version of the network board’s operating system kernel that is required for 
working with the network board firmware. A ‘-’ means that there is no 
particular kernel version required. ‘Loaded’ means that the kernel version 
required is present on the connected network element. A red version number 
means that the kernel version installed on the connected network element is 
incompatible with the network board firmware in the firmware set you 
selected. To upgrade the kernel, follow the instructions in TN-977b. This also 
upgrades the network board firmware. 

Required 
hardware

The range of version numbers of hardware that is compatible with the 
corresponding firmware. Version numbers below the minimum or above the 
maximum displayed are not compatible.

If the version numbers are displayed in red, the firmware version in the selected 
set is incompatible with the hardware or kernel version of the connected 
network element. You are unable to download.

Force download Enable the Force download check box to repeat the download of a firmware 
version. When the Force download check box is selected and you click 
Download, all firmware files in the set are downloaded. When the check box 
is cleared, firmware files that display ‘loaded’ are not downloaded. 
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Installed Versions
The Installed Versions area displays the version numbers for firmware, kernel, 
and hardware that are currently installed in the connected network element. It 
also displays the serial numbers of each module, so that you can check that you 
are connected to the correct modules. 

Downloading Firmware
A set of firmware files is copied into the CSS’s Firmware Files folder at 
installation. More recent firmware can be obtained from the Tait support site. 
Copy the file containing the set of firmware (firmware.exe) to the Firmware 
Files folder (the default location is C:\Program Files\Common Files\Tait 
Programming Applications\TB9100 CSS\Firmware Files) and run it to extract 
the individual firmware files.

Important: Save a backup copy of the network element 
configuration before downloading firmware. This is a precautionary 
measure; the backup may be needed if the firmware download does 

not successfully complete on the first attempt.

To download new network element firmware

1. Run the CSS software and connect to the network element. 

2. Read the network element’s configuration and save it to a file, so that if 
necessary, you can restore it manually (see “Manually Updating the 
Configuration” on page 43).

3. Select Tools > Firmware Download. The Firmware Download dialog box 
appears. 
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The CSS obtains information about the network element’s modules and 
displays it in the Current versions area. 

4. Under Download, select the firmware file set you want to download. The 
version numbers of each firmware item in the set appear in the Download 
area. If the firmware item is already downloaded and activated, its display is 
disabled and shows ‘Loaded.’ 

5. If version numbers in the Required Hardware column appear in red, the 
selected firmware is incompatible with the network element’s current 
hardware. You cannot download the firmware.

6. If the Kernel version appears in red, you must first update the kernel. For 
instructions, see TN-977b.

7. Click Download. 

The CSS downloads firmware for the modules you selected. This is a 
background activity and can proceed while the network element is in Run 
mode. The bottom of the dialog box indicates progress.

The network element sends its configuration to the CSS, which temporarily 
stores it. The network element then goes into Standby mode and activates 
the downloaded firmware by programming it into flash memory. The 
network element resets itself. The CSS waits 30 seconds for the network 
element to get up and running, and then re-establishes the connection and 
loads the stored configuration back into the network element, adding any 
new data items used by the new firmware. 

8. When the CSS asks you whether to overwrite the network identity or keep 
the existing network identity, choose overwrite, otherwise the network 
element will have a default identity instead of its identity in your network. 

Once the stored configuration is loaded, the network element begins 
operating with the new firmware and returns to Run mode.

Note: If the activation of a module fails, an alert informs you of this. 
If you have no backup of the current configuration, contact your 
Tait dealer. If you do have a backup, repeat the download 

procedure. When that is completed, you must manually restore the 
configuration, see “Manually Updating the Configuration” on page 43.
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9. Re-open the Firmware Download form and verify that the network 
element has the new firmware versions. 

10.Check the Release Notes for new data items added by the firmware 
upgrade. New data items are given default values designed to give safe, 
expected behavior, but in particular systems they may have undesirable 
effects. Check that they are appropriate and change them if necessary. 

11.Save the configuration (do not overwrite the old configuration file) and 
program it back into the network element. 

12. If you upgraded the network board firmware or kernel, re-load any 
encryption keys. (A firmware upgrade zeroizes any stored encryption keys.)

Manually Updating the Configuration
If you needed to repeat the download procedure, the network element’s 
configuration is probably unusable and must be restored from backup. After 
repeating the download, follow these steps.

1. Using the new CSS, open the backed-up configuration file. The CSS adds 
any new data items to the configuration, so that its database structure 
matches that of the new network element firmware. 

2. Check the default settings of any new data items (information in the Release 
Notes) and change any that do not suit the system. 

3. Save the configuration (do not overwrite the old configuration file) so that 
you have a backup.

4. Program the configuration back into the network element. 

Working with the Software Feature Enabler
Use the software feature enabler (Tools > Software Feature Enabler) to enable 
additional features in the network element you are connected to. For a 
description of these features, see “Software Feature Licensing” on page 13. The 
network element already has these features but it needs license keys to enable 
them. Each network element requires a unique license key for each feature. A 
license key for one network element cannot be used in another. The software 
feature enabler displays the status of all features. You can disable any that are 
enabled.
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The form displays the name of the network element you are connected to and 
its channel module serial number. Each row in the table displays information 
about a feature: the Feature code used to order a feature, its name, and whether 
it is enabled or disabled. The Seq column indicates how many times it has been 
enabled or disabled. 

Determining the Feature Licenses Required
To determine which feature licenses you need, apply the following rules (full 
details are in the table below).

To determine feature licenses for a TB9100 base station

The default radio system license is always included. The transmit enable license 
is also included, unless the base station is a fill-in receiver.

1. If the base station will handle digital P25 speech calls, obtain the P25 
common air interface license.

2. If the base station will be part of a channel group but not the central voter 
or its backup, obtain a networking with distributed voter license.

3. If the base station will use its analog line and carry digital P25 speech, obtain 
an analog line license. If the console system uses MDC1200 signaling, obtain 
an MDC1200 signaling on analog line license as well.

4. If the base station will be the channel group’s interface to a digital dispatch 
system, obtain a digital fixed system interface license.

5. If the base station will interface the channel group to a trunking site 
controller, obtain an external trunking interface license. In addition, all 
channel group members will require the SNMP (external trunking) license.

6. If the base station will operate as the central voter or the standby central 
voter, obtain a networking with centralized voter license. 
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To determine feature licenses for a P25 Console Gateway

The default radio system, analog line, networking with distributed voter, and 
P25 base encryption and key loading licenses are always included. 

1. If the console system uses MDC1200 signaling, obtain an MDC1200 
signaling on analog line license.

2. If the network uses AES encryption, obtain a P25 AES encryption license.

3. If the Console Gateway will be connected to a digital dispatch system, 
obtain a digital fixed station interface license.

Feature License
Affected 
Interfaces

License Required for the Service?

Analog 
FM

Digital 
P25

TSBK
Channel
1 control 

1.Channel control includes the ability to carry out the following: Repeat enable/disable, 
channel change, encryption defeat, monitor

Default radio system2

2.The base station or P25 Console Gateway cannot go into Run mode unless it has a 
default radio system license or a P25 common air interface license.

All Y Y Y Y

P25 common air 
interface2

RF N Y N n/a

Analog line3

3.Applies to digital P25 speech only. 

Analog line N Y N N

Networking with 
distributed voter

Channel group Y Y Y Y

MDC1200 signaling 
on analog line4

4.Determines whether ANI and the conversion between MDC1200 and TSBKs is 
supported.

Analog line n/a n/a Y n/a

Transmit enable RF Y Y Y n/a

External trunking 
interface5

5.Only available for operation with external trunking equipment.

TCCP Y Y Y Y

P25 base encryption 
and key loading6

6.Required for encryption at the analog line interface. Enables DES encryption and 
decryption. 

Analog line N Y N n/a

P25 AES encryption7

7.Enables AES encryption in conjunction with the Base encryption feature license.

Analog line N Y N n/a

SNMP (external 
trunking)

SNMP n/a n/a n/a n/a

Digital fixed station 
interface

DFSI Y Y Y Y

Networking with 
centralized voter

Channel group Y Y Y n/a
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Enabling Additional Features
If you want a feature, obtain a license key from Tait for that feature, and then 
use the CSS to enable it.

To license a feature

1. Connect to the network element.

2. If you received the license key in a license file, copy that file (and any others 
that you received for other features or other network elements) to the license 
file folder (select Options > File Folders to see which folder the CSS uses).

3. Go into Standby mode, and then select Tools > Software Feature Enabler. 

4. Click the feature to select it.

5. If you received a license file, click Find License File. This searches the 
license file folder for a license file for the current network element and the 
selected feature. If the CSS finds one, it displays the license key (in the 
feature’s row and in the Feature License Key boxes), and increments the Seq 
column by 1. 

6. If you don’t have a license file, enter the license key into the Feature License 
Key boxes.

7. Click Enable. A ‘Feature enabled’ message appears. The license key appears 
in the feature’s row and the Seq column is incremented by 1.

Note: Many features also have a configuration setting that enables or 
disables them. Often, the default setting is ‘enabled.’

Disabling a Feature
Features are not normally disabled. However, disabling may be desirable in 
special circumstances, for example, if you are trying out the feature and decide 
not to purchase it. 

Important: A disabled feature can only be re-enabled by purchasing 
a new license key. The original feature license key cannot be re-
used. 

Before disabling a feature, make sure that the network element configuration 
does not use it. Once a feature is disabled it does not work, even if the CSS 
configuration enables it. 

If the network element configuration requires a function but the software 
feature enabler has disabled it, a syslog message will be generated when the 
network element attempts to implement the function. For example, if you 
disable the P25 common air interface, but use a calling profile that tells the 
network element to handle dispatcher calls as digital P25 calls, the dispatcher 
will be unable to make calls. Each attempt produces a syslog message. 

To disable a feature

1. Connect to the network element.

2. Go into Standby mode, and then select Tools > Software Feature Enabler. 

3. Check the Channel module serial number box to make sure that the 
CSS is connected to the correct network element.

4. Click the feature’s row. 

5. Click Disable.
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The progress bar indicates how far the disabling has progressed. On 
completion, a new number appears in the Feature License Key column. 
Communicate this new number to Tait if you are entitled to a refund or if 
you want to re-enable the feature. 

Working with Privileges
If access codes have been set, you must enter an access code to obtain the 
Maintainer or the Administrator privilege before you can carry out some 
functions. From the toolbar you can change privileges. Only the Administrator 
can change access codes. 

Obtaining a Privilege
If you request a function that you don’t currently have the privilege for, the 
Access Code Required dialog box appears, asking for an access code. 

1. Enter the access code for the required privilege.

2. Click OK. The Privileges icon on the toolbar indicates the privileges you 
now have. A yellow key indicates Maintainer privilege. A red key indicates 
Administrator privilege. 

Changing Privileges
The Privileges dialog box indicates which privileges are currently active. You 
can enable or disable privileges. You may, for example, have enabled 
Administrator privilege in order to change a network element password, but 
now you want to return the CSS to Guest privilege, because a number of 
people have access to the CSS. The Guest privilege is always enabled and 
cannot be disabled.
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If a row is disabled, the privilege has no access code and you automatically have 
this privilege. If you want the privilege to be controlled by an access code, select 
Tools > Change Privilege Access Codes. 

To enable a privilege

1. On the toolbar, click Privileges.

2. Select the check box of the privilege you want to enable.

3. Alongside the check box, enter the corresponding access code.

4. Click OK. 

To disable a privilege

1. On the toolbar, click Privileges.

2. Clear the check box of the privilege you want to disable.

3. Click OK. 

Setting up and Changing Privilege Access Codes
If access codes have not been set up, CSS users automatically have all privileges 
and they are not asked for access codes. If you want to increase security, set up 
access codes by entering them as described below. 

If access codes have been set up (for example during installation), you can 
change them with Administrator privilege. 

To set up or change an access code

1. Select Tools > Change Privilege Access Codes. 

2. If the Access Code Required dialog box appears, supply the current 
Administrator access code. The Change Privilege Access Codes dialog box 
appears.

3. In the Privilege box, select the privilege for which you want to set up or 
change an access code.

4. In the New access code box, enter the new access code.

5. In the Confirm new access code box, enter the same code again.

6. Click OK. 
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CSS Options

Using the Options menu you can configure aspects of the CSS software.

Temperature Display
The CSS can display temperature in degrees Fahrenheit or Celsius. 

Select Options > Settings and select the option you prefer. 

File Folder Locations
The Default file locations area (Options > File Folders) specifies folders for 
configuration files, log files, license files, and firmware files. To modify a default 
location, click the button to the right of the box and select a folder.

Configuration 
files

Specifies the default location that the CSS looks in when opening configuration 
files and saves to when saving them. (This may have been chosen during 
installation.) 

Firmware files Specifies where the CSS will look for firmware files when you ask it to 
download new firmware into a network element. If you receive new firmware 
for a network element upgrade, copy it to this folder.

License files Specifies where the CSS will look for license files when you ask it to enable 
additional features in a network element. If you receive a license file, copy it to 
this folder.



 

50 Part C: Basic Tasks    © Tait Electronics Limited March 2007



 

TB9100 Customer Service Software User’s Manual   Monitoring 51

Part D Monitoring

The CSS can monitor Tait P25 network elements. It can provide 
operational information about the various interfaces and 
modules. The CSS can also display data logs and details about 
the hardware and software of installed modules. Monitoring can 
take place while the network element is in Run mode; it has no 
effect on the element’s operation.

For information about monitoring alarms, see “Alarms” on 
page 141. For information about monitoring Task Manager, see 
“Monitoring Task Manager” on page 209.

To monitor a base station or P25 Console Gateway, connect to 
it, click Monitor, and select an item from the navigation pane. 

Interfaces

Monitoring the RF Interface

Monitoring the Channel Group Interface

Monitoring the Analog Line

Monitoring the TCCP Interface

Monitoring the DFSI Interface

Channel Group 

Monitoring Channel Group Status

Monitoring the Channel Coordinator

Modules

Monitoring the Reciter or Gateway Module

Monitoring the Power Amplifier

Monitoring the Power Management Unit

Data Logs

Viewing Call Records

Viewing the System Log

Viewing the Trace Log

Viewing Call Statistics

Viewing the CSS Application Log

Module Details

Viewing Reciter or Gateway Module Information

Viewing Power Amplifier Information

Viewing Power Management Unit Information
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Interfaces

The CSS can monitor the network element’s interfaces. You must be 
connected to that network element. 

Monitoring the RF Interface
The RF Interface form (Monitor > Interfaces > RF Interface) shows what the 
receiver and transmitter is currently doing. It displays:

Details about the channel that the base station is currently operating on

Operational information about the receiver

Operational information about the transmitter

Most information in this form is not relevant to the P25 Console Gateway. 

Current Channel
The Current channel area shows you which channel the base station is 
operating on and displays its main configuration settings. The choice of channel 
is the result of Task Manager action. If the channel name is Invalid channel, 
Task Manager has told the base station to operate on a channel that does not 
exist. 

To view additional settings defined by the channel, look in the channel table 
(Configuration > Network Element > Channel Table) and in the profiles 
assigned to the channel.

Receiver
In the Receiver area, you can check that the receiver is enabled, see whether it 
is gated, and view information about the NAC or subaudible signaling. You can 
also view the RSSI, SINAD, and the digital P25 signal quality (EVM or BER). 

Status If the Status box displays Enabled, the receiver is able to function. If it displays 
Disabled, look at the items to the right to see what the problem is.
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Note: It is possible in the configuration to disable the receiver (in the 
channel profile, clear both the analog and the digital receiver 
modes). This is not reflected in the status display, which still shows 
‘Enabled.’

Gated When the Gated LED is green, the receiver has unmuted; a valid signal is being 
received. The LEDs alongside indicate whether that signal is analog FM or 
digital P25. 

NAC The two NAC boxes display the NAC that the receiver is configured with and 
the current or most recently received NAC. Alongside the Received NAC 
box, an LED monitors NAC detection.

If the Lock padlock is locked, the receiver will unmute irrespective of the 
received signal’s NAC. Task Manager has locked the decoding of subaudible 
signaling and the NAC.

Subaudible The two Subaudible boxes display the configured and the received CTCSS 
tone or DCS code. The configured tone or code is specified in the signaling 
profile for the current channel. The receiver can only detect a CTCSS tone if 
it is the same as the configured one, but it can detect any DCS code. The form 
displays what the receiver is currently receiving (or has just received). 

Alongside the Received box, an LED monitors the detection of subaudible 
signaling.

Item Status Meaning

Lock Locked Task Manager has locked the receiver. The receiver 
cannot operate.

Valid channel Red The currently selected channel does not exist or is 
corrupted. 

Synthesizer 
locked

Flashing 
Red

The receiver is unable to operate on the configured 
frequency. 

LED Color Meaning

Green The receiver has detected a matching NAC. 

Red The receiver has detected a NAC that is different from the 
one it is configured to receive. 

Gray The receiver is not currently detecting a NAC.

LED Color Meaning

Green The receiver has detected a valid DCS code or the particular 
CTCSS tone that it is configured to recognize.

Gray The receiver is not currently detecting any subaudible signaling.
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If the Lock padlock is locked, the receiver will unmute irrespective of the 
received signal’s CTCSS tone, DCS code, or NAC. Task Manager has locked 
the decoding of subaudible signaling and the NAC.

RSSI The RSSI gauge displays the current strength of the received signal in dBm. 
The equivalent numeric value appears under the gauge heading. If this value is 
red, it exceeds the maximum or has fallen below the minimum that the gauge 
can display. A pointer indicates the configured threshold for opening the 
receiver gate. 

SINAD The SINAD gauge displays the signal-to-noise ratio of the received signal in 
dB. The equivalent numeric value appears under the gauge heading. If this 
value is red, it exceeds the maximum or has fallen below the minimum that the 
gauge can display. A pointer indicates the configured threshold for opening the 
receiver gate.

EVM Click EVM and the box to the right displays the error vector magnitude of the 
received signal. This ranges between 200 (high quality) and 1000 (low quality).

BER Click BER and the box to the right displays the estimated bit error rate of the 
received signal, expressed as a percentage.

Transmitter
In the Transmitter area, you can check that the transmitter is enabled, see 
whether it is keyed, view information about the NAC and the subaudible 
signaling, and see the source of what is being transmitted. You can also monitor 
the forward and reverse power. 

Status If the Status box displays Enabled, the transmitter is able to function. If it 
displays Disabled, look at the items to the right to see what the problem is.

Item Status Meaning

Lock Locked Task Manager has locked the transmitter. The 
transmitter is unable to function.

Valid channel Red The currently selected channel does not exist or is 
corrupted. 

Synthesizer 
locked

Flashing 
Red

The transmitter is unable to operate on the configured 
frequency. 
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Note: It is possible in the configuration to disable the transmitter 
(clear the RF transmit check box). This is not reflected in the status 
display, which still shows ‘Enabled.’

RF repeat When the RF repeat LED is green, RF repeat is enabled and the transmitter 
will repeat any vote-winning RF signal that the base station or channel group 
receives.

When the RF repeat LED is gray, the RF repeat setting is currently disabled.

The box alongside indicates the cause of the current RF repeat setting. 

PA keyed When the PA keyed LED is green, the transmitter is transmitting; carrier is 
present. The LEDs alongside indicate whether that signal is analog FM or digital 
P25. 

The PA keyed LED turns green when one of the following occurs:

A call (the Transmitting source LED is green and the Voter box indicates 
the origin of the call)

A CWID transmission (CWID LED is green)

A transmit tail (Tail LED is green)

The Carrier button on the control panel has been pressed 

NAC The two NAC boxes display the NAC that the transmitter is configured with 
and the NAC that the transmitter is currently transmitting or has most recently 
transmitted. The configured NAC is specified in the signaling profile for the 
current channel. 

Reason Description

Config The RF repeat setting was selected by configuration.

RF link The base station is configured as a linking transceiver. This 
disables local RF repeat. However, network repeat is still 
enabled.

Trunking Trunking operation caused the current setting. Beginning to 
operate as a control channel disables RF repeat. Beginning to 
operate as a traffic channel causes the base station to use 
the RF repeat setting in the channel table. If the base station 
is ‘down’, RF repeat is disabled. 

Dispatch local A dispatch command enabled or disabled RF repeat. This 
command was from a locally connected digital dispatch 
console or from a Task Manager action (Enable/Disable/
Toggle RF repeat). The Task Manager action can implement a 
local or a remote dispatch command. This can only happen if 
the channel table has put RF repeat under dispatcher 
control. 

Dispatch remote A dispatch command enabled or disabled RF repeat. This 
command was from a digital dispatch console connected to 
another channel group member. This can only happen if the 
channel table has put RF repeat under dispatcher control and 
the channel group configuration enables collective control of 
RF repeat.
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Subaudible The two Subaudible boxes display the CTCSS tone or DCS code that the 
transmitter is configured with and the CTCSS tone or DCS code that the 
transmitter is currently transmitting or has most recently transmitted. The 
configured tone or code is specified in the signaling profile for the current 
channel.

If the Lock padlock is locked, the transmitter does not send any subaudible 
signaling. Task Manager has locked the encoding of subaudible signaling.

Transmitting 
source

The Transmitting source LED is green if the transmitter is transmitting signal 
from a user. 

Voter The Voter box shows where the signal being transmitted came from. 

Receiver number The receiver number of the network element that provided the signal being 
transmitted. 

CWID The CWID LED displays green when the base station is currently transmitting 
its CWID.

Tail In analog FM mode, the Tail LED displays green when the base station is 
transmitting its tail. This consists of the hang time (subaudible signaling but no 
audio) followed by the soft-off time (carrier only).

Forward power Displays the measured forward power of the PA output. Click Watts or dBm 
to select the units used. 

Reverse power Displays the measured reverse power of the PA output. Click Watts or dBm 
to select the units used.

VSWR Displays the Voltage Standing Wave Ratio of the PA’s RF output. 

Display Description

FM - Line An analog FM call received over the analog line or DFSI

FM - IP An analog FM call received over the digital line from another 
channel group member.

FM - RF An analog FM call received over the air interface

FM - Panel An analog FM call received from the control panel microphone

P25 Voice - Line A digital P25 call received over the analog line or DFSI

P25 Voice - IP An digital P25 call received over the digital line from another 
channel group member.

P25 Voice - RF An digital P25 call received over the air interface

P25 Voice - 
Panel

An digital P25 call received from the control panel microphone

P25 Data A digital P25 data call.
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Monitoring the Channel Group Interface
To help in troubleshooting, the Channel Group form (Monitor > Interfaces > 
Channel Group) monitors the network element’s operation as part of a channel 
group. Use the form for the following: 

Checking channel group settings when installing the system

Monitoring network link operation and measuring network jitter

Checking for transmit buffer underflows

Checking Channel Group Settings
If the system is not behaving as expected, check the channel group settings.

1. Select Monitor > Interfaces > Channel Group. 

2. Check that the Software feature enable check box is selected. If it is 
cleared, the network element does not have a networking feature license 
and is unable to be part of a channel group.

3. Under Current channel group, check the settings displayed. These are a 
subset of the settings in the Channel Groups dialog box (Configure > 
Channel Group > Channel Groups and click Edit).

Confirm that the expected channel group is in use. The network 
element uses the channel group that is assigned to the current channel.

Check that the required types of voice stream can be sent to the channel 
group. If Analog FM is selected, the digital line can send analog FM 
voice streams to other channel group members. If Digital P25 is 
selected, the digital line can send digital P25 voice streams. 

Check that the IP address is correct. This is the (normally multicast) 
address of the current channel group. The network element sends voice 
streams to this address and (if the address is multicast) receives voice 
streams that have this destination address.

The Port is not normally changed from the default.

Check that the padlock symbol is open. If it is closed, Task Manager has 
locked channel group communications and the network element will 
not send anything to or receive anything from the channel group.

Monitoring the Network Link
To monitor the network element’s network link to other channel group 
members, select Monitor > Interfaces > Channel Group and view the Quality 
of Service area. This area displays quality of service values for the current 
incoming voice stream. 
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Jitter The delay variation of RTP packets arriving at the connected network element. 
A high jitter is a sign that the network is congested.

Packet loss (per 
call)

The number of packets lost in an over. Packet loss should be rare. Users will 
not notice a loss of up to 10 packets. Packet losses may be caused by inadequate 
linking bandwidth, cable faults, or power cycling of the switch or router.

Average loss The average number of packets lost per second. Packet losses should be rare. 
Frequent packet loss indicates that there is something wrong with the linking 
infrastructure.

Monitoring the Transmit Buffer
If the jitter on the incoming voice stream is high, the transmit buffer may not 
be able to cope. To check the buffer, select Monitor > Interfaces > Channel 
Group and view the Transmitter area.

Initial delay The configured length of time in milliseconds that the transmitter waits before 
beginning to transmit voice. This is the preamble duration that is set in the 
Network form (Configure > Channel Group > Network). If the base station 
transmits TSBKs, it uses a preamble duration of 100 ms and the display updates 
to reflect this. 

Underflow (last 15 
minutes)

The percentage of packets during the last 15 minutes that arrived late enough 
to cause a buffer underflow. If too many buffer underflows occur, lengthen the 
preamble (see “Configuring the Jitter Buffer” on page 122). 

Underflow (worst 
15 minutes)

The highest percentage of packets during any 15 minute period in the last 24 
hours that arrived late enough to cause a buffer underflow. If too many buffer 
underflows occur, lengthen the preamble (see “Configuring the Jitter Buffer” 
on page 122).
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Monitoring the Analog Line
The Analog Line form (Monitor > Interfaces > Analog Line) indicates what is 
happening on the analog line. You can check that it is enabled, view 
information about the current calling profile, look at line levels, and view the 
current state of line signaling.

Analog line 
enabled

If the Analog line enabled LED displays red, the analog line is unable to 
function. Look at the first items under Calling profile for the reason. 

RF repeat The RF repeat LED only has meaning if the CSS is connected to a base station. 
When the RF repeat LED is green, the base station repeats the signal it receives, 
unless another signal with a higher priority is present at one of its interfaces. If 
the base station is part of a channel group, the signal it repeats may have been 
received by any of the channel group’s base stations. 

When the RF repeat LED is gray, the base station’s repeat function is currently 
disabled. Signals from a receiver (at this base station or at any other base station 
in the channel group) can be sent to the analog line but not to the transmitter. 

Calling profile
The Calling profile area displays details about the current calling profile. The 
calling profile is selected by the channel table or by function tone from an 
analog console system.

User enabled If this check box is cleared, the current calling profile is disabling the analog line.

Software feature 
enabled

If this check box is cleared, the network element does not have a license 
enabling the analog line.

Lock If the padlock icon is locked, Task Manager has locked the analog line. 

Name The name of the calling profile.

Squelch Specifies what the analog line unmutes to. If the squelch is Normal, the 
network element switches any vote winner onto the analog line. If the squelch 
is Selective, the network element only switches the vote winner onto the 
analog line if it is addressed to the current calling profile’s line ID or to a group 
listed in the current calling profile’s group membership.
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Emergency When the Emergency LED is green, any calls that the analog line makes will be 
emergency calls. This is because the current calling profile configures them that 
way. It does not mean that the base station is currently receiving an 
emergency call. 

Call type Defines the type of call that the channel group makes when the dispatcher 
initiates a call. (The analog line can always forward incoming calls of any type.) 
If the call type is P25 group or P25 individual, the following boxes provide 
further information.

Group 
membership

The name of the collection of groups assigned to the calling profile. Alongside 
are displayed the group IDs belonging to the collection.

Service profile The service profile assigned to the calling profile. The check boxes alongside 
indicate which services are enabled at the analog line input. (The receiver input 
can have a different service profile, assigned to the channel.) For details about 
these services, see “Working with Service Profiles” on page 96.

Encryption Displays the encryption key that is assigned to the current calling profile. 

Encryption Status
The Encryption status area monitors the encryption of the input on the analog 
line input and the decryption of signals destined for the analog line output.

From line The From line LED indicates whether encryption is proceeding normally. 
The box alongside indicates whether the call is clear, what key is being used, or 
what the encryption problem is.

Item Meaning

ID The identity of the caller.

Destination The individual or group ID that the call is made to.

LED Box text Encryption status

Grey There is currently no speech.

Green Clear The input speech is not being encrypted.

Green Key name The speech is being encrypted using the named key.

Red Key empty There is no secure key data for the CKR that the key name is mapped to. The 
speech cannot be encrypted so it is not transmitted. Check that the key name 
is mapped to the correct CKR and that the secure key data for that CKR has 
been loaded. 

Red No license The calling profile specifies an encryption key but the required encryption 
feature license is not present. Speech is transmitted clear. 
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To line The To line LED indicates whether there are any problems with decryption. 
The box alongside indicates whether the call is clear, what key is used for 
decryption, or what the decryption problem is.

Line Status
The Line status area shows the status of line signaling and the levels of the line 
input and output. 

The first row of controls displays information about the analog line input. 

If the Channel seize LED is green, the analog line is receiving a signal that an 
analog input is present. 

The Level boxes display the configured input level (the expected level of the 
line input) and the RMS level currently being measured. 

LED Box text Encryption status

Grey There is no speech output.

Green Clear The speech was not encrypted.

Green Key name The speech has been decrypted using the named 
key. If the key has no name, the CKR number is 
displayed.

Red Clear The speech is clear but should not be; the calling 
profile specifies an encryption key.

Red Key name The key used by the caller is not the key specified by 
the calling profile. The speech has been decrypted 
using the displayed key. If the key has no name, its 
CKR number is displayed.

Red Key empty The key that the calling profile selects has not been 
loaded or has been zeroized. No other key fits, so 
the speech cannot be decrypted.

Red No key The P25 Console Gateway does not have the key 
that was used to encrypt the speech. The call cannot 
be decrypted.

Red No license The encryption feature license is not present. If the 
speech is clear, it is provided to the analog line. If the 
speech is encrypted, it cannot be decrypted.
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If the Overload LED is red, the level is too high and is about to cause distortion 
in the DSP. It is acceptable for occasional speech peaks to trigger this LED, but 
if this happens regularly and often, too much gain is being applied and tone 
detection will not work properly. Enter a higher line level (Configure > Analog 
Line > General). If the Overload LED goes red at the beginning of the over, 
the HLGT is too high. Configure the console system to reduce the level of its 
HLGT output.

The second row of controls displays information about the analog line output.

If the Analog valid LED is green, the analog line is sending a signal that there 
is a valid output on the analog line. 

The Level boxes display the configured and measured levels of the analog line 
output. 

Signaling
The Signaling area shows the status of line signaling on the analog line. Check 
boxes indicate what is enabled in configuration and LEDs show what signaling 
is currently happening.

E & M If the Enabled box is checked, the analog line is configured to recognize and 
use E & M signaling. If the E Wire (input) LED is green, the network element 
has detected that the E wire has been asserted. If the M Wire (output) LED is 
green, the network element has asserted the M wire.

MDC1200 If the Enabled box is checked, the analog line is configured to recognize 
MDC1200 signaling. If the Received LED is green, the analog line has 
detected incoming MDC1200. 

Tone remote If the LLGT detected LED is green, the analog line is receiving low level 
guard tone. If the green Monitor LED lights briefly, the analog line received a 
dispatcher command to monitor the channel.

Last function tone Displays the frequency pair of the last function tone that was received. If a dual 
function tone was received, the two frequencies in the pair are different. If a 
single frequency tone was received, this is still displayed as a pair, but both 
frequencies are the same. 

Last address 
received

Displays the last MDC1200 address that was received. This is the destination 
address of a call initiated from the dispatcher.
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Monitoring the TCCP Interface
Using the TCCP form (Monitor > Interfaces > TCCP) you can monitor the 
operation of the interface between the trunking site controller and a channel 
group. In a channel group, only the master base station has a TCCP interface. 
Connect the CSS to the master base station for full details. If you connect to 
another channel group member, only the Channel area provides information.

Software feature 
enabled

If this check box is cleared, the base station does not have a license enabling the 
TCCP interface. Only the master base station needs this license. 

User enabled If this check box is cleared, a TCCP interface is not enabled in the base station 
configuration (Configure > Channel Group > Trunking).

External trunking controller
The external trunking controller area monitors the connection to the trunking 
controller.

Site controller A green LED indicates that the base station is receiving heartbeat messages from 
the trunking site controller. There is a TCCP connection. 

IP address The IP address of the trunking site controller. 

Configured 
listening port

The port that the base station is listening to for TCCP communications. This 
port is defined by configuration. 

Talking port The port that the base station sends its control service communications to. The 
base station obtains this port number from the site controller’s requesting 
packet.

Voice service
The Voice service area monitors the voice service that is established for traffic 
channels by the TCCP connection. (If the base station has a DFSI connection, 
the Voice service and Traffic areas will display voice service information, but 
this should not be relied upon. Use the DFSI form instead.)



 

TB9100 Customer Service Software User’s Manual   Interfaces 65

IP address The IP address that the base station is configured to send voice streams to. This 
can be the trunking controller or another device.

Port The UDP port that the base station sends voice streams to. The base station 
obtains the port number from the trunking controller’s connection message. 

SSRC The SSRC (synchronization source) currently being used. The SSRC is a large 
number specified by the trunking controller in its connection message. It 
uniquely identifies voice streams sent from the master base station.

Traffic
The Traffic area indicates the types of communication that the voice service is 
carrying.

Speech A green LED indicates that the TCCP interface is carrying speech. Inbound 
speech is from a SU to the trunking controller, outbound speech is from the 
trunking controller to one or more SUs.

 Packet data A green LED indicates that the TCCP interface is carrying packet data.

Channel
The Channel area indicates the operational state of the base station. This area 
also displays information when the CSS is connected to base stations other than 
the master. 

Channel type Displays the operational state of the base station.



 

66 Part D: Monitoring    © Tait Electronics Limited March 2007

Connected A green LED indicates that the base station is part of a channel group that is 
connected to a trunking controller. More precisely, the master base station is 
receiving heartbeat messages from the trunking controller and this base station is 
functioning as (part of) a traffic channel or a control channel. A gray LED 
indicates that the channel group has lost its TCCP connection or never had one.

Monitoring the DFSI Interface
Using the DFSI form (Monitor > Interfaces > DFSI) you can monitor the 
operation of the interface between digital dispatch equipment and a channel 
group. The CSS must be connected to the channel group member with the 
DFSI (digital fixed station interface.

Software feature 
enabled

If this box is cleared, the network element does not have a license enabling the 
DFSI.

User enabled If this box is cleared, the DFSI is not enabled in configuration (Configure > 
Channel Group > Network).

Control service
The Control service area monitors the control service provided by the DFSI.

Display Description

Control channel The base station is functioning as (part of) a trunking control 
channel.

Traffic channel The base station is functioning as (part of) a traffic channel.

Conventional The base station is operating in conventional mode. 
Configuration has not permitted a TCCP connection 
(Configure > Channel Group > Trunking).

Down The base station is down. Either the trunking controller has 
taken the channel out of service or it has not yet received any 
trunking controller communications.

Isolated control 
channel

The base station is still (part of) a control channel but has lost 
its TCCP connection to the trunking controller.

Isolated traffic 
channel

The channel continues to function as (part of) a traffic channel 
but has lost its TCCP connection to the trunking controller.

Standby The base station is in Standby mode. 
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Connected A green LED indicates that the DFSI is active. The network element has 
received a connect message and has responded to it. It is able to receive and 
action control commands from the FSH.

IP address The IP address of the FSH control service. 

Configured 
listening port

The port on which the network element is listening for DFSI communications. 
This port is defined by configuration. 

Talking port The port that the network element sends its control service communications to. 
The network element obtains this port number from the FSH. 

Voice service
The Voice service area monitors the voice service provided by the DFSI. (If the 
network element has a TCCP connection, the Voice service and Traffic areas 
will display voice service information, but this should not be relied upon. Use 
the TCCP form instead.)

IP address The IP address that the network element sends voice streams to. Depending on 
the configuration, this could be the control service IP address or a different 
unicast or multicast address.

Port The UDP port that the network element sends voice streams to. It obtains this 
port number from the connection message. 

SSRC The SSRC (synchronization source) currently being used. The SSRC is a large 
number specified by the FSH in its connection message. It uniquely identifies 
voice streams sent from the channel group master to the FSH.

Traffic
The Traffic area indicates the types of communication that the DFSI is carrying.

 

Speech A green LED indicates that the DFSI is carrying speech. Inbound speech is from 
a SU to the FSH, outbound speech is from the FSH to one or more SUs.

Signaling The LED lights green briefly to indicate that a TSBK was sent or received.
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Channel Group

The CSS can monitor information about the whole channel group. Status 
information is provided by the channel group member that the CSS is 
connected to and is displayed in tables, with one row of information for each 
channel group member. The CSS also displays status information about the 
channel coordinator of the member that the CSS is connected to.

Monitoring Channel Group Status
The Channel Group Status form (Monitor > Channel Group > Status) displays 
status information in two tables. The first table displays voting information and 
the second displays configuration information relevant to channel group 
operation.

Monitoring Channel Group Voting
The Group Status area (Monitor > Channel Group > Status) monitors the 
voting of the channel group. If voting is centralized, connect the CSS to the 
central voter; satellite voters do not indicate who is winning the vote.

Green cells indicate the voice stream that has won the vote or been selected. If 
the channel group is duplex, there can be a winning inbound (subscriber) 
stream and an outbound (dispatcher) stream.

Host name The name of the channel group member.

Voting The type of voting taking place at each channel group member.

Display Description

distributed Voting is distributed among all channel group members. If one member has this voting 
type, all others should have the same type.

central voter Voting is centralized at this channel group member. All other channel group members 
should display ‘satellite’ or ‘satellite (central).’ Only one member should display ‘central 
voter’ at any one time. 

satellite This channel group member has acknowledged that another channel group member is the 
central voter. This member plays a supporting role to the central voter. 

distributed 
(central)

This channel group member is currently operating as a distributed voter but is configured 
for central voting. It is therefore a candidate central voter but something (for example, one 
member is version 2.2x) is preventing central voting. 
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A cell with a colored background indicates that a dispatcher command has 
modified the member’s voting behavior. (Not currently supported.)

CG Mode Displays the mode of the channel group.

RF repeat Indicates whether the member currently repeats the vote-winning output or 
not. This can be set by configuration, by dispatcher command, or by Task 
Manager action.

Rcvr num Displays the receiver number of the channel group member. This number is 
used by digital dispatch equipment, when the dispatcher selects or disables a 
receiver. It is also used in voting. Voice streams from members with a lower 
receiver number win the vote (or are selected) when other things are equal. 

RF Rx Type Displays whether the call is digital P25 or analog FM.

If this and the two adjacent cells have a green background, the RF stream is 
winning the vote. 

satellite 
(central)

This channel group member is currently operating as a satellite voter but is configured for 
central voting. Another channel group member is acting as the central voter. This is the 
expected voting type for a back-up central voter. 

switched There is no RF voting, but the channel group member still selects or prioritizes voice 
streams. This setting is appropriate if the channel group receivers do not have a common 
uplink frequency.

(blank) The member is in Standby mode. Normal voting and switching does not operate. However, 
the control panel can still receive and make calls. These calls will only be visible in the table 
if the CSS is connected to this member or to the central voter. 

Display Description (Continued)

Display Description

green The dispatcher has selected the member’s receiver. This 
receiver’s signal will always win the vote. If this receiver has no 
signal, the channel group votes as it is configured to do.

red The dispatcher has disabled the member’s receiver. The 
receiver’s signal cannot win the vote. 

Display Description

duplex The channel group can simultaneously handle an inbound 
(subscriber to dispatcher) and an outbound (dispatcher to 
subscriber) voice stream.

simplex The channel group provides a single voted or selected stream 
at any one time. If the dispatcher is talking, subscribers cannot 
be heard.
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RF Rx Impairment Displays the impairment value of the received signal. Impairment is a number 
between 0 and 15. It is the inverse of signal quality. The lowest impairment 
wins the vote, if the streams have the same RF Rx Type. For digital P25 calls, 
the impairment is based on an internal measure similar to EVM (error vector 
magnitude). For analog FM calls, it is based on an internal measure similar to 
SINAD. 

RF Rx % Displays the percentage of the time during the current call that this receiver 
won the vote.

Line In Type Displays the type of call coming from the line in. This can be digital P25 or 
analog FM.

Line In Src Displays the source of the call coming from the ‘line in.’ This can be DL (the 
DFSI), the analog line, or the control panel. 

Monitor Displays the source of a call when the dispatcher issues a monitor command. 
For example RF 5 indicates that the call came from the RF interface at receiver 
number 5.

Skew The milliseconds of skew in the voice stream as it arrives at the central voter. 
The central voter always has a skew of 0. A skew of 20 means that the voice 
stream from that member is arriving at the central voter 20 ms later than the 
equivalent voice stream from the central voter. The central voter can only 
measure skew and compensate for it in digital P25 mode. 

Monitoring Channel Group Configuration
The Group Status form (Monitor > Channel Group > Status) helps you check 
that all members of the channel group have a consistent configuration. This is 
particularly useful during network installation. Many settings need to be the 
same for all channel group members. 

The information displayed in this table is passed from other channel group 
members to the connected member using the RTCP protocol. The connected 
member supplies the information to the CSS.

Host name The name of the channel group member. Check that each name is unique.

IP address The IP address of the channel group member. 

Rcvr num The receiver number of the channel group member. This number is used by 
digital dispatch equipment, when the dispatcher selects or disables a receiver. It 
is also used in voting. Voice streams from members with a lower receiver 
number win the vote (or are selected) when other things are equal. Make sure 
that each channel group member has a unique number. 
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Chan The member’s current operating channel. Normally, all members are set up to 
operate on the same channel number. If the channel group is set up to handle 
channel change commands from the dispatcher, monitor this column when 
testing these commands. 

Tx Freq The transmit frequency of the member’s current channel. 0.000002 MHz 
means that the base station is Version 2.x. These base stations do not put their 
transmit frequency in RTCP messages. 

Rx Freq The receive frequency of the member’s current channel. 0.000002 MHz means 
that the base station is Version 2.x. These base stations do not put their receive 
frequency in RTCP messages. 

BS Mode The current mode of the channel group member.

RFSS I/F Indicates whether the member is providing an interface to the channel group.

Display Description

Control channel The base station is functioning as part of a trunking control 
channel.

Traffic channel The base station is functioning as part of a traffic channel.

Conventional The base station is operating in conventional mode. 
Configuration has not permitted a TCCP connection 
(Configure > Channel Group > Trunking).

Down The base station is down. Either the trunking controller has 
taken the channel out of service or it has not yet received any 
trunking controller communications.

Isolated control 
channel

The base station is still part of a control channel but has lost its 
TCCP connection to the trunking controller.

Isolated traffic 
channel

The channel continues to function as part of a traffic channel 
but has lost its TCCP connection to the trunking controller.

Standby The base station is in Standby mode. A CSS has taken it out of 
service

Display Description

None There is no channel group interface other than the RF interface 
and the control panel.

TCCP The member has an active TCCP interface to a trunking site 
controller. 

Analog line The member has an active analog line interface, for example 
to analog dispatch equipment. (By default, all analog lines are 
active. To ‘deactivate’ an an unused analog line so that it does 
not appear in this column, select Configure > Analog Line > 
Calling Profiles and disable its calling profiles.)

DFSI The member has an active digital fixed station interface, for 
example to digital dispatch equipment. 
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Monitoring the Channel Coordinator
The Channel Coordinator form (Monitor > Channel Group > Channel 
Coordinator) monitors the operation of the channel coordinator in the channel 
group member that the CSS is connected to. The form displays the current state 
of the variables that are coordinated and indicates who is responsible for that 
state and what caused it. For more information about the channel coordinator, 
see the TaitNet P25 System Manual. 

Configuration Displays the configured setting for RF repeat.

Collective ‘True’ means that the variable is under collective control; the coordinator will 
send channel control commands to and respond to commands from other 
channel group members.

Display Description

Enabled The entry in the channel table for the current 
channel enables RF repeat. RF repeat is enabled and 
cannot be disabled by collective control or by 
dispatcher command. 

Disabled The entry in the channel table for the current 
channel disables RF repeat. RF repeat is disabled and 
cannot be enabled by collective control or by 
dispatcher command.

DispatchControlled The entry in the channel table for the current 
channel places RF repeat under dispatcher control. 
Dispatcher commands and collective control can 
determine the RF repeat state.
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State The current state of the variables under the control of the channel coordinator.

Originator The network element responsible for the present state of the variable.

Cause The cause of the present state of the variable. 

Variable State Description

RF repeat Enabled Repeat is enabled. The base station transmits 
streams from SUs over the RF interface.

Disabled Repeat is disabled. The base station does not 
transmits streams from SUs over the RF 
interface.

Channel 
number

nnn (for example 3) The number of the channel that the member 
is currently operating on.

Voter 
control

Normal Normal voter operation. 

Selected A dispatcher command has selected this 
network element’s receiver as the vote 
winner.

Disabled A dispatcher command has prevented this 
network element’s receiver from winning the 
vote.

Display Description

Local The channel group member that the CSS is 
connected to is responsible for the present variable 
state.

nnn (for example 3) The channel group member with receiver number 
nnn is responsible for the present variable state.

Display Description

Configuration The present state of the variable is due to the local 
configuration.

Task Manager The present state of the variable is due to Task 
Manager action, triggered for example by an analog 
dispatch console command.

DFSI The present state of the variable is due to a 
command from a digital dispatch command, 
received over the local DFSI interface.

power up The present state of the variable resulted from 
power up.

IP The present state of the variable resulted from a 
command sent over IP from another network 
element
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Modules

The CSS can monitor operational details about individual modules. These 
details include temperatures, currents, voltages, and other levels.

Monitoring the Reciter or Gateway Module
The Channel Module form (Monitor > Modules > Channel Module) monitors 
the RSSI and SINAD of the received RF signal and audio levels on the analog 
line. Each level is displayed graphically as a gauge. The equivalent numeric 
value appears under the gauge heading. If the value is red, it has exceeded the 
maximum or fallen below the minimum that the gauge can display.

RF received level The RF received level area displays the RSSI and SINAD levels of the inbound 
RF signal. (For the equivalent RSSI in microvolts, see “Converting Between 
Microvolts and dBm” on page 108). The SINAD is only an estimation, 
obtained by measuring the out-of-band noise.

Analog line The Analog line area displays the audio levels for the receive (line in) and 
transmit (line out) paths of the analog line.

Temperature The Temperature area displays a thermometer that shows the temperature 
measured at the channel module heatsink.

Fan Displays whether the channel module has turned the fan on or off.

Fan rotation Active means that the channel module has detected fan rotation. Inactive means 
that the fan has failed, if the Fan box displays On. This box does not apply if 
the channel module is fitted with a 2-wire fan. 
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Monitoring the Power Amplifier
The Power Amplifier form (Monitor > Modules > Power Amplifier) monitors 
the levels of various PA parameters. Some levels are displayed graphically as a 
gauge or thermometer. The equivalent numeric value appears in or under the 
heading. If a value goes off the scale, it turns red. 

To switch the temperature display between Celsius and Fahrenheit, select 
Options > Settings.

Alarm status The Alarm status box indicates whether the PA has an alarm. If the LED is red, 
select Monitor > Alarms > Status to see which alarm is active.

Transmitter 
output

The Transmitter output area displays the forward and reverse power. Click the 
Watts or dBm option to change the units of the display.

Heatsink 
temperature

Displays the highest of the three temperatures measured at the PA driver, 
Final 1, and Final 2 transistors. (The 5 W PA has no final transistors and the 
50W PA has no Final 2 transistor.)

Air intake 
temperature

This thermometer displays the temperature measured at the air intake to the PA 
heatsink. 

Duty cycle The Duty cycle area has two gauges. 

The first gauge indicates the average duty cycle over the past 5 minutes. 50% 
means that the PA was transmitting for 2.5 of the last 5 minutes. The display is 
updated once every minute. 

The second gauge indicates the average duty cycle over the past 24 hours. 25% 
means that the PA was transmitting for 6 of the last 24 hours. The display is 
updated once every hour.
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VSWR The VSWR displays the voltage standing wave ratio. If this is greater than 10:1, 
an alarm is triggered and the PA folds its output back to 10% of its capability. 
Only when the VSWR falls below 5:1 will the power output begin to recover.

Fan Indicates whether the fan is on.

Supply Displays the voltage of the power that the PMU is supplying to the PA.

Monitoring the Power Management Unit
The Power Management form (Monitor > Modules > Power Management) 
monitors the operation of the PMU. You can:

Check the voltage of the battery and the current that the PMU outputs to 
the PA.

Check the status of the PMU’s inputs and outputs.

This form has gauges displaying the battery voltage, the output current, and the 
output voltage. Boxes represent different PMU submodules and LEDs indicate 
the status of power inputs and outputs. If a submodule is not fitted, the box 
alongside the LED is disabled.

Alarm status The Alarm status box indicates whether there is a current alarm. If the LED is 
red and the box displays ‘Alarms active’, one or more PMU alarms have been 
triggered. Select Monitor > Alarms > Status to see which alarms are active.

Battery voltage The battery voltage gauge indicates the voltage of the DC power supply to the 
PMU. The LED alongside indicates the state of the power supply.
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AC-DC converter The LED in the AC-DC Converter box indicates the state of AC power.

DC-DC converter The LED in the DC-DC converter box indicates the state of the battery input.

Standby converter The LED in the Standby converter box indicates the state of the DC supply to 
the standby converter. 

PA The PA LED displays green if the PMU is supplying power to the PA.

Channel module/
control panel

The Channel module/control panel LED indicates the status of the power 
supply to the receiver and the control panel. Green means that it is supplying 
power. Gray means that it is not, because the PMU is in battery protect mode. 

Auxiliary output The Auxiliary output box has an LED that indicates the status of the auxiliary 
power output.

LED Description

Green DC power input is usable

Red DC power input is off (or too low or too high) 

Gray No battery power supply is fitted

LED Text Description

Green On AC power input is usable

Red Off AC power input is off (or too low or too high) 

Gray Off Mains Failure test is running

LED Text Description

Green On Battery input is usable. The PMU can provide up to 500 W 
(or up to 40 W of power in low power mode). 

Red Off Battery voltage is off (or too low or too high).

Gray Off 
(disabled)

A DC-DC converter is not fitted.

LED Text Description

Green On The standby DC supply is on.

Red Off Battery voltage is off (or too low or too high.

Gray Off 
(disabled)

No standby battery power supply is fitted. (AC-only PMUs 
do not have standby converters.) 
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Output current 
gauge

The Output current gauge shows how much current the PMU is supplying to 
the subrack.

Output voltage 
gauge

The Output voltage gauge shows the voltage of the power that the PMU is 
supplying to the subrack.

Fan
The Fan box displays whether the PMU fan is off or on.

LED Text Description

Green On The auxiliary output power supply has been turned on.

Red Off There is a fault. This could be because there has been a 
current overdraw and the fuse is blown. On cooling, the 
fuse will automatically reset.

Gray Off The PMU has turned the output off.

Gray Off 
(disabled)

An auxiliary power output submodule is not fitted.
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Data Logs

The CSS can ask the connected network element to provide records of various 
types of logged events. You can view them and save them to a file. In addition, 
the CSS has its own log.

Viewing Call Records
The CSS can display records of digital P25 calls that the connected network 
element has participated in. 

 

Important: Viewing call records can cause voice drop-outs. When 
you click All Records, the network element sends all the entries in 
its log to the CSS. This may flood switched networks, which cannot 

prioritize voice packets. The result is that voice traffic does not arrive in time. 
To avoid this problem, configure the network element to send call records to a 
syslog collector. For details, see “Logging to a Syslog Collector” on page 155. 

To view the call record log

1. Select Monitor > Data Logging > Call Record Log. The appropriate form 
appears, but displays no data. 

2. Click All Records. The CSS asks the connected network element to 
supply all call records it has stored. 

3. To stop the records from scrolling on the screen as the CSS receives them, 
select the Disable scrolling check box.

4. To update the display with new call records, click All Records again. The 
network element only sends call records that have not already been supplied. 
To view only new call records, click Clear before clicking All Records.   

Using the buttons on the bottom of the form, you can tell the network ele-
ment to stop supplying records, clear the display, or save the records to a file.
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Viewing the System Log
The CSS can ask the connected network element to provide records of events 
that lie above the level of Notice. The network element can store up to 1000 
such events.

Important: Viewing the system log can cause voice drop-outs. 
When you click All Records, the network element sends all the 
entries in its log to the CSS. This may flood switched networks, 

which cannot prioritize voice packets. The result is that voice traffic does not 
arrive in time. To avoid this problem, configure the network element to send 
the data to a syslog collector. For details, see “Logging to a Syslog Collector” 
on page 155. 

To view the system log

1. Select Monitor > Data Logging > System Log. The appropriate form 
appears, but displays no data. 

2. Click All Records. The CSS asks the connected network element to 
supply records, beginning with the oldest. 

3. To stop the records from scrolling on the screen as the CSS receives them, 
select the Disable scrolling check box.

4. To update the display with new records, click All Records again. The 
network element only sends records that have not already been supplied.  

Using the buttons on the bottom of the form, you can tell the network ele-
ment to stop supplying records, clear the display, or save the records to a file.
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Viewing the Trace Log
The trace log provides information about the operation of the network 
element. Normally, you would look in the system log for such information. 
However, Tait may request that you look in the trace log for particular items 
or save the trace log to a file and send it to them.

The trace log contains system log messages, call records, and additional messages 
with a severity level of Information. Information messages are Tait-internal and 
very detailed. The network element’s trace log can store up to 1000 messages. 

Important: Viewing the trace log can cause voice drop-outs. When 
you click All Records, the network element sends all the entries in 
its log to the CSS. This may flood switched networks, which cannot 

prioritize voice packets. The result is that voice traffic does not arrive in time. 
To avoid this problem, configure the network element to send the data to a 
syslog collector. For details, see “Logging to a Syslog Collector” on page 155. 

To view the trace log

1. Select Monitor > Data Logging > Trace Log. The appropriate form appears, 
but displays no data. 

2. Click All Records. The CSS asks the connected network element to 
supply records, beginning with the oldest. 

3. To stop the records from scrolling on the screen as the CSS receives them, 
select the Disable scrolling check box.

4. To update the display with new records, click All Records again. The 
network element only sends records that have not already been supplied.  

Using the buttons on the bottom of the form, you can tell the network ele-
ment to stop supplying records, clear the display, or save the records to a file.
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Viewing Call Statistics
The Call Statistics form (Monitor > Data Logging > Call Statistics) displays 
information about the current or most recent call and statistics about recent calls. 
Statistics are displayed separately for digital P25 calls and for analog FM calls.

 

Last / current Call
Information about the current call. If there is no current call, information about 
the most recent call.

Type Whether the call was digital P25 or analog FM.

Duration How long (in seconds) the call has been in progress.

Source ID The ID of the sender (P25 calls only).

Destination ID The ID of the intended receiver of the call (P25 calls only).

Calls
The Calls area displays statistics separately for analog FM and for digital P25 calls.

Last 15 minutes The Last 15 minutes columns display call totals for the last completed 15-
minute period. When the next 15 minute period completes, the display updates 
with the totals for that period.

Since reset A column of totals that have accumulated since the network element was last 
reset.

RF Calls that were initiated from the RF interface.

Line Calls that were initiated from the analog line.

Network Calls that were initiated from another channel group member.

Microphone Calls that were initiated from the control panel microphone.
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Viewing the CSS Application Log
The CSS maintains a log of events in a file. This log may provide useful 
information if there are problems with the CSS or in the communications 
between the CSS and a network element.

To view the Application log

1. Navigate to the Log Files folder. This is a subfolder of the main CSS folder. 

2. Open Application.log in any text editor.

A display similar to the following appears.
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Module Details

The CSS can display details about the channel module, PA, and PMU of the 
network element it is connected to. Items under the heading Module Details 
display information about the module such as its frequency range and firmware 
version. To monitor the way the modules are operating, see “Modules” on 
page 74.

Viewing Reciter or Gateway Module Information
The Channel Module form (Monitor > Module Details > Channel Module) 
displays information about the channel module of the network element you are 
connected to. Use it to confirm exactly what it is that you are dealing with.

Band The RF frequency band of the reciter. This is the frequency range that the 
reciter is type-approved to operate in.

Alarm status Indicates whether the channel module currently has any alarm conditions. If the 
LED is green, there are no active channel module alarms. If the LED is red, the 
text box displays ‘Alarms active,’ and there is at least one active alarm. To see 
which alarm is active, select Monitor > Alarms > Status. 

Exciter frequency The current switching range of the exciter, as recorded by the network element 
when it was last tuned using the Calibration Software. You can confirm the 
actual switching range using a diagnostic test (Diagnose > RF Interface > 
Synthesizers). K4 band exciters have two sub-bands but the CSS can only 
display the switching range of one sub-band. However, the exciter can always 
operate in either sub-band. To have the CSS display the other sub-band, select 
it using the calibration software. 
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Receiver 
frequency

The current switching range of the receiver, as recorded by the network 
element when it was last tuned using the Calibration Software. You can 
confirm the actual switching range using a diagnostic test (Diagnose > RF 
Interface > Synthesizers).

Calibrated The date when the reciter was last modified using the Calibration Software. 
(This includes adjusting the switching range and tuning the frequency 
response.)

External reference Indicates whether the reference frequency is currently being provided by an 
external or an internal source.

Product code The product code and name for the type of channel module. 

Crypto module The status of the firmware crypto module in the channel module. Gateway 
modules usually need a crypto module so that they can be an encryption and 
decryption point for dispatcher communications. Base stations cannot normally 
have a crypto module; they are crypto-denied.

.

Versions
The Versions area (Monitor > Module Details > Channel Module) displays 
version information for the channel module’s digital and network boards. 

Serial number A unique identifier assigned to the board in the factory.

Firmware The version number of the firmware currently installed on each board.

Kernel The version number of the network board’s operating system kernel. 

Hardware The version number of the hardware for each board. This version number is 
used to establish compatibility with firmware versions.

Database The version number of the network element’s database. The CSS 
communicates primarily with the channel module’s network board. The CSS 
and the network board must use the same database version.

Viewing Power Amplifier Information
The Power Amplifier form (Monitor > Module Details > Power Amplifier) 
displays information about the PA module of the base station you are connected 
to. Use it if you need to confirm exactly what it is that you are dealing with.

Display Description

Not fitted A firmware crypto module is not present and cannot be 
loaded, as the reciter is crypto-denied.

(blank) A firmware crypto module is not present, but can be loaded 
by a CSS firmware download. The channel module is crypto-
capable.

1.01 The version number of the firmware crypto module.
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Product code The product code and name for the type of PA. 

Serial number A unique identifier assigned to the PA in the factory.

Band The RF frequency range that the PA is type-approved to operate in.

Isolator Indicates whether the PA is fitted with an optional internal isolator (not 
currently available.)

Power Specifies the RF power output rating of the PA. There are 5 W, 50 W, and 
100 W variants.

Alarm status Indicates whether the PA currently has any alarm conditions. If the LED is 
green, there are no active alarms. If the LED is red, the text box displays ‘Alarms 
active,’ and there is at least one active alarm. To see which alarm is active, select 
Monitor > Alarms > Status. 

Versions
The Versions area (Monitor > Module Details > Power Amplifier) displays 
version numbers for aspects of the PA. 

Calibrated The date when the PA was last calibrated using the Calibration Software.

Firmware The version number of the PA firmware.

Hardware The version number of the PA hardware.
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Viewing Power Management Unit Information
The Power Management Unit form (Monitor > Module Details > Power 
Management Unit) displays view information about the PMU if you are 
connected to the channel module in position 1 of the subrack. Use it if you 
need to confirm exactly what it is that you are dealing with.

Product code The product code and name of the PMU module. 

Serial number A unique identifier assigned to the PMU in the factory.

Alarm status Indicates whether the PMU currently has any alarm conditions. If the LED is 
green, there are no active alarms. If the LED is red, the text box displays ‘Alarms 
active,’ and there is at least one active alarm. To see which alarm is active, select 
Monitor > Alarms > Status. 

Submodules
The Submodules area (Monitor > Module Details > Power Management Unit) 
indicates which submodules the PMU is fitted with.

AC-DC converter Indicates whether the PMU is fitted with an AC-DC converter submodule, so 
that it can use mains input.

DC-DC converter Indicates whether the PMU is fitted with a DC-DC converter submodule, so 
that it can use DC power as an input. The box alongside indicates whether the 
submodule is designed for a 12, 24, or 48 V input. 

Standby converter Indicates whether the PMU is fitted with a standby converter submodule. 

Auxiliary output Indicates whether the PMU is fitted with a submodule that provides an 
auxiliary power output. The box alongside indicates whether the submodule is 
designed for a 12, 24, or 48 V output.
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Versions
The Versions area (Monitor > Module Details > Power Management Unit) 
displays version numbers for aspects of the PMU. 

Calibrated Indicates when the PMU was last calibrated using the Calibration Software.

Firmware The version number of the PMU firmware.

Hardware The version number of the PMU hardware.
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Part E Configuring

You can use the CSS to configure TB9100 base stations and 
P25 Console Gateways.

Click Configure, choose a configuration, and select an item 
from the navigation pane. 

Choosing a Configuration

Network Element

Working with the Channel Table

Working with Service Profiles

Configuring the System Interface

Configuring Miscellaneous Items

RF Interface

Working with Channel Profiles

Working with Signaling Profiles

Configuring the CWID

Enabling RF Linking

Channel Group

Network

Working with Channel Groups

Trunking

Analog Line

General Analog Line Settings

Working with Calling Profiles

Encryption

Defining Group Memberships

Mapping Tone Remote Commands

Setting Tone Remote Options

Mapping MDC1200 Addresses
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Choosing a Configuration

If you click Configure and the CSS doesn’t already have a configuration in 
memory, it asks you to choose one to work with. 

Click New to open a new configuration based on the default template.

Click Open to select an existing configuration file.

Click Read to read in the configuration of the network element you are 
connected to.
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Network Element

Under Network Element, the navigation pane groups items that apply to the 
network element as a whole and are not specific to a particular interface.

Working with the Channel Table
In the Channel Table form (Configure > Network Element > Channel Table),  
you can view the configured  channels, edit them, and add more channels. 

Channel Table Details
The Channel Table form (Configure > Network Element > Channel Table) 
displays the channels defined in the channel table of the configuration file that 
you opened or the network element database that you read.

The form contains a table that displays a row for each channel. The row 
indicates the channel’s number and name, the configured transmitter power 
output for mains and battery power, and the profiles that have been assigned to 
the channel.

The arrow at the left of one row indicates that that row is selected; if you click 
Add, a copy of that row will be added. Use the mouse or the arrow keys to 
change the selection. When you make any changes to a row, the arrow changes 
to a pencil.

Important: The arrow does not define the current channel. To find 
out the channel that the network element is currently operating on, 
select Monitor > Interfaces > RF Interface.

The first two columns indicate the number and name of each channel. The 
other columns define the main characteristics of each channel. Frequencies and 
transmit output power you can edit directly. Profiles and the channel group are 
selected from a list. Click a cell and a drop-down list appears, showing the items 
that have been defined. 

Num The number of the channel. It is not editable, so that you do not break existing 
Task Manager statements. To replace a deleted channel, select the previous 
channel and click Add. This adds an entry to the channel with the number of 
the deleted channel. 
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Name The name of the channel. When you create a channel, it is given a default name 
of the form ‘Channel nnn’ where nnn is the channel number. You can edit this 
name to reflect the channel’s purpose or users. 

RF repeat The RF repeat column specifies whether the base station operates as a repeater. 
For an introduction to the Repeat function, see “RF Repeat Function” on 
page 7.

Transmit 
Frequency

The radio frequency that the channel transmits on. 

Receive Frequency The radio frequency that the channel receives on.

Mains Power The RF power output in watts. This is the power that the channel is configured 
to provide when the base station is using mains power. 

Note: If you specify an RF power of 100 W and the PA is rated at 
50 W, it will run at 50 W. There is therefore no need to alter this 
value if you temporarily substitute an amplifier with lower power, 

for example, if there is a fault and you don’t have a fully powered module on 
hand.

Battery Power The RF power output in watts. This is the power that the channel is configured 
to provide when the base station is using battery power. 

Trunking Select Conventional for non-trunked operation or Trunked if the channel is to 
be part of a trunked system. This setting specifies how the channel operates. 
The network element needs to behave differently, depending on whether its 
channel group is controlled by a trunking site controller or a dispatcher.

Channel Profile The channel profile assigned to the channel. See “Profiles” on page 4 for an 
overview of the different profiles and their functions.

Signaling Profile The signaling profile assigned to the channel. 

Channel Group The channel group that the network element is part of. 

Option Description

Enabled The base station operates as a repeater. It is able to 
transmit the signal received from its RF interface or the RF 
interface of other channel group members. It repeats the 
best RF signal received by the channel group, not 
necessarily the signal it receives on its own RF interface.

Disabled The base station does not repeat received RF signals. It can 
only transmit what is provided by this base station’s or 
another channel group member’s dispatcher interface or 
control panel microphone. 

DispatchControlled The repeat function is under dispatcher control. The DFSI 
gateway can automatically pass dispatcher commands on 
to the channel group to enable or disable repeat. If the 
dispatch equipment is connected via the analog line, Task 
Manager actions are needed to implement the commands 
and propagate them to the channel group. For more 
details, see “RF repeat actions” on page 201 and the 
TaitNet P25 System Manual.
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Service Profile The set of services that the inbound channel will support.

Calling Profile The calling profile used by the analog line.

Add Inserts a copy of the selected channel immediately below that channel. For 
more information, see “Adding a Channel” on page 95. 

Delete Removes the selected row from the channel table. (To restore a row with the 
deleted channel number, select the row above and click Add).

Editing a Channel
Editing a channel is mostly about assigning the correct profiles to it.

To edit a channel

1. In the channel table (Configure > Network Element > Channel Table), 
click in the row that defines the channel. An arrow appears at the left of the 
row indicating that it is selected.

2. If desired, click in the Name cell and edit the channel’s name.

3. If necessary, alter the receive frequency and the transmit frequency.

Important: Do not assign a prohibited frequency to the transmitter. 
For example, 406.0-406.100 MHz is reserved internationally for 
distress beacons.

Note: The CSS does not check whether the base station can operate 
on the configured frequency pair.

For simplex applications, you can make the receive and transmit frequencies 
the same. The base station automatically increases the transmit frequency by 
25 kHz when it is not transmitting, to avoid desensitizing the receiver.

4. In the Main Power and Battery Power columns, specify values for the 
transmitter’s RF output power when powered by mains and DC 
respectively.

5. In the Trunking column, specify whether the channel is part of a 
conventional or a trunked system. 

6. In the Channel Profile column, select the channel profile you want the 
network element to belong to. (Click in the cell, then click the arrow that 
appears. A list of the defined channel profiles appears.) The channel profile 
determines a whole range of settings, including switching behavior and (for 
analog mode), receiver gating and channel spacing. 

7. In the Signaling Profile column select the channel profile you want the 
base station to belong to. This defines the use of NAC (for digital P25 
mode), subaudible signaling (for analog FM mode), and tail timers.

8. In the Channel Group column, select the channel group that you want the 
network element to belong to. This determines the multicast address on the 
TaitNet P25 digital network that it sends voice to and listens to. 

9. In the Service Profile column, select a the service profile that defines the 
set of services that you want the channel to support. 

10. In the Calling Profile column, select a calling profile that you want to 
apply to the analog line (dispatcher commands that use MDC1200 can 
change this selection or override some of its settings.) 

11.Click OK to confirm the changes and close the form. 
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Note: If you are editing a large number of channels, periodically 
click OK, and then (on the toolbar) Save. Otherwise you could lose 
a lot of data if there is a computer failure.

Adding a Channel
You can add a channel to the channel table. 

1. Select Configure > Channels and Profiles > Channel Table.

2. Click on a channel similar to the one you want to add. A black triangle 
appears to the left of the row.

3. Click Add. This inserts a copy of the selected channel immediately below 
that channel. The inserted channel is given the next available number and 
an equivalent name, for example, if the next available channel number is 
008, the name is Channel 008. 

4. If desired, click the Num column heading to sort the new channel into 
numerical order.

5. Edit the values in the channel row as needed (see “Editing a Channel” on 
page 94).

Selecting the Operating Channel
Different methods can be used to select the channel that a network element 
operates on. For each method, you need to configure the network element. 

Selection at Run 
mode

The configuration contains a Task Manager task that instructs the network 
element to go to a channel on the transition to Run mode, for example: 

IF Network Element in Run mode THEN Go to Channel Channel 001

Normally, the network element is shipped with this channel selection method. 
(This Task Manager task can be deleted. Once the network element has 
operated on a channel, it remembers that channel even through a reset.)

Selection by 
digital inputs

The operating channel can be selected by an external device that is able to 
toggle the state of the network element's digital inputs. You must specify how 
many digital inputs are involved and create Task Manager tasks that instruct the 
network element to go to a channel when the combination of digital input 
states produces the required digital input value.

1. In the System Interface form (Configure > Network Element > System 
Interface), specify the number of bits to use in computing an input value. 

2. Create Task Manager tasks that select the channel based on the digital input 
value, for example:

IF Digital input value 1 THEN Go to Channel Channel 001

IF Digital input value 2 THEN Go to Channel Channel 002

IF Digital input value 3 THEN Go to Channel Channel 003

Selection by 
dispatcher 
command 
(Analog dispatch 
equipment)

Dispatcher commands can select the current channel. The dispatch equipment 
sends a function tone. You need to set up Task Manager statements such as the 
following: 

IF Tone remote detected 550 THEN Go to channel 2

When the analog line receives a 550 Hz function tone, the network element 
switches to that channel. If the network element is part of a channel group, 
configure all channel group members for collective control of the channel 
number.
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We recommend that you delete the Task Manager task that selects a channel on 
transition to Run mode. Then a network element will return to its previous 
channel after a reset. This is the channel that the dispatcher expects to be on.

 Selection by 
dispatcher 
command (digital 
dispatch 
equipment)

Dispatcher commands can select the current channel. The dispatch equipment 
sends a channel select command over the DFSI interface. If the network 
element is part of a channel group, configure all channel group members for 
collective control of the channel number. 

We recommend that you delete the Task Manager task that selects a channel on 
transition to Run mode. Then a network element will return to its previous 
channel after a reset. This is the channel that the dispatcher expects to be on.

Other Methods Any Task Manager input can be used to select a channel. A SU user could for 
example make a call using a special NAC to change channel. 

Working with Service Profiles
The Service Profiles form (Configure > Network Element > Service Profiles) 
displays a list of available service profiles. A service profile indicates which 
additional services are permitted. Emergency alert is always permitted, so does 
not appear. All acknowledgements are also always permitted. Service profiles 
apply when the network element is operating in digital P25 mode. They do not 
affect MDC1200 signaling in analog FM mode. Tait recommends that all 
services are normally enabled. Consoles and SUs can allow or disallow services 
to the end user. However, services can be disabled at the base station to prevent 
pirate SUs from using them on the TaitNet P25 digital network. 

A service profile can be selected by a channel in the channel table and/or by a 
calling profile. When a service profile is selected by a channel, it controls the 
behavior of the inbound RF channel. If a service is enabled, the inbound 
channel supports that service. When a service profile is selected by a calling 
profile, it controls the behavior of the analog line in. If a service is enabled, the 
analog line lets the analog console system use that service. The console system 
sends a MDC1200 signal, which is converted into the digital P25 equivalent.
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The profiles display Yes or No for each service. Yes means that the service is 
enabled, No that it is disabled. The following describes briefly what each service 
is.

Name The name of the service profile.

Call Alert Call alert (also known as paging) is a message that asks the SU user to call the 
sender. It may for example trigger a persisting message on the target SU such as 
a repeating tone and flashing display.

Status Report A status report is a message that the SU sends, perhaps in response to a status 
request. 

Status Request A status request is a message that requests a status report.

Message A message is a free-form text string.

Presence Check A presence check is a message that checks out a given SU. If the SU responds, 
it is within communications range and its RF circuitry is functioning. The 
operator is not disturbed. 

Remote Monitor A remote monitor message causes the SU to initiate a call by itself. It allows the 
sender to listen to what is going on at the SU's location. 

Inhibit An inhibit message disables the destination SU, for example if it is reported 
stolen. When the Inhibit service is enabled, the Uninhibit service is also 
enabled.

Data The data service (not currently supported) involves the sending and receiving 
of data rather than voice.

Configuring the System Interface
In the System Interface form (Configure > Network Element > System Inter-
face), you can configure the operation of digital inputs and outputs and the serial 
port. These all connect to the DB9 labeled DIG on the rear of the channel module. 

To monitor the current status of the digital inputs and outputs, or to carry out 
diagnostic tests on them, select Diagnose > Line Interfaces > System Interface.
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Pin assignments
The unnamed table displays the functions assigned to each pin on the DIG DB9 
connector at the rear of the channel module. The display reflects the choices 
made for Pins 1 and 9.

Serial port
Baud rate The default baud rate setting is 57,600 bit/s and is not normally changed. For 

Calibration Software operation it must be at this speed. The setting is ignored 
when the serial port provides raw C4FM data and a baud rate of 19,200 is used 
instead. 

Computed input value

Number of bits Tells the network element how many bits (digital inputs) to use in calculating 
the digital input value. Digital input 0 provides the least significant bit. Four 
digital inputs are always available. To make a fifth digital input available, 
configure Pin 1 as Digital input 4. Inputs are assigned the value 0 when they are 
low and 1 when they are high. To monitor the current computed input value, 
select Diagnose > Line Interfaces > System Interface.

The digital input value can be used as an input in Task Manager statements (see 
“Digital input value” on page 193). Task Manager can for example select the 
channel number to use based on the computed input value.

Pin 1
The three option buttons let you specify one of three functions for Pin 1. 

Pin 9
The two option buttons let you specify one of two functions for Pin 9. 

Function Description

Antenna relay Select this option in simplex applications to provide 
a signal that drives an antenna relay. For details, 
see “Antenna Relay Operation” on page 99. 

Digital output 1 Configures pin 1 as a digital output. Select this 
option if you need a digital output.

Digital input 4 Configures pin 1 as a digital input. Select this 
option to make a fifth bit available for the 
computed input value or to make a fifth digital 
input available. 

Function Description

RSSI output Configures pin 9 to output a voltage proportional 
to the received signal strength. For more details, 
see “RSSI Output” on page 99.

Digital output 0 Configures pin 9 as a digital output. You can also 
configure pin 1 as a digital output. 
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RSSI Output
The TB9100 can provide an RSSI output on pin 9 of the DB9 labeled DIG. 
This is used for external voting or in systems with two base stations for 
redundancy.

To enable and configure the RSSI output

1. Select Configure > Network Element > System Interface.

2. Under Pin 9, click RSSI output.

3. Under RSSI output, enter into the Signal level boxes the minimum and 
the maximum signal strengths that the base station needs to deal with. The 
RSSI output will be 0.5 V at the minimum signal strength, increasing 
linearly up to 4.5 V at the maximum signal strength. 

Antenna Relay Operation
For simplex applications, the base station can be set up with an antenna relay, 
so that the receiver and transmitter can share the same antenna. For details, see 
the installation instructions that come with the Tait TBAA03-15 Relay Coaxial 
Assembly kit.

To enable the operation of an antenna relay

1. Select Configure > Network Element > System Interface.

2. Under Pin 1, click Antenna relay.

3. In the channel table, make sure that RF repeat is disabled in all channels. 
Using an antenna relay when RF repeat is enabled will result in relay chatter. 
When the base station receives a signal, it switches to transmit so that it can 
repeat it. The result is that it can no longer see the signal. As there is nothing 
to transmit, it switches back to receive, which causes it to switch to transmit 
again, and so on. 

4. Program these settings into the base station.
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Configuring Miscellaneous Items
The Miscellaneous form (Configure > Network Element > Miscellaneous) 
gathers together a number of settings.

Minimum battery voltages
Use the Power configuration area (Configure > Network Element > 
Miscellaneous) to adjust the minimum voltages for the DC power input to the 
PMU. You cannot adjust these voltages below limits fixed in hardware. 

Three pairs of voltages are displayed, corresponding to the PMU’s different 
DC-DC converter options (a nominal 12 V, 24 V, or 48 V input). The voltages 
that apply have a white background and can be edited. 

If the battery voltage falls below the value in the relevant Power shutdown 
voltage box and there is no AC power, the PMU shuts down. (If there is AC 
power, a battery protection mode alarm is raised, indicating that the loss of AC 
power will result in shutdown.)

If the battery voltage rises above the value in the Power startup voltage box, 
the PMU re-starts. (For full details, see the TB9100/P25 CG Installation and 
Operation Manual.)

Note: Network elements with no PMU or with a PMU that has no 
standby converter cannot have their shutdown and startup voltages 
adjusted; these voltages are fixed in hardware. 

Auxiliary power control
If the PMU is fitted with an auxiliary power supply unit, you need to configure 
it to suit the way it will be used. Generally, its output can be used to charge 
batteries or to power other site equipment. If it is used to charge batteries, 
configure it to be on when mains power is on. If it is used to power other site 
equipment, use Task Manager to turn it on and off.

Important: While the auxiliary power output can be used for more 
than one purpose at once, this is not generally recommended. It can 
result in a short-circuit and equipment damage. The output is 

floating. If it is connected to a negatively earthed battery and to positively 
earthed auxiliary equipment, a short-circuit will result.

In the Power configuration area (Configure > Network Element > 
Miscellaneous), the Aux power control box specifies what controls the auxiliary 
output. Select one of the following options.



 

TB9100 Customer Service Software User’s Manual   Network Element 101

Configuring Fan Settings
The Fan area (Configure > Network Element > Miscellaneous) gathers 
together fan-related settings. These specify how the network element monitors 
its PA and PMU fan and when the PA fan is turned on. The operation of the 
reciter fan is not configurable.

PA Fan Control
The PA Fan Control area determines when the PA fan is turned on. The 
settings can be adjusted to meet user requirements based on the transmit duty 
cycle and whether the site facility is air-conditioned. Strike a balance between 
lengthening fan life and reducing the PA operating temperature.The settings 
you choose should also help avoid extreme temperature swings. The PA is 
designed to run at full duty cycle at up to +60°C ambient operating 
temperature into any transmit VSWR load.

Note: While the PA fan on/off thresholds are user-configurable, the 
PMU fan has fixed on/off thresholds controlled by PMU firmware.

Threshold 
temperature

If the temperature at the driver, final 1, or final 2 stages exceeds the threshold 
temperature, the fan is turned on (but only when the PA is transmitting, if the 
check box below is selected). When the temperature at all three parts of the PA 
falls 5°C below the threshold, the fan is turned off. 

Tip: To monitor all PA temperature values, select Diagnose > Power 
Amplifier > Control Tests. 

Only run fan when 
transmitting

When this check box is selected, the fan will only operate if the PA is transmitting 
and any one of the monitored PA temperatures exceeds the threshold.

Option Description

Task Manager The Task Manager action Unlock Auxiliary Supply will turn 
the output on. You need to define suitable tasks for your 
system and application so that the auxiliary power output is 
turned on when it is needed and turned off when it needs to 
be off. See “Auxiliary supply lock” on page 200.

Mains Output is provided only when the PMU uses AC mains power. 
This option is suitable for re-charging the batteries used for the 
PMU’s DC power input. The Task Manager action Unlock 
Auxiliary Supply is not used. If the network element has a 
DC only PMU, this setting never turns the auxiliary power on.
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Note: Fans used in the TB9100 must have the correct wiring. Power 
and ground (2-wire fans) or power, ground and rotation detect (3-
wire fans). Both fans in the front panel should be of the same type.

Type
Specify whether the PA and PMU fan type is 2-wire or 3-wire. If you select 3-
wire, the network element will use the third wire as a rotation detector. If it has 
turned the fan on but does not detect rotation, it activates the ‘Fan failed’ alarm.

Configuring the Fan to Turn on with the PA
You can configure the PA fan to turn on when the PA begins transmitting. 
Follow these steps:

1. Select Configure > Network Element > Miscellaneous.

2. Set the threshold temperature to a value that is lower than the usual site 
ambient temperature.

3. Select the Only run fan when transmitting check box.

With these settings, the PA fan normally turns on with RF output and cools the 
PA as soon as it begins working. It turns off when the RF output stops. How-
ever, if the PA temperature is below the threshold, the fan does not turn on.

External clock reference frequency (if fitted)
Use the External clock reference frequency (if fitted) area (Configure > 
Network Element > Miscellaneous) to specify the frequency of an external 
reference frequency source. If an external source is connected to the reciter, 
you must select the appropriate option so that the reciter knows what the 
frequency is. 

Control panel
The Enable check box in the Control panel area enables the speaker and 
microphone. Disabling them may be desirable for security reasons. Before using 
them, a maintainer on site must first modify the configuration.
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RF Interface

The behavior of the RF interface is determined by the channel profile and the 
signaling profile that are assigned to the current channel in the channel table. 
You can also configure the sending of a morse code station ID.

Working with Channel Profiles
The Channel Profiles form (Configure > RF Interface > Channel Profiles) 
displays the list of profiles. You can add a new profile, or edit an existing one.

The form displays a row of information for each profile. An arrow appears 
alongside the profile selected on the form. To sort the display by a particular 
column, click the column heading.

The Name column indicates the name of the profile. 

The Analog Rx and Digital Rx columns show you whether the profile lets 
the base station receive analog FM, digital P25, or both (dual mode).

If the Tx Enabled column displays No, the base station cannot transmit if its 
channel is assigned that profile. 

For more detail about these columns, and about other profile details, see 
“Editing a Channel Profile” on page 105.

Buttons along the bottom of the form let you add a new profile, edit the 
selected profile, or delete the selected profile.
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Adding a Channel Profile
The base station requires at least one channel profile but you can define up to 
16 of them. One is needed for each combination of parameter variations that 
the base station needs to provide. For example, the base station may need to 
operate normally in mid-band but sometimes in wideband. In addition, 
conditions may sometimes be noisy, so different receiver gating settings are 
sometimes required. For these options four profiles are needed, one for each 
combination of settings. 

The following instructions do not deal with all configuration items. For more 
detailed information about the individual items, see “Editing a Channel Profile” 
on page 105.

Tip: Set up a test profile and assign it to a channel. Use this channel 
when testing the system before commissioning.

To add a channel profile

1. Select Configure > RF Interface > Channel Profiles. The Channel Profiles 
form appears.

2. Click a profile, and then click Add. A copy of the profile appears in the row 
below.

3. Click Edit. The Edit Channel Profile dialog box appears.

4. In the Profile name box, enter a suitable name for the profile.

5. Under Receiver modes, select both the Analog and Digital check boxes 
to enable the base station to receive in both analog FM and digital P25 
modes. Alternatively, select one or the other check box for single-mode 
operation. 

6. Under Analog receiver gating, set the criteria for receiver squelch. You 
can have gating based on RSSI as well as SINAD and choose whether one 
or both criteria must be met. These criteria apply to analog FM mode only. 
For more details, see “Analog Receiver Gating” on page 106.

7. Under Analog RF configuration, specify the following properties for the 
RF channel.

a. The receiver channel bandwidth and the maximum transmit deviation. 

b. The deviation applied to subaudible signaling if the base station will 
transmit with CTCSS or DCS.

c. The type of filter used on the receive and transmit paths.

d. Whether automatic gain control is applied.

8. Select the RF transmit check box to enable the transmitter.

9. Click OK to confirm the changes and close the dialog box, returning you 
to the Channel Profiles form.
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Editing a Channel Profile
Use the Edit Channel Profile dialog box to view the details of the selected 
channel profile and modify them. 

Profile name Specifies the name of the profile. If you edit this name, make sure that the new 
name is unique.

Previous Profile Displays the previous profile in the list, without requiring that you leave the 
dialog box. This confirms any changes you have made to the current profile, 
which means they cannot be undone.

Next Profile Displays the next profile in the list, without requiring that you leave the dialog 
box. This confirms any changes you have made to the current profile, which 
means they cannot be undone.

Receiver modes
The Receiver modes area specifies which modes the base station receiver can 
operate in. You must select at least one mode. If both modes are selected, the 
base station functions as a dual-mode receiver. In dual mode, if the receiver 
achieves frame synchronization, it operates in digital mode. Otherwise, it 
operates in analog mode.

Analog The base station can receive analog FM signals.

Digital The base station can receive digital P25 signals.
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Analog Receiver Gating
In the Edit Channel Profile dialog, the Analog receiver gating area configures 
the way receiver gating (also known as receiver squelch) operates when the base 
station is receiving in analog FM mode. 

Analog gating can be based on:

RSSI 

SINAD 

RSSI and SINAD

RSSI or SINAD

RSSI gating operates more quickly and is suitable for repeater links. SINAD 
gating takes longer but is more immune to noise interference and is suitable for 
the repeater itself or for a line-connected base station. 

Note: Gating in digital P25 mode is not configurable. The receiver 
unmutes when frame synchronization is achieved. If the signal 
subsequently deteriorates so that forward error correction is unable 
to compensate for errors, the voice stream is discontinued.

If analog gating is set at low levels for a dual-mode receiver, breakthrough of 
the digital P25 signal can occur in analog FM mode. The signal is good enough 
to unmute the receiver but not to achieve frame synchronization. 

Tip: If possible, add subaudible signaling to dual-mode receivers. 
This prevents the analog receiver from briefly unmuting to a digital 
signal until frame synchronization is detected.

Time

RSSI or SIN
A

D

Gate 
opens

<
--H

ysteresis-->

Gating level

Gate 
closes
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RSSI Gating 
(carrier)

Enables gating based on the base station’s measurement of the received signal 
strength. This is also known as Carrier gating. This method is not 
recommended for low signal levels. If the level is set low (for example -118 
dBm) and the hysteresis is set to High, the gate may stay open permanently. 

SINAD Gating 
(noise)

Enables gating based on the estimated SINAD (obtained by measuring the out-
of-band noise). This is also known as noise gating. 

Logic When both RSSI and SINAD gating options are enabled, a drop-down list box 
provides options for the gating logic. 

Tip: Select OR and set the RSSI level high (for example -100 dBm). 
This gives quick gating when the signal level is high. When the 
signal level is low, gating occurs based on SINAD. This is slower but 
more accurate. 

Level The two Level boxes define the level (of RSSI or SINAD) required to enable 
receiver gating and pass the received audio. The RSSI level is in dBm. For 
equivalent values in microvolts, see “Converting Between Microvolts and 
dBm” on page 108.

Hysteresis The two Hysteresis boxes specify how far the RSSI or SINAD must fall below 
the level set in the corresponding Level box to disable receiver gating and mute 
the received audio. 

The Hysteresis box for RSSI gating provides the options Low, Medium, and 
High. Typically, these options correspond to hysteresis values of 1–2, 2–5, and 
5–10 dB respectively. The actual hysteresis varies with the RSSI gating level 
(see below). 

Choose a hysteresis level, and then test TB9100 operation, adjusting the setting 
as appropriate.

Note: SINAD dB hysteresis is a recovered audio level measurement. 
It does not correlate to RF dBm levels.

Option Description

AND The receiver gate opens when both RSSI and SINAD 
values reach the required level. Similarly, it only closes 
when both RSSI and SINAD fall below the required 
level minus their respective hysteresis.

OR The receiver gate opens when just one of the RSSI or 
SINAD values reaches the required level. Similarly, it 
closes when either RSSI or SINAD falls below the 
required level minus the hysteresis. 
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Converting Between Microvolts and dBm
Use the following table to convert displayed levels in dBm into microvolts. 

Table 1: Typical hysteresis values for the different hysteresis options

Gating Level Low Medium High

-119 dBm 0.8 3.5 5

-118 dBm 1.1 3.4 5.9

-117 dBm 1.3 3.8 5.4

-116 dBm 1.9 3.9 6

-115 dBm 2.2 4.7 6.4

-114 dBm 2.4 4.7 6.4

-110 dBm 2.9 5.6 7.4

-105 dBm 3.4 6.1 8.1

-100 dBm 3.8 6.8 8.7

-95 dBm 4.1 6.8 8.6

-90 dBm 4.7 7 9.2

Level in 
Microvolts

Level in dBm
Level in 
Microvolts

Level in dBm

0.10 -126.99 10.00 -86.99

0.20 -120.97 12.50 -85.05

0.25 -119.03 15.00 -83.47

0.30 -117.45 17.50 -82.13

0.40 -114.95 20.00 -80.97

0.50 -113.01 30.00 -77.45

0.60 -111.43 40.00 -74.95

0.80 -108.93 50.00 -73.01

1.00 -106.99 60.00 -71.43

1.50 -103.47 70.00 -70.09

2.00 -100.97 80.00 -68.93

2.50 -99.03 90.00 -67.90

3.00 -97.45 100.00 -66.99

4.00 -94.95 150.00 -63.47

5.00 -93.01 200.00 -60.97

7.50 -89.49 250.00 -59.03 
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Analog RF Configuration
In the Edit Channel Profile dialog, use the Analog RF configuration area to 
specify the nominal channel spacing for the receiver and the transmitter. No 
hardware modification is necessary when the RF configuration is changed.

Note: Your country may use Narrow band, Mid band and Wide 
band to refer to different channel spacings. Make sure that the 
option you select has the correct value. 

Receiver channel Specifies the receiver’s nominal channel spacing. The available options are 
expressed both as a description (for example, Mid Band) and as the kHz value 
of the nominal channel spacing.

Note: The Receiver channel box does not determine the actual 
spacing between channels. It determines the receiver IF bandwidth. 
For example, 20 kHz Mid Band sets the receiver IF bandwidth to 

12 kHz. Normally, you would select this option if the channels in your band 
plan have a 20 kHz channel spacing. However, your band plan may be 
irregular, or you may want to specify (when you enter frequencies into the 
channel table) a greater spacing between channels, for example, 50 kHz. 

Max Tx deviation Specifies the highest deviation that the transmit channel is permitted to have. 
The available options correspond to the following channel spacings:

Note: The Max Tx deviation box does not determine the actual 
spacing between channels. For example, 4000 Hz Mid Band sets the 
maximum transmit deviation to 4 kHz. Normally, you would select 

this option if the channels in the band plan have a 20 kHz channel spacing. 

Option Equivalent Rx IF Bandwidth

12.5 kHz Narrow Band 7.5 kHz

20 kHz Mid Band 12 kHz

25 kHz Wide Band 15 kHz

Option Channel Spacing

2500 Hz Narrow Band 12.5 kHz

4000 Hz Mid Band 20 kHz

5000 Hz Wide Band 25 kHz
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However, the band plan may be irregular, or you may want to specify (when 
entering frequencies into the channel table) a greater spacing between channels, 
for example, 50 kHz. 

Subaudible 
deviation

Specifies the deviation that CTCSS or DCS signaling will cause to the carrier 
frequency. Options are specified both absolutely in Herz and relatively as a 
percentage of the selected Max Tx deviation. Gain will be applied to the 
CTCSS signaling to cause the deviation specified. If you subsequently alter the 
Max Tx deviation, the Herz value of the subaudible deviation will alter, but not 
its percentage.

Adding subaudible deviation reduces speech deviation correspondingly. This 
prevents over-deviation by ensuring that the total transmit deviation is not 
increased by the addition of subaudible signaling. (In the TB8100, you can 
choose not to reduce the speech deviation, but this option is not currently 
available in the TB9100.) 

Receive filter The Receive filter drop-down lists let you select an audio filter (see table below) 
that will be applied to received analog FM signals. 

Transmit filter The Transmit filter drop-down lists let you select an audio filter (see table 
above) for the transmit path. 

Automatic gain 
control (AGC)

Specifies whether automatic gain control is applied at the RF stage. AGC 
provides enhanced high signal handling capabilities and receiver 
intermodulation protection. When signal levels are high, however, the 
minimum sensitivity may be degraded.

AGC is normally enabled, but Tait recommends disabling it in the following 
situations: 

The expected receive signal strength is < -107 dBm (1 microvolt) and strong 
interfering signals (> -30 dBm (7000 microvolts)) are anticipated at the 
receiver input.

TIA/EIA or AS-4295 RF performance testing is being carried out.

Switching
In the Switching area, you can disable the transmitter.

Audio filter Description

Flat full Passes audio evenly across the audio spectrum. 

Flat speech Passes only speech frequencies.

De pre emph 
speech

Passes audio in the speech range, de-emphasizing 
(attenuating) higher frequencies (receive filter) or pre-
emphasizing them (transmit filter). 

De pre emph 
full

Passes all audio, de-emphasizing (attenuating) higher 
frequencies (receive filter) or pre-emphasizing them (transmit 
filter).



 

TB9100 Customer Service Software User’s Manual   RF Interface 111

RF transmit Clear this check box to disable the transmitter. A base station with a disabled 
transmitter and receiver can still function as a gateway between the analog line 
interface and the channel group that it belongs to. 

Microslots per slot In conventional systems, most base stations will use the default value of 1 
microslot per slot. With this setting, all status symbols are set to ‘idle’ or ‘busy.’ 
Busy means that a signal is being received on the uplink so that SUs should not 
transmit. 

In trunking control channel operation, more microslots per slot are required. 
This sets up a slotted structure on the downlink. Status symbols are transmitted 
at every microslot boundary (every 7.5 ms) but they are set to “Unknown,” 
except at the slot boundary. We recommend 6 microslots per slot. This allows 
a SU to read the status symbol and transmit a TSBK before the next slot 
boundary, so that its status symbol is ‘idle’ and the next slot is available to other 
SUs. 

Some SU signaling on the control channel uses multiple block trunking packets. 
Examples are requests for telephone interconnect calls and responses to 
authentication requests during registration. These will overlap into the next slot 
if there are only 6 microslots per slot. If SUs use a lot of this signaling, increasing 
the number of microslots per slot beyond 6 could increase control channel 
efficiency.

Working with Signaling Profiles
The Signaling Profiles form displays a list of the current signaling profiles.
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For each profile, the display shows you the NACs that are used for receiving 
and transmitting in digital P25 mode and the subaudible signaling that is used 
in analog FM mode.

Buttons along the bottom of the form let you add a copy of, edit, or delete the 
selected profile.

Adding a Signaling Profile
The base station requires at least one signaling profile. You can define up to 16 
of them. The signaling profile defines the NACs that the base station transmits 
with and unmutes to, the subaudible signaling, and the tail timers. For more 
detailed information about the individual items in the profile, see “Editing a 
Signaling Profile” on page 113. 

Tip: Set up a test profile and assign it to a channel. Use this channel 
when testing the system before commissioning.

To add a signaling profile

1. Select Configure > RF Interface > Signaling Profiles. The Signaling Profiles 
form appears.

2. Click a profile, and then click Add. A copy of the profile appears in the row 
below.

3. Click the profile, and then click Edit. The Edit Signaling Profile dialog box 
appears. 

4. In the Profile name box, enter a suitable name for the profile.

5. Under NAC enter the network access codes that the base station will 
operate on in digital P25 mode. Some systems require different values for 
transmitting and receiving. 

6. If you want the base station to unmute to any NAC, select the Accept any 
check box.

7. For community repeater operation or to enable digital dispatch equipment 
to specify the transmit NAC, select the From stream check box. 

8. Under Subtones, select the CTCSS tones or DCS codes that the base 
station will use when operating in analog FM mode.

9. In the Tail Timers tab, configure the way that audio, signaling, and carrier 
end at the end of analog FM transmissions.

a. If the network uses CTCSS signaling and the SUs are configured to 
respond to reverse tone bursts, enable and configure reverse tone bursts 
at the end of transmissions.

b. You can enable a hang timer and specify the length of time that the base 
station continues to transmit carrier and subaudible signaling after audio 
has ceased.

c. You can enable a soft-off timer and specify the length of time that the 
base station continues to transmit carrier after audio and subaudible sig-
naling have ceased. 

10.Click OK to confirm the changes and close the dialog box. The new profile  
appears in the Signaling Profiles form.



 

TB9100 Customer Service Software User’s Manual   RF Interface 113

Editing a Signaling Profile
Use the Edit Signaling Profile dialog box to view the details of the selected 
signaling profile and modify them.

Profile name Specifies the name of the profile. This name is used in the Channel Table and 
Signaling Profile forms.

Previous Profile Displays the previous profile. This means you don’t need to return to the list of 
profiles. 

Next Profile Displays the next profile in the list. 

General tab
In the Edit Signaling Profile dialog box, the General tab specifies the network 
access codes that the receiver recognizes and the transmitter applies. Network 
access codes only apply to digital P25 mode; in analog FM mode, the specified 
subtones are used. 

NAC
Use the NAC area to specify the network access codes that the base station 
sends and receives. NACs are always entered and displayed as hexadecimal 
numbers. For more information, see the TaitNet P25 System Manual. 

Receive Specifies the network access code that the base station unmutes to. Enter a 
hexadecimal value (the default is 0x293). F7E and F7F are special values 
reserved by the P25 standard.

Accept any Select this check box and the base station will unmute to any NAC. This is the 
equivalent of entering F7E or F7F. The NAC in the Receive box then has no 
effect.

Note: Only select this check box if your application requires it. 
TB9100 receivers are highly sensitive in both analog and digital 
modes and can occasionally falsely detect digital P25 signals. If the 

receiver is set to unmute only to a particular NAC value, the likelihood of false 
detections is greatly reduced. If not, spurious noise can be repeated. Further-
more, if the TB9100 receiver is set to dual mode, the false detection of a digital 
P25 signal can cause an analog FM call to drop out for up to 180 milliseconds. 
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Transmit Specifies the NAC that the base station uses when transmitting. The configured 
transmit NAC can be overridden by the NAC in the voice stream if the From 
stream check box is selected (see below). Enter a hexadecimal value (the default 
is 0x293). F7E and F7F are special values reserved for receivers by the P25 
standard and are not permitted.

From stream Select this check box and the transmitter will transmit using the NAC in the 
voice stream instead of the configured NAC. The NAC could be supplied by 
the calling SU (community repeater operation) or by the digital dispatch 
console. If the stream does not specify a NAC (or if it specifies F7E or F7F), the 
transmitter uses the configured transmit NAC. 

Subtones
Use the Subtones area to specify the subaudible signaling that the base station 
will use in analog FM mode. The base station supports CTCSS frequencies and 
DCS codes. CTCSS attaches a subaudible tone to the carrier signal. DCS 
attaches a digital code. A receiver configured with a particular tone or code will 
not unmute unless that tone or code is presented with the RF signal.

If the SUs transmitting to or receiving from the base station are configured with 
inverted DCS codes, you need to program the base station with the equivalent 
normal DCS code. For details, see “Configuring the Base Station for Inverted 
DCS Codes” on page 114.

Note: If you select a transmit DCS code, the base station will always 
transmit a DCS end tone for muting the receive audio. However, 
transmitting a CTCSS reverse tone burst is optional and 
configurable.

Configuring the Base Station for Inverted DCS Codes
DCS codes can be expressed as a normal or an inverted code. For each inverted 
code, there is an equivalent normal code. For example 023 inverted is the same 
as normal 047 and vice versa. In the Edit Signaling Profile dialog box, the 
Receive and Transmit drop-down lists indicate for each normal code the 
equivalent inverted DCS code, by displaying it alongside in brackets. If the SUs 
are programmed with inverted DCS codes, configure the base station with the 
equivalent normal code. To ascertain that code, look up a table or follow this 
procedure. 

To program the base station with an inverse DCS code

1. Note the inverted DCS code that the SU is programmed to transmit with, 
for example 023.

2. In the Receive drop-down list, scroll down until you find that code in the 
list of normal codes. The inverse equivalent (in this example, 047) is in 
brackets beside it. Note this code.

3. In the Receive drop-down list, scroll down again until you find the code 
you noted (in this example, 047). Select it. When you program this 
configuration into the base station, the receiver will unmute to the SU’s 
inverse DCS code (in this example, 023, which is the same as the normal 
code 047). 
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Tail Timers tab
In the Edit Signaling Profile dialog box, use the Tail Timers tab to configure 
tail timers that the transmitter uses in analog FM mode.

Two tail timers give you flexibility in configuring tail timing. The total tail time 
is the sum of the hang time and the soft-off time.

Tail timers are used to:

eliminate squelch tail (the ‘tish’ sound caused when the CTCSS detector 
doesn’t immediately re-mute the user’s SU when carrier ceases) 

prevent users on different subtones from taking control of the repeater 
during a temporary lull in the conversation

Tail timers are not used in digital P25 mode.

Reverse tone burst
The base station can send a reverse tone burst at the end of each transmission. 
This applies only to analog FM transmissions with a CTCSS tone. The reverse 
tone burst consists of the same tone, but is 180 degrees out of phase with it. In 
suitable SUs, this quickly mutes the receiver. 

Note:  Transmissions with a DCS subtone have an equivalent: the 
DCS end tone. This consists of a 134 Hz tone that lasts 180 ms and 
is not configurable.

In the Edit Signaling Profile dialog box, Tx Timers tab, the Reverse tone 
burst check box enables the sending of reverse tone bursts. 

Duration The Duration box specifies the length of the tone burst. You can specify this in 
milliseconds or in cycles. If the burst has too many cycles, it comes back into 
phase with the original subtone and the SU may detect it again, re-opening the 
receiver gate. Specifying the duration in cycles for different CTCSS frequencies 
can help prevent this. 
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Hang time
The hang time is the length of time at the end of each analog FM transmission 
when the base station continues to transmit subaudible signaling after Tx keying 
has ceased. During the hang time, SUs in the talk group that uses the subaudible 
signaling can initiate a call but other SUs cannot.

In the Edit Signaling Profile dialog box, Tx Timers tab, the Hang time check 
box enables this timer and the Duration box specifies the length of the hang 
time. 

Soft-off time
The base station can also send only carrier (carrier without modulation of any 
kind) at the very end of each analog FM transmission. 

In the Edit Signaling Profile dialog box, Tx Timers tab, the Soft-off time 
check box enables the feature for analog FM transmissions and the Duration 
box specifies the length of time that only carrier is transmitted. 

Configuring the CWID
In the CWID form (Configure > RF Interface > CWID) you can configure 
the way the base station broadcasts its identity using Morse code and set up the 
automatic sending of the CWID. In the USA, the FCC requires that base 
stations broadcast their identity. 

Tip: Transmit using CWID before the radio system is 
commissioned; if there are any other users of the frequencies you 
have been assigned, this gives them advance warning. 

In the Morse area, you define what the base station broadcasts and in the 
Automatic CWID system area, you can enable and configure the regular 
sending of identity broadcasts. 

Morse
Use the Morse area (Configure > RF Interface > CWID) to specify a unique 
ID for the base station. The speed of transmission and the tone used can also be 
configured, but you should not need to alter the default settings. 

The settings in this area apply to the automatic CWID transmission and to any 
CWID transmissions triggered by Task Manager action. 
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Words per minute Specifies the speed of Morse code transmission. The 5-letter word PARIS is 
used to establish the number of words per minute. This word corresponds to 
50 dots. 

Tone frequency The frequency of the tone used to transmit the Morse code.

Message Enter into this box up to 30 characters to be transmitted as the station ID. You 
can enter any character or digit that the international Morse code alphabet 
supports (A-Z, 0-9, and punctuation marks). These characters will be 
transmitted using the International Morse Code convention. You can also enter 
spaces. They result in a silence equivalent in duration to seven dots. 

Automatic CWID system
In the Automatic CWID system area (Configure > RF Interface > CWID) you 
can enable and configure the automatic sending of the base station’s CWID 
according to the configuration in the Morse area. The licensing authority may 
require that the base station regularly identifies itself.

Important: Automatic CWID is likely to cause problems in a digital 
P25 system. Consider using Task Manager instead. You can use the 
Task Manager actions Transmit CWID now or Lock automatic CWID 

to set up identity broadcasts in ways that automatic CWID does not permit. For 
example, Task Manager could carry out this action only if there is no call in 
progress. 

If automatic CWID is enabled, calls that are in progress when a CWID is due 
for transmission will be interrupted. The CWID transmission is analog FM, 
irrespective of the base station’s configuration. If the CWID is transmitted 
during a dispatcher call, the dispatcher is given no indication that the call has 
been interrupted. A CWID that takes a long time could completely replace a 
dispatcher call.

Select the Automatic CWID system check box to enable the regular sending of 
the base station CWID. 

Transmit every Specifies the interval in minutes from the end of one CWID transmission to the 
start of the next. For example, if the interval is one minute and the transmission 
takes 20 seconds, the CWID will be transmitted every one minute 20 seconds.

Enabling RF Linking
If the connected base station is to be a dedicated linking transceiver, use the RF 
Linking form  to enable and configure RF linking. Otherwise, leave the 
Linking transceiver check box cleared. 

A linking transceiver forms one end of an RF link that joins a channel group to 
a remote base station or channel group. As an RF link cannot carry voting and 
switching information, each linking transceiver must be configured to give the 
streams it receives fixed information about the source and quality of the stream. 
The other members of the channel group use this information to make voting 
and switching decisions. For information about RF linking, see the TaitNet 
P25 System Manual. 
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Linking 
transceiver

Select the Linking transceiver check box and the TB9100 modifies its operation 
to suit the role of linking transceiver. The TB9100 then does the following.

It uses the channel group interface's voting and switching rules at the RF 
interface.

It flags calls received on the RF interface with a source derived from 
configuration instead of indicating the actual original source. The 
configuration can specify 'subscriber' or 'dispatch.'

It puts a configured value for impairment into received voice streams, 
instead of inserting a value based on signal quality. (Impairment values are 
only included in subscriber streams.) Otherwise, calls received over the RF 
link would almost always win the vote, irrespective of the signal quality of 
the originally received signal. 

It does not re-transmit any calls received on the RF link. This is to prevent 
a signal from being endlessly received and repeated. RF repeat only happens 
if the signal was received by another channel group member. For this to 
work, the linking transceiver must be configured with a receiver number 
unique to the channel group. 

Link stream 
source

The Link stream source box specifies whether the linking transceiver will flag 
the streams it provides to the channel group as coming from a dispatcher (line 
interface) or a subscriber (SU).  Select the appropriate option based on your 
system design. The channel group that the linking transceiver belongs to will 
use this information when voting and selecting voice streams. 

Link speech 
impairment

The Link speech impairment box specifies an impairment value. This is only 
used if the Link stream source box above specifies ‘subscriber’ (Impairment is 
only used in voting voice streams from a subscriber.) The channel group that 
the linking transceiver belongs to will use this information when voting. Select 
a value between 0 and 15. If the value is lower than that of other subscriber 
streams received by the channel group, the link stream will win the vote. If the 
value is higher, the link stream will lose.
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Channel Group

Using the CSS, you can define the identity of the network element and 
configure its behavior as part of a channel group. You can also enable and 
configure the network element’s DFSI interface to digital dispatch equipment, 
or its TCCP connection to a trunking controller.

Network
The Network form (Configure > Channel Group > Network) displays the 
network element’s network settings. These settings are normally only changed 
at installation time. You can also enable a DFSI connection, configure the voice 
service for the DFSI or for trunking, and configure the transmit jitter buffer.

Setting the Network Identity
Each Tait P25 network element has a unique name and IP address. The default 
settings provided by the factory must be changed when the network element is 
installed. 

Important: See the Installation and Operation manual for 
instructions on changing the network identity. If you give the 
network element an unknown IP address or subnet mask, the CSS 

will be unable to connect to it.

When you program a configuration into a network element, the CSS checks 
whether network identity (IP address, subnet mask, and receiver number) is the 
same as that of the network element. If there is a difference, you are given the 
choice of overwriting these items or keeping the existing ones, while updating 
the rest of the configuration. If you do change the network identity, the 
changes only take effect when the network element is reset.

Hostname The name of the network element. This is the human-readable equivalent of 
the network element’s IP address and appears on the status bar when you are 
connected. The default name is TB9100 but you should make sure that each 
base station and P25 Console Gateway on the network has a unique name. It is 
a good idea for this name to be the same as the name in the connection list 
(Tools > Connections). A blank name is not permitted.

This name is a hostname and has all the restrictions that apply to hostnames (for 
example, you cannot use spaces). 

IP address The unicast IP address of the network element in dotted quad format. The 
default address when the network element leaves the factory is 192.168.1.2. 
This address is used for example in communications with the CSS. 

There should be a line in the CSS connections list (Tools > Connections) that 
contains the name of the network element and its IP address, so that this CSS 
knows what IP address to connect to. The names programmed into the 
network elements should be the same as the names in the connection lists. 
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Subnet Mask The subnet mask for the router that the network element is connected to. Enter 
the mask required by the IP addressing plan for the network.

Note: You may also need to specify a gateway address. At present, 
Tait P25 network elements use Proxy ARP (RFC 1027) to find out 
which host on the LAN will forward packets destined for the 

network. The routers recommended by Tait support this protocol. Some 
networks may use different routers, or not use a local router at all. In these 
circumstances, it is necessary to set a gateway address in the network element. 
Tait intends to make the gateway address configurable in the CSS in a future 
release. Currently, however, the gateway address is set as one of the 
environmental variables of the network board’s Linux operating system. See 
TN-977b for instructions or contact Tait for advice and assistance. 

Receiver number The receiver number uniquely identifies the network element as a member of 
the channel group. You need to assign unique receiver numbers to all channel 
group members (including P25 Console Gateways). Assign lower numbers to 
members that are closer to the center of the network. If there is a central voter, 
give it the lowest receiver number (for example, 1). Receiver numbers must be 
in the range 1–255. 0 is a special case. The DFSI uses the receiver number 0 to 
address commands to all receivers.

Voice streams contain the receiver number of the member originating the 
stream. Voting and switching use the receiver number when selecting a vote 
winner. (If other things are equal, the voice stream from the channel group 
member with the lower receiver number wins.) CSS monitoring forms need 
receiver numbers before they can indicate where the transmitting source came 
from or who is winning the vote. The DFSI uses receiver numbers to address 
commands to individual members of a channel group. 

Enabling a DFSI Connection
The channel group member that acts as a gateway between the channel group 
and the digital dispatch console must have a DFSI connection.

To enable and configure a DFSI connection

1. Select Configure > Channel Group > Network.

2. Select the DFSI - Local connection check box.

3. In the Control service port number box, specify the port number that 
the gateway member will listen to control service messages on. This can 
usually be left at the default of 7000.

4. Configure the voice service (see “Configuring the Voice Service” on 
page 121).



 

TB9100 Customer Service Software User’s Manual   Channel Group 121

Configuring the Voice Service
The channel group master can provide a voice service between the channel 
group and a digital dispatch console or a trunking controller. 

The following items let you configure that service.

Use DFSI control 
service IP address

Select this check box if you want the channel group master to send voice 
streams to the IP address of the digital dispatch console. Otherwise clear the 
check box and enter the destination IP address into the box below.

IP address Specifies the IP address that the master sends voice streams to. This can be a 
multicast address. The master uses the port specified for the voice service in the 
digital dispatch console’s connect message.

Loopback speech Select this check box if the dispatch equipment using the DFSI needs to receive 
the voice streams that it sends. For example, dispatch equipment could use the 
loopbacked voice streams to make one dispatcher’s voice available to other 
dispatch positions. 
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Configuring the Jitter Buffer
The TB9100 has jitter buffers to accommodate the variation in the delay of 
speech, but only the RF jitter buffer is configurable. The size of the jitter buffer 
is defined by two timers (preamble and transmit holdoff). While these timers 
run, the buffer fills. These timers are important for the operation of SU scanning 
and voting. They have no effect on P25 Console Gateways. For recommended 
settings for different system designs, see the TaitNet P25 System Manual.  

Preamble Specifies the length of time that the base station transmits a preamble before 
beginning to transmit the call itself. In digital P25 mode, the preamble consists 
of a high deviation test pattern. In analog FM mode, the preamble is carrier 
only. While the preamble is transmitted, arriving voice packets are stored in the 
jitter buffer. The longer the preamble, the larger the jitter buffer and the greater 
the voice delay. A preamble cannot be shorter than than 40 ms, even if you 
enter a smaller value. For signaling messages (TSBKs), the base station applies a 
minimum preamble of 100 ms. 

Generally speaking, the aim is to keep the preamble as short as possible (to 
minimize the voice delay) but as large as required by the system design.

The maximum available preamble duration is 300 ms. If the base station has an 
antenna relay, the effective maximum is 260 ms; entering a preamble larger than 
260 ms will not lengthen the preamble.

Transmit 
holdoff

Specifies the length of time that the base station may wait before beginning to 
transmit the preamble. The purpose of this timer is to allow all the transmitters 
in the channel group to begin transmitting at about the same time. This is 
important if the receiving SUs are scanning or voting. (SU scanning works best 
if the base stations can all begin transmitting within approximately +/-10 ms of 
each other.) 

In channel groups with distributed voting, the transmit holdoff is only applied 
if the call originated locally (at the RF, line, or microphone interface). If voting 
is centralized, the transmit holdoff is always applied.

For single repeaters, leave the transmit holdoff at the default of 0ms.

The combined duration of the transmit holdoff and the preamble should not 
exceed 200ms, to limit the speech delay.
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Working with Channel Groups
The Channel Groups form (Configure > Channel Group > Channel Groups) 
displays information about the channel groups that the network element can be 
part of. You can add channel groups and edit them. 

For details about the other columns in the table, see “Editing a Channel Group” 
on page 124.

At any particular time, the network element is a member of the channel group 
specified by the current channel in the channel table. 

Adding a Channel Group
1. Select Configure > Channel Group > Channel Groups.

2. Click Add.

3. Click Edit. The Channel Groups dialog box appears. 

4. If desired, edit the name of the group.

5. Under Speech transport, specify which call types the digital line can send.

6. Under Voting, select the type of voting. Voting can be distributed among 
all channel group members, centralized at one member, or there can be 
switching only. See the TaitNet P25 System Manual for an explanation of 
these options.

7.  Under Voting, specify the voting mode (simplex or duplex). See the 
TaitNet P25 System Manual for an explanation of these options.

8. Under Voice stream, enter into the IP address box the multicast IP 
address for the channel group. Generally, you can use the default port 
number. 

9. Under Channel control, specify whether dispatcher commands only affect 
the channel group member that the dispatch equipment is connected to 
(Individual), or whether they affect the whole channel group (Collective). 

10.Click OK.



 

124 Part E: Configuring    © Tait Electronics Limited March 2007

Editing a Channel Group
In the Channel Groups form (Configure > Channel Group > Channel 
Groups), select a channel group, and then click Edit to modify it. 

Important: When editing a channel group, make sure that all 
channel group members have compatible channel group settings. 
Check these settings in the Group Status form (Monitor > Channel 
Group > Status). 

Name The name of the channel group. Each channel group must have a unique name.

Speech transport
In the Speech transport area you can specify which types of call can be passed 
to the channel group along the network element’s digital line. Normally, both 
types are enabled, but analog FM can be disabled if the bandwidth of the linking 
infrastructure is insufficient to support it. Either may be disabled to assist with 
troubleshooting. The settings in this area have no effect on data calls. 

Digital P25 enable Enables the network element to send digital P25 voice to the channel group. 
The digital P25 voice stream is in the form of IMBE packets, which are 
compressed and low bandwidth. 

Analog FM enable Enables the network element to send analog FM voice to the channel group. 
The analog FM voice stream is in the form of G.711 packets, which are 
uncompressed and require a bandwidth of 64 kbit/s. 
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Voting
The Voting area configures the way the network element handles voting. See 
the TaitNet P25 System Manual for a more detailed explanation of voting and 
its options.

Type Voting can be distributed among all channel group members, centralized at one 
member, or there can be switching only. 

Mode The channel group can operate in duplex or in simplex mode. All channel 
group members should have the same mode setting.

Voice stream
Use the Voice stream area to set the IP address and port for sending voice 
streams to and receiving them from the channel group. 

IP address Specifies the IP address (normally multicast) that the channel group member 
belongs to. The member sends its voice stream to this IP address and (if the 
address is multicast) accepts any voice stream that is addressed to this IP address. 
If the channel group has only two members, the unicast IP address of the other 
member can be used. 

Port number The port number that the network elements in the channel group use for the 
voice stream. Generally, the default port number is used. 

Type Description

Switched Select Switched if the receivers in the channel group do not operate on the same 
frequency. Simultaneous calls cannot be from the same SU and should not be 
voted on. If there is more than one voice stream, the switch makes the streams 
available and interfaces play out the stream with the highest priority. 

Distributed Select Distributed if you want distributed voting in the channel group. In 
distributed voting, each channel group member votes using the same algorithm 
and with the same results. Also select this option if the channel group is to have 
central voting but this member is not to be a central voter.

Central Select Central if you want this channel group member to be the central voter. 
Other members will not vote their RF streams or switch any streams, but will send 
them to the central voter. The central voter sends a voted RF stream back to all 
members of the channel group for repeating. The member will only take over as 
central voter after ensuring that all other channel group members are in 
agreement. 

Mode Description

Duplex The channel group can simultaneously handle an inbound (SU to dispatcher) and 
an outbound (dispatcher to SU) call.

Simplex The channel group handles only one call at a time. It selects the call with the 
highest priority. Dispatcher calls always win over subscriber calls. 
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Channel control
The Channel control area determines whether channel control commands are 
applied to the individual network element or to the whole channel group. 
These settings apply to dispatcher commands received over the analog line or 
the DFSI interface. Generally, the same setting is used for all channel 
commands.

Channel number If Collective is selected, a channel change command is propagated to the 
channel group. If Individual is selected, a channel change command only affects 
the network element with the interface to the dispatch equipment. 

RF repeat If Collective is selected, a command to enable or disable RF repeat is 
propagated to the channel group. The channel table must specify that RF repeat 
is DispatchControlled. If Individual is selected, the command only affects the 
network element with the interface to the dispatch equipment. 

Monitor squelch If Collective is selected, a Monitor command is propagated to the channel 
group. If Individual is selected, the command only affects the network element 
with the interface to the dispatch equipment. (The Monitor command is not 
currently supported.)

Trunking
Use the Trunking form (Configure > Channel Group > Trunking) to enable 
and configure the channel group master’s TCCP interface to the site controller. 
This is required for control channels and for traffic channels.

Allow TCCP 
connection

Select this check box to allow the trunking site controller to establish a TCCP 
connection to the base station. 

Listen port Tells the base station which UDP port to listen to on the TCCP interface.
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Heartbeat interval Specifies the interval between heartbeat messages that the base station sends 
over TCCP to the site controller.

TSBK assembly Specifies how many TSBKs can be sent in one outbound signaling packet.

Packet data
Durations for the following packet data timers are configurable.

Message time If the message time elapses and the confirmed data message is still undelivered, 
the master discards the message. 

Retry time The retry time is used in the following ways.

For confirmed data, the master waits until the retry time elapses. If a 
confirmation has not been received, it sends the message again. This is repeated 
until the message time has elapsed.

For unconfirmed data, the master waits until the retry time has elapsed before 
sending the next message.

Option Description

Single Outbound signaling packets contain a single TSBK. This is the 
default setting and will be suitable for most systems. It is the 
best setting where coverage is marginal.

Double Outbound signaling packets can contain up to two TSBKs. 

Triple Outbound signaling packets can contain up to three TSBKs. 
This may bring performance improvements in busy sites with 
lots of call requests and registrations. More TSBKs can be 
transmitted per framesync and NID. However, SUs will take 
longer to find the control channel and noise will have a greater 
impact on channel efficiency.
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Analog Line

TB100 base stations and P25 Console Gateways have an analog line. The 
behavior of the analog line is determined by the current calling profile. The 
calling profile assigned to the current channel is the default calling profile. A 
dispatcher command can select a different calling profile.

Line levels for the audio and for MDC1200 output must be set. The types of 
signaling used by the console system must be enabled and configured.

General Analog Line Settings
In the General form (Configure > Analog Line > General), you can set levels 
for the analog line. You can also enable MDC1200 signaling, set its level, select 
configuration options and monitor the signaling received. 

Setting Line Levels
Line levels are set in the General form (Configure > Analog Line > General) 
To help you, the form displays the current line levels at the analog line interface. 
These are measured in the digital domain and adjusted to represent the actual 
values at the interface pins.

Levels need to be set correctly so that the line output level does not exceed 
acceptable limits and so that the signal arriving at the network element switch 
is neither so strong that it risks exceeding the maximum value nor so weak that 
signal quality is affected. The levels that you enter are the absolute levels in dBm 
that a -10 dBm0 test tone would have at the line interface. 

The levels you set should implement the network level plan. In the following 
level plan for a very simple network, a dispatch console is directly connected to 
a base station along lines with a 3 dB loss. The plan specifies 0 dBr for each 
output. This is achieved by setting line levels in both the dispatch console and 
the base station at -10 dBm for the output and -13 dBm for the input. 

 

Base station Dispatch
console

-10 dBm

-13 dBm

0 dBr-3 dBr

0 dBr -3 dBr

-13 dBm

-10 dBm

3 dB
loss
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Output The Output box specifies a nominal line level for the analog line output. When 
a base station is receiving an analog FM signal at 60% maximum deviation, it 
applies a gain so that it outputs audio at this level. Enter a value based on the 
level plan for the network. For example, if the level plan specifies -0 dBr at the 
analog line output, enter -10 dBm. This results in an average power level at the 
transmission reference point of -10 dBm, allowing 10 dB for speech peaks. You 
can verify the accuracy of the setting by using RF test equipment to supply a 
signal at 60% deviation, and reading the output in the RMS level box. 

Note: The output level is currently limited to a maximum of -10 
dBm. This is to ensure compliance with telecommunication 
company requirements.

Input The Input box specifies the line level that the network element expects on the 
analog line input. When the base station receives audio at this level, it applies a 
gain so that it transmits at 60% maximum deviation, when in analog FM mode. 
Enter a value based on the level plan for the network. For example, if the level 
plan specifies -3 dBr at the analog line input, enter -13 dBm. Audio sent from 
the transmission reference point at -10 dBm will arrive at the analog line 
interface at -13 dBm. You can verify the accuracy of the setting by looping back 
the analog line and using the base station’s own ability to send a 1 kHz test tone, 
measuring the maximum deviation using RF test equipment.

Using Deviation Measurements to Set the Input Line Level
Traditionally, technicians use transmitter deviation measurements to set line 
levels. While line levels in a TB9100 can be correctly set without measuring the 
deviation, some may still wish to use this method.

To set the input line level

1. Apply a 1 kHz tone at the required reference level at the line input.

2. Set the base station to analog FM mode. (In digital P25 mode, the C4FM 
modem uses fixed deviation patterns that represent specific symbols. The 
deviation cannot be used for setting the line level.)

3. Adjust the input level (Configure > Analog Line > General) until the 
deviation is 60% of peak.

Note: After the line level is set, you can also check for a transmitted 
tone in P25 mode. However, you must first change the tone 
frequency to 500 Hz; the IMBE vocoder does not reproduce 

fundamental tones above about 500 Hz. 

Channel seize and analog valid
Use the General form (Configure > Analog Line > General) to specify which 
signaling methods can be used by the analog line. 
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E & M This check box enables E & M signaling. When the E line goes low, the 
network element interprets this as a channel seize. When the network element 
puts a valid signal on the analog line, it asserts its M line.

Tone remote This check box enables the use of tone remote signaling for channel seize. 
When the network element receives LLGT (keytone), it interprets this as a 
channel seize. The LLGT must have the properties specified by Configure > 
Analog Line > Tone Remote Options.

After MDC1200 This check box only applies when tone remote signaling is enabled. Select this 
check box and the network element waits when it receives LLGT for enough 
time to receive one or more MDC1200 tone bursts before seizing the channel.

Setting MDC1200 Options
Use the General form (Configure > Analog Line > General) to set 
configuration options for MDC1200 signaling.

MDC1200 The MDC1200 check box enables MDC1200 signaling across the analog line, 
provided the network element has an MDC1200 signaling on analog line 
license.

Important: MDC 1200 signaling must be sent to the network 
element before digital P25 voice transmission can begin. This is an 
inherent characteristic of the MDC 1200 and digital P25 standards 

and necessarily increases the end-to-end delay, or causes the start of the call to 
be lost, or to interfere with the MDC 1200 signaling. Which of these outcomes 
occurs will depend on the dispatch equipment. Sending guard tone, a single 
function tone, and the PTT ID takes at least 280 ms.

Make sure that you include the MDC 1200 signaling time when calculating the 
end-to-end delay of the system. You may be able to configure the dispatch 
equipment to achieve a balance of initial voice loss and end-to-end delay. 

MDC1200 output 
level

Defines the level of MDC1200 signaling in dBm0. This applies only to 
MDC1200 signaling that the network element has generated from P25 
signaling. -10 dBm0 corresponds to the level that MDC1200 is normally sent 
over the air (60% deviation). 
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ANI Specifies for incoming digital P25 calls when the MDC1200 ANI message is 
added to the voice stream sent on the analog line. The setting you choose must 
match the setting of the console system. 

Monitor Enable the Monitor check box to monitor any MDC1200 commands coming 
from the console system. The MDC1200 code for this command appears in 
hexadecimal in the Events box and the MDC1200 value of any destination 
addresses appears in the Address box. 

Enabling Encryption Warnings
The General form (Configure > Analog Line > General) specifies whether 
warnings about encryption are sent on the analog line.

Warn on clear 
speech

When this check box is selected, a single beep (1500 Hz) is sent on the analog 
line at the end of the over whenever a clear digital P25 transmission is passed to 
the analog line. Clear the check box if the system doesn’t use encryption.

Warn on key 
mismatch

When this check box is selected, three beeps (500 Hz) are sent on the analog 
line at the end of the over if there is a mismatch between the received call and 
the current calling profile. A mismatch occurs if the call uses a key other than 
the one selected in the current calling profile, if the selected key is missing, or 
if the current calling profile specifies clear communications but the call uses a 
key. If any key matches the key used by the call, that call is decrypted. The 
dispatcher may need to change to a calling profile that uses the key used by the 
caller, so that the caller can decrypt the reply. 

Working with Calling Profiles
The Calling Profiles form (Configure > Analog Line > Calling Profiles) displays 
the list of calling profiles. You can add a new profile and edit an existing profile. 
A calling profile defines the properties of calls that the dispatcher makes and 
receives. Think of the analog line as equivalent to a SU; the calling profile 
defines the identity and behavior of that SU. Included in the calling profile is a 
service profile, which specifies what services the analog line supports, and a 
group membership, which specifies the groups it belongs to and therefore can 
listen in to. 

Option Description

Leading The ANI message is supplied to the console at the beginning of 
the over. As this information is not available until after the P25 
voice stream has begun, the network element must wait for it 
before forwarding voice on the analog line. 

Trailing The ANI message is supplied to the console at the end of the 
over. Delay is minimized, but the identity of the caller is not 
available until the end of the over.
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By default, the analog line uses the calling profile specified by the current 
channel. Dispatcher commands can select a different calling profile. If the 
console system uses MDC1200 signaling, aspects of the calling profile can be 
overridden.

The form displays a row of information for each profile. 

To create a new profile, click Add, and then click in each column as needed to 
edit it. To delete a profile, select it and click Delete.

Name The name of the profile. 

Enable The Enable column contains a check box. When this check box contains a tick, 
the profile is enabled. When the check box is cleared, the profile is disabled. 
This has the effect of disabling the analog line interface, if the current channel 
or a dispatcher command has selected this calling profile. 

If the analog line is not used, it may be desirable to disable the current calling 
profile to prevent unauthorized access to the channel group. You may want to 
disable the analog line temporarily. You can also set up a disabled calling profile 
and assign it to a channel in order to be able to disable the analog line interface 
through channel selection. 

Squelch Specifies what the analog line unmutes to. If the squelch is Normal, the 
network element switches any winning voice stream onto the analog line. If the 
squelch is Selective, the network element only switches a voice stream onto the 
analog line if it is addressed to the current calling profile’s line ID or to a group 
listed in the current calling profile’s group membership. The Squelch setting has 
no effect on analog FM calls. 

Call Type Specifies the type of call for dispatcher-initiated calls. The network element 
turns the audio on the analog line into the specified type (P25 group, P25 
individual, or analog FM). The analog line can always pass calls of any type to 
the console. If you select analog FM, inapplicable columns are not editable.

If the console uses MDC1200 signaling, this setting can be overridden as 
follows. If the Call type column specifies analog FM, the channel group makes 
an analog FM call. If the Call type column specifies P25 group or P25 
individual, the channel group makes a P25 call of the type specified by the 
MDC1200 signaling. The line ID and destination addresses specified by the 
calling profile are overridden. 
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Group 
Membership

Selects one of the available sets of group IDs and assigns them to the console. 
Calls to these groups will be routed over the analog line to the console. 

Line ID Defines the individual ID of the analog line (digital P25 calls only). The 
network element will pass incoming individual calls with this destination ID to 
the analog line. The Line ID is also used as the source ID of all outgoing calls. 

Note: The analog line has additional IDs that are derived from the 
groups in the current group membership. This is done to support 
the way Status Messages are implemented. Some SUs send Status 

Messages to an individual ID that is derived from the talk group assigned to the 
SU’s current channel. To derive this ID, the SU adds 0xFEF000 to the talk 
group. For example, talk group FFFF becomes individual ID 0xFFEFFF. Talk 
group 0x000A becomes individual ID 0xFEF00A. These additional line IDs 
mean that Status Messages from these SUs are passed to the analog line. If the 
analog line uses MDC1200, it converts the configured Line ID (not the 
received ID) to MDC1200 and passes it on to the console system.

Destination Defines the unit or group ID that the call will be sent to (digital P25 calls only). 

If the selected call type is P25 group, enter a 5-digit group ID. 65535 (FFFF in 
hexadecimal) is a special group ID that sends the call to all SUs on the system. 
This is also known as an unaddressed voice call. If you enter a group ID, make 
sure that the group membership profile assigned to the channel and to the 
analog line includes that group, otherwise the network element will not 
respond to communications from other group members.

If the call type is P25 individual, enter a 7-digit individual ID. 

This setting is overridden when the dispatch console uses MDC1200 signaling.

Service Profile Selects one of the available service profiles that specifies which services are 
available to the dispatch console (digital P25 calls only). The services the 
dispatch console is able to receive are determined by the service profile assigned 
to the current channel of the base station receiving the transmission.   

Encryption Specifies the analog line's encryption behavior. If ‘Clear’ is selected, the analog 
line does not encrypt calls and does not expect to have to decrypt them. Click 
in the column to display a drop-down list of keys. The key list comes from the 
Encryption form (Configure > Analog Line > Encryption). If a key is selected, 
the analog line encrypts outbound digital P25 calls using the secure key data for 
that key. It always decrypts inbound P25 calls if it has the key, but may sound 
a warning if a call does not use the expected key.

The encryption setting has no effect on analog FM calls.

Emergency Specifies whether calls that the dispatcher makes are emergency calls (digital 
P25 calls only). This setting is overridden when the console uses MDC1200 
signaling.

Encryption
In the Encryption form (Configure > Analog Line > Encryption) you can set 
up encryption keys. The Unused keys area displays the CKR numbers of key 
data that has been loaded into the P25 Console Gateway but not associated with 
a key name. Use the Keys area to define keys, by giving them a name and a 
CKR. These keys are then available for assigning to calling profiles. You can 
also delete named keys from the keys list and zeroize all keys.
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Keys
The Keys area contains a table consisting of up to 16 rows, each containing a 
named key and a CKR number. Click on a column header to sort the table by 
that column. An arrow to the left of the table indicates which row is currently 
selected.

Name The name of the key. When you add a row to the Keys table, the CSS gives it 
a default name. You can leave this name as is or edit it to make it more 
meaningful, for example ‘Common key 1’ or ‘Police February.’ The name 
appears in a drop-down list in the Calling profiles form. Calling profiles refer to 
keys by name only.

CKR The CKR to be associated with the key. Enter the CKR of secure key data that 
has been or will be loaded into the P25 Console Gateway. If the CSS is 
connected to a P25 Console Gateway, the Unused keys area displays a list of 
CKRs that have not yet been assigned a name in the Keys table. 

Key present? If the CSS is connected to the P25 Console Gateway, this column indicates 
whether secure key data (the key ID, algorithm ID and key variable) is present 
for the CKR. For encryption to work, the secure key data must be present. If 
the column displays No, check that you entered the correct CKR number 
when naming the key.

Add Adds a new row to the Keys table.

Delete Deletes the selected row from the Keys table. This has no effect on the 
underlying secure key data.

Unused keys
The Unused keys area displays the CKR numbers of keys that have been loaded 
but not yet named.
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Zeroize
Click Zeroize all keys to remove all the secure key data that has been loaded 
by a key fill device. Zeroize all keys before loading new key data, to make sure 
that all obsolete key data is removed. Zeroize all key data when sending a 
gateway module for repair, to maintain security. 

 Defining Group Memberships
The Group Membership Table form (Configure > Analog Line > Group 
Memberships) lists sets of groups. You can add new group memberships or edit 
existing ones. 

The network element only switches digital P25 calls to the analog line if they 
are to groups that are in the current group membership. The current calling 
profile selects the current group membership. The group membership has no 
effect on the RF interface. 

You can enter up to ten sets of groups, each containing up to seven P25 group 
IDs. 

To add a set of groups

1. Click Add. A new row appears in the table. 

2. In the Name column, enter a suitable name or description for the set of 
addresses.

3. Enter a P25 group ID into the Group 1 column. These are 4-digit 
hexadecimal numbers. 

Note: If you enter nothing (leave the columns empty), one group is 
still specified: 65535 (0xFFFF). The network element will always 
pass calls to the group address 65535 on to the analog line. 

4. Repeat for subsequent group columns until you have entered all the groups 
that the dispatcher needs to listen to. The special group ID 

5. Click OK to confirm the changes and close the form. 
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Mapping Tone Remote Commands
The Tone Remote Mapping form indicates what actions function tones trigger. 
You can map tone remote function tones to calling profiles. By default, all 
function tones can trigger Task Manager actions. If you map a tone remote 
function tone to a calling profile, when the console sends the function tone, the 
analog line switches to that calling profile. If you want the function tone to do 
something other than select a calling profile, create an appropriate Task 
Manager statement with Tone remote detected (nnn) as the input. 

To map a function tone to a calling profile

1. Select Configure > Analog Line > Tone Remote Mapping. 

2. Select Single tone or Dual tone, based on the kind of function tones that 
the console system will produce. This configures the analog line for the 
detection of single-tone or dual-tone function tones. If you select Single 
tone, one tone column is displayed. If you select Dual tone, there are two 
columns.

3. If necessary, clear the Hide Task Manager actions check box.

4. In the row displaying the function tone frequency (or combination of 
frequencies, for dual function tones), click in the Action column. An arrow 
button appears.

5. Click the arrow to drop down a list of the available calling profiles together 
with the item ‘Task Manager.’

6. In the list, click the calling profile you want. 

Setting Tone Remote Options
Console systems can use a variety of frequencies and levels for the tone remote 
control of the P25 Console Gateway or base station. In the Tone Remote 
Options form (Configure > Analog Line > Tone Remote Options), you 
specify the parameter values that the connected equipment uses. A graph of 
tone remote signaling shows you visually the meaning of the parameters. Some 
values can be ascertained from the console system documentation, others may 
depend on the console system configuration. The console system and the 
network element must have compatible settings. 
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The Tone Remote Options form also has some monitoring items. You can use 
them to confirm that tone remote detection is working properly. 

Signaling duration The maximum time that the analog line will listen for HLGT and function 
tones. This time begins when the analog line detects HLGT. Any function 
tones received after this time has elapsed are not detected. 

Guard tone 
frequency

The frequency that the console system uses for the guard tone. HLGT and 
LLGT use the same frequency. If the console system is going to use MDC1200 
with analog FM SUs, this frequency should be well above 2100 Hz, so that the 
notch filter does not remove significant amounts of energy from the MDC1200 
signaling.

HLGT level HLGT must exceed this minimum level for the network element to detect the 
tone.

Function tone 
level

Single tone or dual tone function tones must exceed this minimum level for the 
network element to detect them.

LLGT level LLGT must exceed this minimum level and be less than the minimum HLGT 
level for the network element to detect the tone. 

Guard tone notch 
filter

When this check box is enabled, the network element removes the LLGT from 
the audio before sending it to the voter. Normally, the notch filter is enabled.



 

138 Part E: Configuring    © Tait Electronics Limited March 2007

Monitoring Controls
Once the tone remote options are set up, you can confirm that the analog line 
is correctly detecting and decoding them. Send some tone remote signaling 
from the console system and check the display of the following monitored 
items. 

Guard tone detect Displays green when the analog line recognizes HLGT or LLGT.

Input overload Displays red if the level exceeds the limit that the analog line can handle. If 
overloads occur, the analog line cannot correctly detect tones.

Recent function 
tones

Displays the frequencies of the last four function tones detected by the analog 
line interface. If the analog line detects a function tone, its characteristics lie 
within the limits of the parameters defined in this Tone Remote Options form. 

Function tone 
count

Displays the number of function tones that have been detected. When you send 
a number of function tones from the console system, check that the count 
increments by that number.

Mapping MDC1200 Addresses
The MDC1200 Address Table (Configure > Analog Line > MDC1200 
Address Table) tells the analog line how to convert individual and group 
numbers from P25 to MDC1200 and vice versa. For example, when the 
dispatch console calls a group, the analog line converts the destination 
MDC1200 address to its P25 equivalent, which the channel group uses over the 
air. Similarly, when a SU calls the dispatcher, the analog line converts the SU’s 
P25 address to the equivalent MDC1200 address, which the dispatch console 
displays as the caller ID.

The default mappings will suffice in most circumstances. If necessary, the 
existing rows in the table can be modified or further rows can be added. All 
mappings involve a number conversion, so that the MDC1200 numbers 
displayed on the dispatch console can be highly similar to the equivalent P25 
numbers.

In the default mappings, the first table row maps P25 individual addresses 
between 1 and 999 to MDC1200 addresses 0001–0999. The second row maps 
P25 talkgroup addresses between 1 and 99 to 9001–9099. 

Adding an Address Mapping
If there is a need to map additional addresses to the ones already mapped, follow 
these steps.

1. Select Configure >Analog Line > MDC1200 Address Table.

2. Click Add. A new row appears in the table. 
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3. In the Comment column, enter a name or remark to identify the block of 
addresses.

4. In the Group column, select Yes to map P25 group addresses or No to map 
P25 individual addresses. 

5. Under P25, enter into the Start column the lowest P25 address in the 
block. Enter into the End column the highest address in the block. 

We recommend using group and individual addresses between 1 and 9999. 
However, valid group addresses are 1-65535 (0xFFFF) and individual 
addresses 1-16777215 (0xFFFFFF). Generally, you can’t include addresses 
that have already been mapped, but you can re-use addresses from a block 
of group addresses in a block of individual addresses and vice versa. This is 
because a P25 group address is not identical to a P25 individual address with 
the same number; they have different byte sizes.

The size of the block is calculated and appears in the Size column. 

6. Under MDC1200, enter into the Start column the beginning of the 
equivalent MDC1200 block of addresses. MDC1200 addresses must 
normally be in the range 1-9999. You can’t include addresses that have 
already been mapped. The end of the MDC1200 address range is 
automatically calculated and appears in the End column. 

Note: Some analog console systems will not allow Radio Enable/
Radio Disable, Radio Check, Radio Monitor or Status Report 
(Status Request) if the hexadecimal MDC1200 radio address has an 

E or F in it. For assistance with mapping addresses with this or other similar 
special requirements, contact Tait. 

7. Click OK to confirm the changes and close the form. 

Tip: To shift a range, edit the address in the P25 or MDC 1200 Start 
column. To change the size of a range, edit the P25 size or the P25 
address in the End column.

SU Numbering Example
The following example shows how a county Sheriff’s department could 
number its SUs. 

Officer handportables, in-vehicle mobiles, and talkgroups each have their own 
number range. This example uses the default mapping and results in MDC1200 
numbers that are highly similar to the P25 numbers. 

P25 Start 
Address

P25 End 
Address

MDC1200 
Start Address

MDC1200 
End Address

Officer handportables 1 99 0001 0099

In-vehicle mobiles 201 299 0201 0299

Talkgroups 1 20 9001 9020
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Part F Alarms

The CSS can monitor the current status of a network element’s 
alarms. Many alarms have thresholds that you can alter to suit 
the application. Unwanted alarms can be disabled.

You can run multiple instances of the CSS software (supported 
in version 3.00.xx and above) and use them for example to 
simultaneously monitor alarms at several network elements.

To view a list of recent alarms, display the system log 
(Monitor > Data Logging > System Log). 

Topics

Monitoring Alarms

Disabling Unwanted Alarms

Altering Network Element Alarm Thresholds

Altering Network Alarm Thresholds

Logging to a Syslog Collector

Configuring the SNMP Agent
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Monitoring Alarms

The Status form (Monitor > Alarms > Status) shows the current status of alarms 
in the base station or P25 Console Gateway. The CSS must be connected to 
one of these network elements before it can display any alarms.

LED-like icons indicate the status: 

Red (flashing) means that the alarm is active.

Green means that the monitored condition is OK and that there is no alarm.

Gray means that the alarm has been disabled or that the monitored condition 
is not available; for example, Final 2 alarms are gray if there is no Final 2 stage.

Alarms are triggered when a monitored condition crosses a defined threshold. 
Some thresholds are fixed and built into the module firmware. Others are 
configurable in Configure > Alarms > Element Thresholds and Network 
Thresholds. Some parameters such as high voltage and high reverse power have 
two thresholds. When the configurable threshold is crossed, the network 
element generates an alarm. When the built-in threshold is crossed, the network 
element responds by protecting itself against damage. 

Tip: Use Task Manager to configure an automatic response to 
alarms. In general, each alarm has an equivalent Task Manager 
input. When the alarm occurs, Task Manager executes any tasks 

with that alarm as an input.
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Power Amplifier
The Power Amplifier area shows the alarm status of the PA associated with the 
reciter that the CSS is connected to. When a fault is no longer active, any 
actions (for example, inhibiting transmission) are reversed.

No PA detected The reciter cannot obtain a response from a PA over the control bus. The PA 
may still be operating but the system has lost the ability to monitor PA alarms, 
carry out diagnostics, change configuration, or detect PA fan failure.   

1. The reciter has no associated PA. You should disable this alarm.

2. The network element uses a third-party PA which does not use the control 
bus and cannot respond to the reciter.

3. The control cable or exciter cable is not connected.

4. The PA is faulty and unable to communicate with the exciter. 

Invalid PA 
firmware

The firmware in the PA is invalid.

1. Use the CSS to download the PA firmware.

2. Return the PA to Tait.

Calibration invalid This alarm can only be triggered on startup, when the PA carries out self-tests. 
It indicates that settings stored in firmware have values outside acceptable limits. 
In response, the base station disables the transmitter. Re-calibrate the PA using 
the Calibration Software or send it to a service center for repair. 

Fan failed The PA told the reciter that its fan is on, but the reciter cannot detect fan 
motion. The base station takes no action when this alarm occurs, but it will act 
if the PA temperature becomes too high.

The fan has failed. Replace it.

Forward power 
low

The PA forward power output is below the configured minimum limit. If the 
VSWR is also raised, check for a load mismatch. Otherwise, there may be a 
fault in the output driver(s). 
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H/w configuration 
invalid

The PA has an invalid hardware configuration. Either the driver is not present 
or the configuration says that there is a Final 2 output stage but no Final 1, 
which is impossible.

Power foldback The PA has detected a fault condition and has reduced its power output to a 
minimal level to prevent damage. 

Check the other alarms to see what fault condition or conditions have caused 
this. If the fault condition clears, the PA automatically returns to its previous 
power output level and the alarm changes to green.

Reverse power 
high

The PA’s reverse power is above the configured maximum. Check for a load 
mismatch. With a resolution of only 1 W, this alarm is not sensitive if the power 
output is lower than 20 W. Check the VSWR fault alarm instead.

Shutdown The PA has detected a fault condition and has disabled the transmitter to 
prevent damage. Check the other alarms to see what fault condition or 
conditions have caused this. 

VSWR high The VSWR is above the configured threshold. A normal VSWR is ≤ 2:1. 
A high VSWR automatically means reduced output power. If the VSWR 
increases to 10:1 or more, the PA folds back its power output to a minimal level. 
If the VSWR returns to 5:1 or less, the PA recovers.

Check for a load mismatch on the PA’s RF output. 

Current The Current group of alarms detects excessive or inappropriate current draw. 
If an alarm shows red, the PA needs servicing.

Supply voltage The PA can detect whether its power supply voltage is too high or too low.

Supply voltage 
low

The PA supply voltage is 26 V or less, probably because the battery is running 
low. The fault condition disappears when the voltage exceeds 26.1 V.

Supply voltage 
high

The PA supply voltage is 29 V or more.

1. The third-party power supply is incorrectly configured. 

2. A voltage regulator has failed. 

Note: The base station is not type-approved for operation when the 
supply voltage is outside the specified range. 

Alarm Description

Driver high The driver is drawing excessive current. A fixed limit has been 
exceeded.

Final 1 The Final 1 output stage is drawing excessive current. A fixed 
limit has been exceeded.

Final 2 The Final 2 is drawing excessive current. A fixed limit has been 
exceeded.

Imbalance One of the final stages is drawing significantly more current 
than the other.
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Temperature high This group of alarms shows whether the temperature in the driver, Final 1, or 
Final 2 output stage has exceeded the configured threshold. If a temperature 
exceeds a built-in limit, the PA folds back its power output until the 
temperature is within the normal range.

To see the actual temperatures, select Diagnose > Modules > PA Control Tests. 

Power Management Unit
The Power Management Unit area shows the alarm status of the PMU. The 
CSS must be connected to the channel module in position 1 of the subrack.

No PMU detected The channel module is unable to detect the PMU on the control bus. Only the 
channel module in position 1 can communicate with the PMU. If the channel 
module is in position 1, the fault may be in the communication path and the 
PMU itself is still operating satisfactorily. However, in this case the system loses 
the ability to monitor PMU alarms, carry out diagnostics, change configuration, 
or detect PMU fan failure.

Invalid PMU 
firmware

The firmware in the PMU is invalid.

1. Use the CSS to download the PMU firmware.

2. Return the PMU to Tait.

Fan failed The PMU told the channel module that its fan is on, but the channel module 
cannot detect fan motion. The network element takes no action when this 
alarm occurs, but it will act if the PMU temperature becomes too high.

The fan has failed. Replace it.

Mains supply 
failed

The mains power supply to the PMU is absent or its voltage is outside 
acceptable limits. The PMU is using DC power from its battery source. 

Power up fault The PMU has detected an internal error and will reset itself. If the reset is 
successful, the alarm will clear.

Shutdown 
imminent

A battery is currently being used to power the network element and its voltage 
has fallen below the configured power shutdown voltage. The PMU will stop 
operating 30 seconds after activating this alarm. 
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The main value of this alarm is as a syslog message, sent to the network’s alarm 
center just before the PMU shuts down.  

Temperature high One of the PMU temperature sensors has detected a temperature that is above 
the fixed limit. 

Battery The PMU measures the voltage of its battery input.

Battery protection 
mode

Battery protection mode is on. The network element is operating on mains 
power, but the battery voltage is below the configured power shutdown 
voltage. If mains power fails, the PMU will shut down to protect the battery.

Battery voltage 
low

The battery voltage is below the configured alarm threshold. This threshold 
may have been set to alert you to the risk of damage to the battery from 
overdischarge. If the voltage falls further to below the configured shutdown 
voltage, the PMU automatically shuts down to protect the battery and the 
modules in the subrack. 

1. The system has been operating on battery power; the battery has become 
flat and mains is restored. No action required.

2. The battery is not being charged. Check the PMU’s auxiliary output line, if 
it is being used for charging.

3. The battery is flat. Replace it.

4. The minimum battery voltage is set too high. 

Battery voltage 
high

The PMU’s battery voltage is higher than the configured maximum. The 
network element takes no action until the voltage reaches the fixed maximum, 
when it shuts down. 

Output The PMU measures the voltage and the amperage of its DC output to the PA 
and to the channel module. 

Output current 
high

The PMU is providing more than 15 A of current and is automatically limiting 
its output, lowering the output voltage. There is a short circuit or the PMU is 
faulty.

Output voltage 
low

The PMU’s DC output (nominally 28 V) is lower than the fixed minimum of 
24 V.

Output voltage 
high

The PMU’s DC output (nominally 28 V) is higher than the fixed maximum of 
32 V. 

Channel Module
The Channel module area shows the Alarm status of the channel module. 
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Channel invalid (Rare) The network element has received an instruction to select an invalid 
channel number and has stopped operating. 

The channel could be invalid for one of the following reasons:

1. The current channel definition no longer exists. 

2. Task Manager has selected a channel that no longer exists.

3. The channel definition has an invalid index to other information. For 
example, it specifies channel profile 3 when there is no such profile. 

Network board 
calibration invalid

The network element cannot operate properly because the analog line has not 
been calibrated, or because the calibration procedure has not been properly 
completed, deleting the old calibration value, but not storing a new value. This 
alarm is not triggered when the analog line goes out of calibration.

Use the Calibration Software to calibrate the analog line.

Network board 
configuration 
invalid

The configuration data has become corrupted. Open the corresponding 
configuration file stored on the CSS PC and program it into the network 
element.

Digital board 
calibration invalid

The network element cannot operate properly because the digital board does 
not have valid calibration settings. This could be because a calibration 
procedure has not been properly completed, deleting the old calibration value, 
but not storing a new value. This alarm is not triggered when the reciter goes 
out of calibration.

1. Use the Calibration Software to adjust the frequency setup.

2. Use the Calibration Software to fully calibrate the reciter.

3. Calibrate the reciter TCXO.

4. Replace the reciter. 

Digital board 
configuration 
invalid

The configuration data has become corrupted. Open the corresponding 
configuration file stored on the CSS PC and program it into the network 
element.

Power up failure The channel module has failed one or more of its initialization self-tests and has 
gone into Failure mode. The transmitter and receiver are disabled and any 
system interface outputs are deactivated. 

Note: This alarm will not show if the channel module cannot 
communicate with the CSS.

1. Reset the network element. This may clear the fault.

2. Send the channel module to a Service Center.

Temperature high The temperature of the reciter has exceeded the built-in threshold of 
162.5 deg F (72.5 deg C). To see more details about the reciter and its fan, 
select Monitor > Modules > Channel Module.

1. The reciter fan has failed.

2. The reciter is not fitted with a fan and the combination of ambient 
temperature and duty cycle is too high for operation without a fan.

Synthesizer out of 
lock

The channel module has three different synthesizer alarms.
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Synthesizer out of 
lock: Digital

One or more of the DSP and sampling clocks is out of lock. In response, the 
base station disabled the receiver and the transmitter.

1. The base station is configured for an external reference of a particular 
frequency, but the actual frequency of the external reference is different. 

2. The master synthesizer is unable to lock onto the frequency. The base 
station will run, but the accuracy of its receive and send frequencies cannot 
be guaranteed. Send the reciter for repair.

Synthesizer out of 
lock: Exciter

The exciter synthesizer is unable to lock on to the frequency it is configured to 
operate at. In response, the base station disabled the transmitter.

1. Check that this frequency is within the exciter’s RF frequency range. 

2. Do a diagnostic test to determine the reciter’s switching range, and then 
check that the frequency is within the exciter’s switching range. 

3. If the frequency is outside the switching range, use the Calibration Software 
to alter the switching range. Otherwise send the reciter for repair.

Synthesizer out of 
lock: Receiver

The receiver synthesizer is unable to lock onto the frequency it is configured to 
operate at. In response, the base station disabled the receiver.

1. Check that this frequency is within the receiver’s RF frequency range. 

2. Do a diagnostic test to determine the lock range, and then check that the 
frequency is within that range. 

3. If the frequency is outside the lock range, use the Calibration Software to 
alter the switching range. Otherwise send the reciter for repair.

System
The System area displays alarms that are triggered by system conditions. These 
alarms do not indicate network element faults. Set a threshold for these alarms 
if this is appropriate for the system. 

Air intake 
temperature

The base station is normally fitted with a sensor that measures the air 
temperature at the PA fan intake and determines whether it is above or below 
the configured limits.

Air intake 
temperature low

The temperature is below the configured minimum. The base station is not 
designed for operation below the default minimum.
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Air intake 
temperature high

The temperature has exceeded the configured maximum. The PA can sustain 
full-powered continuous operation at an air intake temperature of up to 60° C. 
Fan operation and PA power foldback are unaffected by this alarm; it is the 
heatsink temperature, not the air intake temperature, that turns a base station 
fan on or folds back PA power.

BER The base station estimates the BER, based on the amount of forward error 
correction it is carrying out on the digital RF it receives. If the estimated BER 
is greater than 5%, the alarm is triggered. 

BER high A high BER indicates that the quality of the received signal is poor. This alarm 
is useful when the base station is used for RF linking. It indicates that something 
is wrong with the link. For other applications, we recommend disabling the 
alarm, so that it is not triggered every time an SU user calls from almost outside 
the base station’s coverage area. 

External 
Reference

The base station can detect whether an external reference is present and 
whether it is usable.

External reference 
absent

The base station did not detect an external reference frequency source. It is now 
using its own source.

1. There is no external reference source. Many applications do not need one. 
You can disable the alarm (Configure > Alarms > Control).

2. The source has become unplugged.

3. The source is not working.

An external reference is critical for simulcast applications and for K-band 
operation.

External reference 
invalid

An external reference frequency is connected to the base station, but the base 
station cannot lock on to its channel frequency using that reference. It is now 
using its own source.

1. The base station is configured (Configure > Base Station > Miscellaneous) 
to expect a 10 MHz frequency, but the source is 12.8 MHz (or vice versa). 

2. The reference source is faulty.

Network Most network alarms give early warning that the network is becoming 
congested.

Network user 
traffic

Packets are taking too long to traverse the network. The Maximum round trip 
delay threshold has been exceeded.

QoS jitter The incoming voice stream has a delay variation greater than the configured 
threshold.

QoS lost packets The number of lost packets in the incoming voice stream has exceeded one or 
more of the configured thresholds (see “Max loss rate” on page 154 and “Max 
interarrival jitter” on page 154).
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Disabling Unwanted Alarms

You can disable any of the network element’s alarms. Some alarms may not be 
appropriate for the system.

If you disable an alarm, it is disabled in the Alarm status form and in any 
diagnostics forms where it appears. It also does not turn on the control panel 
alarm LED or result in a SNMP trap. However, the alarm still generates a syslog 
message, which the network element stores in its log and optionally sends to a 
syslog collector. Disabling an alarm disables its syslog message to the level of 
Notice. In addition, any Task Manager tasks with that alarm as an input are still 
processed. 

For detailed information about individual alarms, see “Monitoring Alarms” on 
page 143.

To disable unwanted alarms

1. Select Configure > Alarms > Control. 

2. Clear the check boxes of the alarms to be disabled.

3. Click OK.
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Altering Network Element Alarm Thresholds

The Network Element Thresholds form (Configure > Alarms > Element 
Thresholds) displays all configurable alarm thresholds.

Some alarm thresholds are fixed; they are built in to the network element and 
cannot be changed. Others have default values that can be adjusted to better 
reflect the system’s operating conditions or monitoring procedures. This can be 
important if an alarm is used as an input in Task Manager tasks.

The Minimum column displays lower thresholds. The Maximum column 
displays upper thresholds. Most parameters have only one threshold. The read-
only Currently column displays the current value of the parameter to help you 
select a suitable threshold. 

To adjust a threshold, edit its value or click one of the adjacent arrows, and then 
click OK to confirm the changes and close the form. When the current value 
of a parameter goes above the maximum or below the minimum, the network 
element triggers the corresponding alarm. The alarms that these thresholds 
apply to are described in “Monitoring Alarms” on page 143. The equivalent 
Task Manager inputs are described in “Alarm Inputs” on page 188. 

PA

Power output The minimum value defines the lower limit for the PA forward power output. 
When the output falls below this limit, the base station triggers the alarm 
Forward power low and the Task Manager input PA forward power low 
becomes true.

Reverse power 
output

The maximum value defines the upper limit for the PA’s reverse power. When 
the reverse power exceeds this limit, the base station triggers the alarm Reverse 
power high and the Task Manager input Reverse power high becomes true. 

When using a 5 W PA, or any PA set to 20 W or less, disable this alarm and use 
the VSWR alarm instead. The resolution of the reverse power measurement is 
only 1 W, so the reverse power alarm would only trigger if there is a serious 
antenna fault. VSWR has a better precision and reliably detects load failure.
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VSWR The Maximum column defines the upper limit for the VSWR. When the 
VSWR exceeds this limit, the base station triggers the alarm VSWR high and 
the Task Manager input VSWR fault becomes true. The hysteresis is fixed at 
0.2. For example, if the threshold is 1.5:1, when the VSWR falls to 1.3:1, the 
alarm is cleared and the Task Manager input becomes false. 

Final temperature The Maximum column defines the upper limit for the operating temperature 
at the Final 1 and Final 2 stages of the PA. When the temperature exceeds this 
limit, the base station triggers one of the Temperature high alarms and the Task 
Manager input PA temperature high becomes true.

Driver 
temperature

The Maximum column defines the upper limit for the operating temperature 
at the driver stage of the PA. When the temperature exceeds this limit, the base 
station triggers one of the Temperature high alarms and the Task Manager input 
PA temperature high becomes true.

Air intake 
temperature

The Maximum column defines the upper limit for the air intake temperature 
that is measured at the PA. When the temperature exceeds this limit, the base 
station triggers the Air intake temperature high alarm and the Task Manager 
input PA air intake temperature high becomes true.

The Minimum column defines the lower limit for the air intake temperature 
that is measured at the PA. When the temperature falls below this limit, the base 
station triggers the Air intake temperature low alarm and the Task Manager 
input PA air intake temperature low becomes true.

PMU

Battery voltage The Minimum column defines the lower limit for the battery voltage that is 
supplied to the DC-DC converter. Different limits apply, depending on which 
nominal voltage the DC-DC converter is designed for. When the voltage falls 
below the relevant limit, the network element triggers the Battery voltage low 
alarm and the Task Manager input Battery voltage low becomes true.

The Maximum column defines the upper limit for the battery voltage that is 
supplied to the DC-DC converter. Different limits apply, depending on which 
nominal voltage the DC-DC converter is designed for. When the voltage 
exceeds the relevant limit, the network element triggers the Battery voltage 
high alarm and the Task Manager input Battery voltage high becomes true.

Both the upper and lower limits have a hysteresis of 0.1 V. 
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Altering Network Alarm Thresholds

The Network Thresholds form (Configure > Alarms > Network Thresholds) 
displays thresholds that are mostly for measures of the quality of service of the 
network link to other channel group members. Generally, you can leave 
defaults as they are. When a threshold is exceeded, an alarm condition results. 
The aim of adjusting them is to ensure that alarms trigger before the quality of 
service deteriorates under network load, giving some advance warning. 

Tip: Select Monitor > Interfaces > Channel Group to view current 
values for quality of service measures. These can help in the setting 
of appropriate thresholds.

Max loss per call The maximum allowable number of packets lost in one over. This threshold is 
designed for detecting a sudden acute loss of service. The network element 
calculates the packets lost from a jump in the sequence number from one packet 
to the next. You can select up to 50, which is roughly equivalent to a gap of 
one second. If more packets are lost than the selected number, the network 
element raises the QoS lost packets alarm. 

 Max loss rate The maximum number of packets lost per RTCP interval (one second). If this 
is exceeded, the network element raises the QoS lost packets alarm. The 
maximum loss rate is designed for detecting a longer-term chronic degradation 
in quality of service.

Max interarrival 
jitter

The maximum allowable jitter for packets arriving at the network interface. 
The jitter is calculated for each over and if it exceeds this threshold, the network 
element raises the QoS jitter alarm.



 

TB9100 Customer Service Software User’s Manual   Logging to a Syslog Collector 155

Logging to a Syslog Collector

You can use the Logging form (Configure > Alarms > Logging) to enable and 
configure the sending of some or all system log messages to a central syslog 
collector. Messages are sent in the syslog format.

Send syslog 
messages to 
network

Select this check box to have the network element send its log messages over 
the digital line.

Note: Syslog messages can cause voice drop-outs. A switched 
network does not have QoS and so cannot give voice packets 
priority. If the network element’s logging level is low (Notice or 

Trace), syslog messages may combine with voice to exceed the available 
bandwidth, causing voice drop-outs. See the TaitNet P25 System Manual for 
guidance on bandwidth allocation and syslog bandwidth requirements.

Log address Enter the IP address of a host running syslog collector software. Use dotted 
decimal notation. The network element will send its log messages to this 
address. 

Logging Level Select the lowest level of messages to be sent to the log address. All messages at 
or above this level will be sent. The different syslog message levels are as follows:

Select ‘Warning’ to minimize the loading on the linking infrastructure. The 
network element only sends messages if there is a problem. 

Select ‘Notice’ to make sure that you do not lose the system log. All system log 
messages are sent to the syslog collector.  If the network element resets, its 
system log is cleared, but the syslog collector still has its log of messages. 

Level Description

Emergency Alarm conditions that make the network element unusable.

Alert Alarm conditions that require immediate action to prevent failure.

Critical Alarm conditions that indicate a trend towards failure, for example, 
high temperature.

Error Alarm conditions that indicate an error within the network 
element’s interfaces. 

Warning Events that do not affect behavior, but that may be of significance 
to operators or maintainers.

Notice Events that may be helpful to operators or maintainers. 

Trace Tait-internal messages. 
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Also select ‘Notice’ if you want to set the syslog collector up to respond when 
a network element fails. Each network element sends a ‘heartbeat’ message at 
level ‘Notice’ to the syslog collector. If a network element fails, the syslog 
collector no longer receives the heartbeat and can raise the alarm.

Select ‘Trace’ to provide the syslog collector with the maximum detail possible. 
This is not normally needed. 
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Configuring the SNMP Agent

Use the SNMP form (Configure > Alarms > SNMP) to configure the 
operation of the SNMP agent within the base station. This is only needed if the 
network has an SNMP-based network management system. The SNMP agent 
is designed for base stations in trunked networks with external site controllers. 
An SNMP (external trunking) feature license is required. 

Recipient address The IP address of the network management system to which SNMP traps are 
sent. If this box is empty, no SNMP messages are sent.

Port number The port number that SNMP messages are sent to.

Community name The community name that must be included in SNMP get requests. The base 
station’s SNMP agent will only accept SNMP messages that have this 
community name.

Contact Standard MIB-II data item that will be returned on a GET request for the OID 
‘SysContact.’ You can specify the person to be contacted when a SNMP trap 
occurs. 

Location Standard MIB-II data item that will be returned on a GET request for the OID 
‘SysLocation.’ You can specify the location of the network element.
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Part G Diagnosing

Using the CSS, you can carry out diagnostic tests on the base 
station or P25 Console Gateway and its modules. For many tests, 
the network element must be in Standby mode. However, you 
can view any diagnostic form in Run mode.

Generally a diagnostic form displays relevant information, so that 
you can monitor network element status before, during, and 
after the test. Often you can combine different tests.

Some diagnostic tests check aspects of the network element. 
Others provide a simple function (for example, looping back the 
analog line) that facilitates setting up or trouble-shooting the 
network element’s interface to external equipment. 

Topics

Carrying Out Diagnostic Tests

RF Interface

Receiver Tests

Measuring Received Signal Levels

Determining Synthesizer Lock Ranges

Transmission Tests

Providing Raw C4FM Data

Line Interfaces

Analog Line Tests

Testing Connections

System Interface Tests

Modules

PA Control Tests

PMU Control Tests

Control Panel Tests
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Carrying Out Diagnostic Tests

Most diagnostic tests are carried out in a similar way. The following gives 
general instructions on how to do it.

When you start a test, the network element uses its existing settings such as 
frequency and level, unless you entered different values. When a test comes to 
an end or is stopped, the network element always returns to the configuration 
it was in before the test began. For example, after making a test transmission at 
a manually selected frequency, the network element reverts to the frequency it 
was previously configured for. 

Some tests can only be carried out when the network element is in Standby 
mode. Colors in the square alongside the Start test button indicate the 
supported modes: yellow means Standby mode and green means Run mode. 
Hover the mouse over the square and a tooltip specifies the supported modes.

To carry out a diagnostic test

1. Connect to the network element. You can be remotely connected, but you 
do need to be on site to test the control panel and the speaker.

2. Click Diagnose.

3. In the navigation pane, select an item. The corresponding form appears.

4. In the form, check the network element’s current status.

5. If the rectangle alongside the Start Test button is yellow and gray, click 
Standby on the toolbar. 

6. Click Start Test. 

This either carries out the test or it enables other buttons on the form so that 
you can carry out a test. The item in the navigation pane turns red and the 
Start Test button changes to Stop Test. 

During the test, the network element will respond to any faults that occur 
(if, for example, the PA overheats, it will fold the power back) but there will 
be no alarm notification, because Task Manager is not active in Standby 
mode.

7. If desired, navigate to other forms to view monitoring screens or check the 
network element’s configuration. Some tests also allow you to 
simultaneously carry out other tests.

8. If necessary, click Stop Test to end the test (some tests end automatically). 
Selecting Run mode or disconnecting the CSS also ends the test. 
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RF Interface

The CSS can carry out a variety of tests on the connected base station’s RF 
interface. You can receive on any frequency and bandwidth, scan the switching 
range and display the signal strength, test synthesizer lock ranges, and transmit 
carrier, FM, or C4FM.

Receiver Tests
In the Receiver form (Diagnose > RF Interface > Receiver) you can carry out 
various tests on the TB9100 receiver.

Testing Receiver Operation
The Set receiver frequency test provides a quick way to check that the receiver 
is operating. You manually set the receiver frequency and do not need to alter 
the base station’s configuration. The test can be carried out on analog FM or 
digital P25 transmissions.

1. Connect an RF source to the reciter or arrange for a suitable SU to transmit 
a signal. 

2. Select Diagnose > RF Interface > Receiver. In the Frequency box, enter 
the frequency for receiving on. Alternatively, use the arrow buttons to shift 
the frequency up or down.

3. In the Channel Spacing box, select a value from the drop-down list.

4. On the toolbar, click Standby.

5. Click Start Test. 

The Current receiver values area displays information about the received 
signal.

The Synthesizer LED indicates whether the receiver synthesizer managed to 
lock onto the frequency. The Receive frequency box displays the receiver’s 
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current operating frequency. The current RSSI and SINAD are also dis-
played.

Note: The SINAD is approximate and is obtained by measuring the 
out-of-band noise. This value should not be relied upon to make 
calibrated measurements. 

Note: The speaker may not give any indication that a signal has been 
received.

6. If desired, modify the receive frequency by clicking the up or down arrows. 
(You can repeat this as often as you want.)

The End Test button turns into a disabled Starting Test button until the new 
frequency has been tested. The form now displays the new values. 

7. Click Stop Test when you are finished.

Testing Receiver Sensitivity
You can carry out a basic test of the receiver’s sensitivity without using test 
equipment. The test only works if a 50 ohm load is connected to the receiver’s 
RF input and no RF signal is being received. You can set this up by connecting 
up a test set and switching its RF off.

1. Disconnect the receive antenna and connect a 50 ohm load.

2. Select Diagnose > RF Interface > Receiver. 

3. On the toolbar, click Standby.

4. Click Start Test. The box alongside indicates whether the receiver passed 
or failed the test. The test is carried out at the frequency and channel spacing 
defined by the current channel. 

If the test result is ‘fail’ and the receiver was not receiving any RF, the 
receiver front end is not properly tuned and/or the RSSI calibration is inac-
curate. Use the calibration software to tune the receiver front end and re-
calibrate the RSSI.
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Measuring Received Signal Levels
You can measure the strength of RF signal that the base station receives across 
a band of frequencies. A bar graph displays the results. 

This test indicates what signals are out there; it does not determine the receiver’s 
sensitivity.

To measure signal levels

1. Select Diagnose > RF Interface > Signal Level.

2. In the Center frequency box, specify the middle frequency of the band to 
be tested. This can be any frequency within the receiver’s switching range.

3. In the Channel spacing box, select a value from the drop-down list. This 
specifies the size of the step from one frequency to the next. If this 
corresponds to the channel spacing, the test will measure the signal levels of 
the different channels in the band.

4. Under Peak hold, select On and the display will show the strongest signal 
received on any pass. This means signals from infrequent users are more 
likely to be included. Select Off and the display will only show the results 
of the most recent pass.

5. On the toolbar, click Standby.

6. Click Start Test. The base station sets the receiver to a frequency, measures 
the RSSI, increments the frequency by the value in the Channel spacing 
box, measures its RSSI and so on for 101 steps below and above the 
specified center frequency. Once it has completed a pass over all 101 
frequencies, it begins the next pass. You can leave the test running as long 
as you wish.

7. Click End Test to stop the test. 
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The graph displays the measured RSSI values and annotates the x-axis with 
the correct frequency values. The data is automatically saved to a file 
(signal_level_log.csv) in the LogFiles folder. You can open this file in a 
spreadsheet program. 

Determining Synthesizer Lock Ranges
You can test the reciter’s synthesizers to determine the range of frequencies that 
the receiver and the exciter can operate on. Use these tests to check that the 
reciter is calibrated correctly for the channels that it will operate on.

The Clock source box indicates whether the reference frequency is internal 
or external to the base station.

The bottom group of boxes with LEDs indicate the lock status of various parts 
of the reciter in its current operation.

To test the exciter or receiver lock range 

1. Select Diagnose > RF Interface > Synthesizers.

2. On the toolbar, click Standby.

3. Click Start Test in the Exciter synthesizer or Receiver synthesizer area. 

The exciter or receiver checks all the channel frequencies in the band that 
the base station is type-approved to operate in.

4. In the Lower Frequency and Upper Frequency boxes, view the results 
of the test. These values report the range within which the synthesizer is able 
to lock onto the specified frequency. 

Note: The reported ranges are conservative. In fact, the base station 
will be able to transmit and receive outside the range, but with 
reduced transmit output and receive sensitivity. 

Note: K-band base stations have two exciter synthesizers, each 
covering a different band. The diagnostic test will show the range of 
one synthesizer but the exciter will also be able to operate on 

frequencies within the range of the other synthesizer. When the reciter was last 
calibrated, the synthesizer to be displayed was chosen.
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5. Click Stop Test. The exciter and receiver frequencies revert to what they 
were before the start of the test.

Transmission Tests 
In the Transmission form (Diagnose > Power Amplifier > Transmission) you 
can set up and start a carrier-only test transmission. If desired, you can modulate 
the carrier by starting a FM test or a C4FM test while this carrier test is running. 

Tip: Alternatively, test the transmitter by pressing the Carrier button 
on the control panel. This transmits using the current configuration.

Carrier The Carrier area initially displays values from the current channel 
configuration. You can configure and start a test transmission.

Transmitter 
output

The Transmitter output area displays forward and reverse power gauges. You 
can choose whether to view the values as watts or dBm. Underneath is the 
VSWR.

FM In the FM area, you can configure and start FM modulation, once a Carrier test 
is running.

Note: If the current channel profile disables the transmitter (see “RF 
transmit” on page 111), you can still carry out a carrier test and a FM 
test, but not a C4FM test. 

Carrier Test
To test the base station’s ability to transmit carrier, follow these steps.

1. Select Diagnose > RF Interface > Transmission Tests.
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2. In the Transmitter frequency box, enter a frequency or use the arrows to 
increment or decrement the current frequency.

Important: Do not select a prohibited frequency. For example, 
406.0-406.100 MHz is reserved internationally for distress beacons.

3.In the Power box, specify the RF output power that the test will 
run at. The box to the right displays the equivalent power in dBm.

Important: Check the transmit frequency and RF power output 
before beginning the test. In the TB9100, the transmission test does 
not default to the currently configured frequency and power. Make 

sure you do not inadvertently transmit on someone else’s frequency.

4. Wait until the base station is not busy, to avoid interrupting a conversation, 
go to Standby mode, and then click Start Test. 

The PA outputs an RF signal on the RF Out N-connector. The Trans-
mitter output area provides a graphical display of the forward and reverse 
power and the VSWR.

5. If desired, modulate the carrier using FM (see “FM Test” on page 167) or 
C4FM (see “C4FM Test” on page 167).

6. Click Stop Test at any time to end the test. 

FM Test
To test the base station’s ability to transmit carrier modulated with analog FM, 
run a Carrier test, and then start an FM test to add analog FM modulation to 
the carrier. Follow these steps.

1. Under Carrier, start a Carrier test (see “Carrier Test” on page 166).

2. Under FM, configure FM modulation as follows.

a. In the Deviation box, select a maximum transmit deviation.

b. In the Modulation level box, specify what percentage of the maximum 
deviation the test tone will have.

c. In the Modulation frequency box, specify the frequency of the tone 
that will modulate the test signal. 

3. Under FM, click Start Test. 

C4FM Test
To test the base station’s ability to transmit carrier modulated with C4FM, the 
digital P25 standard’s modulation scheme, run a Carrier test, and then start a 
C4FM test to add C4FM modulation to the carrier. Follow these steps.

1. Under Carrier, start a Carrier test (see “Carrier Test” on page 166).

2. Under C4FM, click P25_Conformance1011 Hz in the Test pattern 
box. This defines a fixed pattern of bits which are transmitted using C4FM 
and which result in a test tone of 1011 Hz at the receiver vocoder. The 
receiving radio must be configured for the default NAC (0x293).

3. Under C4FM, click Start Test. 
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Conformance Tests
To make test transmissions in order to test the base station’s transmitter or 
another receiver for conformance to the P25 standard, follow the instructions 
for a C4FM test (“C4FM Test” on page 167), but select a different test pattern. 
The results obtained can be compared with the results on the factory test sheet.

The following test patterns are available:

For more details about these tests, see the Project 25 standards document TIA-
102.CAAA-A 

Providing Raw C4FM Data
In the Miscellaneous form, you can tell the base station to start providing output 
from the receiver as raw C4FM data. 

1. Select Diagnose > RF Interface > Log C4FM.

2. In the Log box, specify whether the data is sent to a syslog collector (at 
severity level Trace) or to the serial port. The serial port baud rate is set to 
19,200 for the duration of the logging, overriding the configured setting. 

3. Click Start log. 

Option Description

C4FM_V52BER A standard transmitter test pattern used to check a receiver’s BER.

C4FM_ModulationFidelity Standard Transmitter C4FM Modulation Fidelity Pattern. The transmitter 
output is sent directly to test equipment to check the accuracy of the base 
station’s radio modem. 

P25_ConformanceSilence Standard Silence Test Pattern. Used for testing a receiver. When this pattern 
is decoded, there should be no sound from the receiver.

P25_Conformance1011Hz Standard Tone Test Pattern. Presents a 1011 Hz tone at the receiver vocoder. 
The default NAC is embedded in the test pattern so the receiver must be 
configured with this NAC. 

P25_StdDeviation Transmits the dibits 11 and 01 using the C4FM modulation scheme. The 
test is used to measure the bandwidth used when transmitting the dibits 
with the greatest frequency offset.

P25_LowDeviation Transmits the dibits 10 and 00 using the C4FM modulation scheme. The 
test is used to measure the bandwidth used when transmitting the dibits 
with the least frequency offset. With this test pattern, a standard frequency 
counter can be used to measure the frequency of the transmitter’s carrier.

SerialInput Transmits the bit pattern received on the base station’s antenna to the serial 
input.
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Line Interfaces

Using the CSS, you can carry out a range of tests on the analog and digital lines, 
the digital inputs and output, the E & M lines, and the serial port.

Analog Line Tests
Using the CSS, you can carry out transmit and loopback tests on the analog line. 
You can also monitor line levels. 

Sending a Test Tone
The channel module can output an audio test tone. Use this to test the channel 
module’s ability to output audio on its analog line or to set up and configure 
the interface from external equipment to the network element. 

1. Select Diagnose > Line Interfaces > Analog Line.

2. Under Transmit, enter the desired test tone frequency into the Frequency 
box.

3. In the Level box, enter a level in dBm.

4. Click Start Test.

5. View the Monitor area to verify that the network element is sending the 
test tone. 

6. Adjust the external equipment as required.

7. Click Stop Test to end the test.
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Monitoring Line Levels
The channel module can measure the mean levels of the current analog line 
input and output and display them on the CSS. 

Use this diagnostic tool in the following situations:

Troubleshooting: the measurement shows whether audio is arriving at the 
network element. 

Adjusting the audio output of other equipment such as a console. 

Note: To avoid transmitting the test audio input, put the base station 
into Standby mode.

To monitor audio levels

1. Make sure that the analog line is connected. 

2. Select Diagnose > Line Interfaces > Analog Line.

The bars display the average levels for audio that the network element sends 
and receives on the analog line. Levels are measured over a window of 
500 ms and updated twice a second. The network element cannot actually 
measure values at the analog line interface: it measures them in the digital 
domain and compensates for calibration and line level adjustment effects.

Looping Back Audio
You can loop audio back on the analog line (this simply connects the audio in 
line to the audio out line). Once the audio is looped back, you can, from the 
dispatch console end of the audio line, check on line levels or check that the 
line works in both directions. 

To loop back the analog line

1. Make sure that the analog line is connected.

2. Select Diagnose > Line Interfaces > Analog Line.
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3. On the toolbar, click Standby.

4. In the Loopback area, click Start test. The State box now displays 
Enabled. 

5. When you have finished testing the analog line, click Stop test. The State 
box now displays Disabled.

Testing Connections
The CSS supports the use of the ping command to test whether there is an IP 
connection to any entity with an IP address. In this way, you can test the IP/
Ethernet links from the connected network element to routers and other 
network elements in the TaitNet P25 digital network. You can also obtain an 
estimate of link delays and use multicast IP addresses to check the membership 
of a channel group.

To carry out a ping test

1. Select Diagnose > Line Interfaces > Connections.

2. In the Destination IP address box, enter the IP address of the destination 
host. Use dotted decimal notation, for example 172.25.206.26.

3. Click Ping.

The CSS instructs the network element to send a ping command to the IP 
address you entered. Responses are displayed in the large Response box 
and the number of responses in the small Responses box below.

Note: The response time for a first ping may be long, if the network 
element needs to send an ARP request to obtain information about 
the destination IP address. A second ping carried out a short time 

later will give a more accurate estimate of the link delay, as the information will 
be cached.

System Interface Tests
The System Interface form (Diagnose > Line Interfaces > System Interface) 
displays the current state of all digital inputs and outputs. You can toggle the 
digital outputs and the M-wire output to help you test any equipment 
connected to them. This can be done on site or on the bench when the 
network element is connected to a CTU. 

The Digital inputs area displays the current settings of digital inputs. 

In the Digital outputs area, you can toggle the digital outputs. The pin 
number of each output is displayed. 

The area below displays the current state of the E line and M line. You can 
toggle the M line output.

The Computed input value area displays the binary number that is currently 
set by the digital input lines. This value is used as a Task Manager input.

Testing Digital Inputs
The Digital inputs area displays the current state of all digital inputs to the 
channel module. 
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A digital input can be high (green LED) or low (red LED). 

To test a digital input

1. Select Diagnose > Line Interfaces > System Interface.

2. Using the equipment connected to the digital input, toggle the state of that 
input.

Note: If digital input 4 is not available (through configuring pin 1 as 
an output), ignore its display.

3. In the Digital inputs area, check that the state of that input changed. 

Testing Digital Outputs
If the system interface is configured to provide a digital output, you can toggle 
that output between high and low. Pin 9 can provide digital output 0 and pin 1 
can provide digital output 1. Use this test to make sure that the output is 
working and to check that any equipment attached to that output responds as 
intended.

To test a digital output

1. Select Diagnose > Line Interfaces > System Interface.

2. Click Start Test. This enables the Toggle buttons in the Digital outputs 
area. This area now displays the output states as they were before the test.

3. Click the digital output’s Toggle button to change its state.

When the output is high, its LED is green. When it is low, the LED is red.

4. Check the response of any attached equipment.

When you have finished testing the outputs, click Stop Test. This returns all 
digital outputs to the state they were in before the test.

Testing the E & M Lines
The network element can be configured to use the E & M lines on the RJ45 
connector to carry channel seize and analog valid signals (Configure > Network 
Element > System Interface). 
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To test the E & M lines

1. Select Diagnose > Line Interfaces > System Interface.

2. Click Start Test. 

3. Using the equipment (for example the Tait CTU) connected to the E line, 
toggle the state of that input.

4. In the E wire input box, check that the state of the E line changed. 

5. Click the Toggle button alongside the M wire output box.

6. Check the equipment to verify that the state of the M line changed.

Viewing the Computed Input Value
The Computed input value area (Diagnose > Line Interfaces > System 
Interface) indicates the number of bits that the network element is using to 
compute its input value as well as the computed value itself. The former is a 
configurable item (Configure > Network Element > System Interface) and the 
latter can be used as a Task Manager input to trigger desired actions such as 
changing channel. 
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Modules

Using the CSS, you can carry out various tests on network element modules. 
You can toggle fans, simulate a mains failure, and test the controls on the 
control panel.

PA Control Tests
In the PA Control Tests form (Diagnose > Modules > PA Control Tests), you 
can test the PA fan and front panel fault LED. 

The PA Control Tests form provides information about the PA that is useful 
before you carry out any tests.

LED Indicates whether the PA has any current faults. 

State Indicates whether the fan is currently active.

Current 
temperature

The Current temperature area displays four thermometers that monitor the four 
PA temperature sensors.

Testing the PA Fault LED
You can test that the LED on the front of the PA is able to light up. (This LED 
is only visible when the front panel is removed.) 

1. Select Diagnose > Modules > PA Control Tests. 
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2. Click Start Test. This uncouples the fault LED from the PA’s operational 
logic and flashes the LED on and off continuously.

3. Verify that the PA fault LED is in fact flashing.

4. Click Stop Test to end the test. 

Testing the Fan
You can ask the base station to turn the PA fan on and off. This tests the fan 
and its control circuitry.

Test the fan after fixing a fan problem or fitting a new fan. When you fit a fan, 
use this test to verify that the fan is correctly connected, so that the PA (and not 
the PMU) activates it. 

Note: The base station can detect the motion of 3-wire fans and will 
raise an alarm if the fan does not operate.

To test the fan

1. Select Diagnose > Modules > PA Control Tests. 

2. Click Start Test. This uncouples the fan from the base station’s control but 
leaves it in its current state.

3. Click Toggle Fan. If the fan was off, this should turn it on.

4. Check that the fan is operating. A 5-second timer counts down. When it 
expires, the test ends and control of the fan reverts to the base station. 
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PMU Control Tests
In the PMU Control Tests form, you can simulate a mains failure. You can also 
check that the fan, the fault LED, and the auxiliary output are working. 

Simulating Mains Failure
Simulating a mains failure  tests the network element’s battery backup and the 
PMU’s DC-DC converter. The test can only be run if there is a DC power 
supply. 

To simulate mains failure

1. On the toolbar, select Standby.

2. Select Diagnose > Modules > PMU Control Tests.

3. Click Mains Failure Test.

The State LED should go off, indicating that mains power is no longer avail-
able to the network element. 

4. Verify that the network element is still operating.

5. To end the test, click End Test.

Testing the Fan
You can ask the network element to turn the PMU fan on and off; this tests the 
fan and its control circuitry.

Test the fan after fixing a fan problem or fitting a new fan. When you fit a fan, 
use this test to verify that the fan is correctly connected, so that the PA and not 
the PMU activates it. 

Note: The network element can detect the motion of 3-wire fans 
and will raise an alarm if the fan does not operate.
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To test the fan

1. Select Diagnose > Modules > PMU Control Tests.

2. Click Start Test.

3. Click Toggle Fan. 

4. The State LED should change from On to Off, or from Off to On. 

After ten seconds, the test automatically ends and the network element takes 
back control of the fan. 

Testing the Auxiliary Power Output
If the PMU is fitted with an auxiliary power supply submodule, you can test 
the PMU’s ability to switch its auxiliary output on and off.

Note: The auxiliary power output must be on. If it is configured to 
be on only when the PMU uses mains power, make sure that the 
PMU is not using battery power.

To test the auxiliary power output

1. Select Diagnose > Modules > PMU Control Tests.

2. Go into Standby mode.

3. Under Auxiliary power output, click Start Test.

4. Click Toggle output.

The state of the LED should change.

5. Click Stop Test.

Testing the PMU fault LED
You can test that the fault LED on the front of the PMU is able to light up. 
(This LED is only visible when the front panel is removed.)

1. Select Diagnose > Modules > PMU Control Test.

2. Click Start Test to the left of the PMU fault LED. This uncouples the LED 
from the PMU’s operational logic.

3. Check that the PMU LED flashes on and off. (The control panel LED 
should also light up, unless all PMU alarms are disabled.) 

4. Click Stop Test to restore the LED’s connection with the PMU. 
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Control Panel Tests
In the Control Panel form (Diagnose > Modules > Control Panel), you can 
carry out tests to verify that the controls on the front of the network element 
are working. You must be at the site.

Before starting a test, make sure that the CSS is connected to the same network 
element (channel) that the control panel currently selects. For example, if the 
channel button on the control panel has selected 1, you must be connected to 
reciter 1 or gateway module 1.

To test control panel buttons

1. Under Button test, click Start Test. This disables all control panel functions. 
The network element will now pass control panel inputs to the CSS. 

2. Press a button on the control panel.

3. Check that the corresponding LED in the CSS form turns green.

4. Repeat steps 2 and 3 for each other button to be tested.

5. Click Stop Test to conclude the test. 

To test the microphone’s PTT button

1. Under Button test, click Start Test. This disables all control panel functions. 
The network element will now pass control panel inputs to the CSS. 

2. Press the PTT button on the microphone.

3. Check that the PTT button LED in the CSS form turns green.

4. Click Stop Test to conclude the test. 

To test the control panel LEDs

1. Under LED test, click Start Test.

2. Check that each of the control panel LEDs is going on and off in a 
recognizable sequence. (The Power LED is not affected by this test.)

3. Click Stop Test to conclude the test. 

To test the speaker

1. Under Speaker test, click Start Test.

2. Turn up the volume and listen to confirm that a 700 Hz test tone at 0 dBm 
is coming from the speaker.

3. Click Stop Test to conclude the test. 
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Part H Task Manager

The CSS provides a window into Task Manager. You can view 
the list of tasks, create new tasks from the available list of inputs 
and actions, and create custom inputs and actions. 

You can also monitor recent Task Manager actions and disable 
any tasks that may be causing problems. 

Topics

Introduction to Task Manager

Working With the Task List

Inputs

Actions

Task Manager Examples

Customizing Task Manager

Monitoring Task Manager
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Introduction to Task Manager

Task Manager operates like this. When the network element is in Run mode, 
Task Manager processes its task list every 10 ms. If a task’s input has become 
true, its action is calculated. Once Task Manager has completed processing its 
task list, it makes the results available to other firmware processes. When the 
next 10 ms interval is reached, Task Manager begins again with the next 
processing cycle.

To change the way Task Manager works, you add new tasks or modify existing 
tasks, and then program the changes into the network element. In effect, you 
are creating scripts that make the network element perform simple actions. This 
customizes the way the network element operates without modifying its 
firmware. Task Manager can perform many functions that previously required 
expensive external equipment. 

Task Manager Rules
Before writing your own sets of tasks, you need to know the following rules 
that define how Task Manager processes tasks.

A task is only carried out if its input changes. For example, when the 
network element is in Run mode, the task IF Network element in Run 
mode THEN Increment counter 1 is not carried out. Counter 1 only 
changes when the network element goes into Run mode, because it is only 
then that the input changes from false to true.

Tasks often need to be created in pairs. For example, if you want to set the 
digital output high in response to an input, you also need to set it low when 
that input becomes false. Otherwise the output goes high and always stays 
high. 

IF Analog received THEN Set digital output high
IF NOT Analog received THEN Set digital output low

Tasks are evaluated in the order of the task list. 

External inputs (for example, alarms) never change in the middle of 
processing the task list. Changes to these inputs are queued until Task 
Manager finishes processing the task list. For example, if an alarm is triggered 
while Task Manager is in the middle of the task list, the equivalent alarm 
input does not change until the beginning of the next processing cycle.

Internal inputs (for example, locks) can change in the middle of processing 
the task list. For example, if a task unlocks automatic CWID, a task later in 
the list with the input ‘IF automatic CWID unlocked’ will be processed in 
the same processing cycle.

Tasks that are in the General folder are always processed if their input 
becomes true. Tasks that are in a channel profile or signaling profile folder 
are only processed if the current channel uses that profile. 
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Processing Cycle
To help reduce the amount of processing that Task Manager must do, the 
network element does some additional processing when an input is changed. 
All Task Manager tasks with that input are flagged “must be evaluated” and a 
flag “an input has changed” is set. This processing is done as soon as the input 
changes. 

At the 10 ms tick, Task Manager begins its processing cycle. First it checks the 
flag “an input has changed.” If no input has changed, it stops and waits for the 
next 10 ms tick. If at least one input has changed, it goes through the task list. 
First it checks whether a task has been flagged “must be evaluated.” If it has, 
Task Manager processes that task, determining the action to be taken. This is 
made available to other software processes as soon as the whole task list has been 
processed.

10 ms
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any input
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Get next task

Must task be
evaluated?
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action Log task
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Input Types
Task Manager inputs are of two main types, ‘basic’ and ‘lock.’ Tasks are 
processed differently, depending on the kind of input they have. You need to 
understand these differences if you are creating complex sets of tasks.

Basic inputs Basic inputs come from various parts of the network element. They include all 
alarms. While basic inputs can become true at any time, Task Manager will only 
process them in the course of the regular 10 ms processing cycle. For example, 
if an input becomes true in the middle of a processing cycle, Task Manager 
won’t process tasks with that input until the next processing cycle. This is 
because it only learns of the change after the completion of the first cycle. 

Lock inputs Lock inputs such as ‘Receiver unlocked’ can only become true through a Task 
Manager lock action. They are internal to Task Manager. Most become true 
automatically each time the network element enters Run mode. 

Action Types
Task Manager actions are of two main types, ‘lock’ and ‘do now’. These actions 
have different effects. 

Lock actions Lock actions lock, unlock or toggle a network element function. By default, 
functions are unlocked (except for the Auxiliary Supply). When Task Manager 
locks a function, that function cannot operate. The lock status of these functions 
is displayed in Monitor > Task Manager > Locks. 

Task Manager tasks can have lock actions as an input. When Task Manager 
unlocks a function (for example automatic CWID), the equivalent input (in this 
case Automatic CWID unlocked) becomes true and any tasks with that input will 
be processed. 

’Do now’ actions ‘Do now’ actions issue a command to the network element to do something 
immediately, for example to change channel or send the alarm log. This is a 
one-off action which has no continuing effect on the network element’s status. 
A ‘do now’ action cannot be re-triggered until the original action is completed. 
For example, Task Manager cannot carry out the action Transmit CWID now 
when the base station is still transmitting the CWID from a previous Transmit 
CWID now action. 

Custom Inputs and Actions
A task can only have one input and one output. However, existing inputs or 
actions can be combined to form custom inputs or actions. 

A custom input combines up to eight different inputs. It becomes true when 
the combination becomes true, according to the rules of the Boolean logic that 
you specify for the combination.

Similarly, a custom action can combine up to eight actions. When a task with 
a custom action is processed, all its constituent actions are carried out. 

You can also use counters, timers, and your own flags when defining tasks.
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Working With the Task List

The Task List form (Configure > Task Manager > Task List) displays the list of 
tasks that Task Manager processes. You can add new tasks, modify existing 
ones, and rearrange the order and structure of tasks. Generally, a set of tasks is 
headed by a comment indicating their nature and purpose. Comments have no 
effect on Task Manager processing. 

In the Task list item area, you can create or edit tasks and comments. To edit 
an existing item, click it in the task list. Click one of the special Help icons to 
display information about the input or action currently displayed. 

The task list displays tasks in folders. Double-click a folder (or click its +/- icon) 
to open or close it. An open folder displays the tasks and comments that belong 
to it. Tasks generally have a tick; this means that they are enabled; tasks with a 
cross have been disabled. Click an item to select it; it appears inside the Task 
List Item area. 

The folders group related tasks. Tasks in a folder for a particular profile (for 
example, the default channel profile, or Signaling profile 1) are only processed 
if the current channel uses that profile. 

Use the buttons to the right to maintain the tasks in the list. For example, you 
can insert a newly created item or delete the selected item.



 

TB9100 Customer Service Software User’s Manual   Working With the Task List 185

Maintaining the Task List
In Task Manager forms, the buttons to the right of the task list help you 
maintain the task list. To use some buttons, you must first select a task list item 
by clicking it. 

<<Update Item Saves changes made to the selected item and updates the display in the Task List.

<<Insert Item Inserts the task displayed in the Task list item area just below the selected item 
in the task list. See also “Adding a Task” on page 186.

Delete Item The Delete button deletes the current task list item.

Custom Actions Opens the Custom Actions form, where you can define a combination of 
existing actions. 

Custom Inputs Opens the Custom Inputs form, where you can define a combination of 
existing inputs. 

Move Up / Move 
Down

Shift the selected item up or down one line. Use these buttons to rearrange the 
order of tasks and comments in the task list.

Increase Indent / 
Decrease Indent

Adds or removes an indent from a selected task. Indents have no effect on Task 
Manager processing; they help to make tasks easier to read and understand. You 
can only indent tasks that are under a comment. 

Enable / Disable By default, tasks are enabled; when an input condition becomes true, Task 
Manager processes the task. Use the Enable / Disable button to disable a task so 
that it has no effect, or toggle it between enabled and disabled. 

Enabled tasks Displays the total number of enabled Task Manager tasks. You can have up to 
200 enabled tasks. 

Disabled tasks Displays the total number of disabled Task Manager tasks. The total number of 
tasks (enabled and disabled) must not exceed 400.

Comments Displays the total number of Task Manager comments. The task list can have 
up to 100 comments.
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Adding a Task
To make full use of the network element’s capabilities, you need to add your 
own tasks to the list that Task Manager processes. This enables Task Manager 
to respond to events in a way that is tailored to the system. However, the set of 
actions must be well thought out to operate in exactly the way you want. 

Important: It is possible to create tasks that undermine the network 
element’s ability to operate properly. Make sure that the choices 
made are appropriate. Be particularly careful with powerful actions 

such as Lock transmitter. 

Important: While Tait has carefully tested each input and each 
action, it is not possible to test the enormous number of possible 
combinations of inputs and actions. Thoroughly test any tasks before 

commissioning the network element. If you are uncertain about anything, refer 
to your supplier.

You can add a task anywhere in the task list. The order of tasks in the task list 
represents the order that they are processed in. 

Note: Tasks in a channel profile or a signaling profile folder will only 
be processed if the current channel has that profile assigned to it.

To define a task

1. Select Configure > Task Manager > Task List.

2. In the task list, click a task or comment below which you want to add the 
task. Alternatively, click a folder. 

3. Select Task in the Task list item area.

4. In the drop-down text box, select IF. 

Alternatively, for the task to be processed when the input condition goes 
from true to false, select IF NOT. For example, tasks with the input ‘IF 
NOT Rx Gate valid’ will be processed when the base station stops receiving 
a RF signal that fulfils all the gating requirements.

5. Position the mouse cursor over the next drop-down box and click to open 
the list of available inputs.

6. Select an input from the list. It appears in the box.

7. In the same way, select an action from the drop-down list of the last drop-
down text box. 

8. Click Insert Item. The task appears in the task list. 

9. If necessary, use the buttons on the right to move the task up or down, or 
to indent it.
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Adding a Comment
When defining a set of tasks, you need to provide a comment that names them 
and indicates what they are for and how they work. You may also want to add 
further comments on individual tasks.

To add a comment

1. Select Configure > Task Manager > Task List.

2. In the task list, click the task above which you want to add the comment. 
Alternatively, click a folder. 

3. In the Task list item area, select the Comment option. 

4. Inter the text of the comment into the box below.

5. Click Insert Item. The comment appears in the task list.

6. If necessary, use the buttons on the right to move the comment up or down, 
or to indent tasks under it.

7. Click OK to confirm the changes and close the form.

Disabling a Task
You can disable any task in the task list. This is an easy way to stop Task 
Manager doing something. (When the network element is in Standby mode, 
Task Manager is disabled and no tasks are executed.)

To disable a task

1. In any Task Manager form, click a task.

2. Click Enable/Disable. The tick at the beginning of the task turns into a 
cross.

Tip: Disable a comment to disable all tasks indented under that 
comment.
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Inputs

An input is anything that Task Manager monitors. When the state of that input 
changes from false to true, Task Manager executes tasks with that input. IF 
NOT tasks are executed when the state of the input changes from true to false. 

To select an input

1. In the Task list item area, click in the Task input box. A menu with 
several submenus appears.

2. Click on an item in the menu or submenu.

To obtain Help on the input of a task

1. In the task list, click the task. The task appears in the Task list item area.

2. Click the Help button beside the Task input box.

Alarm Inputs
Any alarm can be a Task Manager input. This makes it possible to individually 
configure the network element's response to any alarm. For information about 
alarms, see “Monitoring Alarms” on page 143. All alarms are basic inputs. Even 
if an alarm is disabled in the Alarm Control form, tasks with that alarm as an 
input will be processed.

Network element alarm on
This input becomes true when any alarm is triggered. 

Battery protection mode on
This input becomes true when the PMU is operating in battery protection 
mode, triggering the ‘Battery protection mode’ alarm. For information about 
this alarm, see “Battery protection mode” on page 147. 

Battery voltage high
This input becomes true when the ‘Battery voltage high’ alarm is triggered. For 
information about this alarm, see “Battery voltage high” on page 147. 

Battery voltage low
This input becomes true when the ‘Battery voltage low’ alarm is triggered. For 
information about this alarm, see “Battery voltage low” on page 147. 

Channel invalid
This input becomes true when the ‘Channel invalid’ alarm is triggered. For 
information about this alarm, see “Channel invalid” on page 148. 

External reference absent
This input becomes true when the ‘External reference absent’ alarm is triggered. 
For information about this alarm, see “External reference absent” on page 150. 
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External reference invalid
This input becomes true when the ‘External reference invalid’ alarm is 
triggered. For information about this alarm, see “External reference invalid” on 
page 150. 

Fan failed
This input becomes true when the PA or PMU ‘Fan failed’ alarm is triggered. 
For information about these alarms, see “Fan failed” on page 144 for the PA or 
“Fan failed” on page 146 for the PMU. 

Invalid channel selected
This input becomes true when Task Manager has selected a channel that is 
invalid. 

Network board alarm on
This input becomes true when any network board alarm is triggered.

Network board BER high
This input becomes true when the BER high alarm is triggered. For 
information about this alarm, see “BER high” on page 150.

Network board invalid calibration
This input becomes true when the Calibration invalid alarm is triggered. For 
more information, see “Digital board calibration invalid” on page 148.

Network board invalid configuration
This input becomes true when the Configuration invalid alarm is triggered. For 
more information, see “Digital board configuration invalid” on page 148.

Network board network usage traffic fault
This input becomes true when the Network user traffic alarm is triggered. For 
more information, see “Network user traffic” on page 150.

Network board QoS Jitter
This input becomes true when the QoS jitter alarm is triggered. For more 
information, see “QoS jitter” on page 150.

Network board QoS lost packets
This input becomes true when the Lost packets alarm is triggered. For more 
information, see “QoS lost packets” on page 150.

No PA detected
This input becomes true when the ‘No PA detected’ alarm is triggered. This 
occurs when the module fails or control bus communications are disrupted. For 
information about this alarm, see “No PA detected” on page 144.

No PMU detected
This input becomes true when the ‘No PMU detected’ alarm is triggered. This 
occurs when the module fails or control bus communications are disrupted. For 
information about this alarm, see “No PMU detected” on page 146.
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PA air intake temperature high
This input becomes true when the ‘Air intake temperature high’ alarm is 
triggered. For information about this alarm, see “Air intake temperature high” 
on page 150. 

PA air intake temperature low
This input becomes true when the ‘Air intake temperature low’ alarm is 
triggered. For information about this alarm, see “Air intake temperature low” 
on page 149. 

PA alarm on
This input becomes true when any PA alarm is triggered.

PA current fault
This input becomes true when any of the PA’s current alarms are triggered. 
This happens if any part of the PA is drawing excessive current, or if one final 
stage uses significantly more current than the other. For information about these 
alarms, see “Current” on page 145.

PA forward power low
This input becomes true when the ‘Forward power low’ alarm is triggered. For 
information about this alarm, see “Forward power low” on page 144. 

PA is shut down
This input becomes true when the PA’s ‘Shutdown’ alarm is triggered. For 
information about this alarm, see “Shutdown” on page 145. 

PA power foldback
This input becomes true when the PA’s ‘Power foldback’ alarm is triggered. For 
information about this alarm, see “Power foldback” on page 145. 

PA supply voltage fault
This input becomes true when one of the PA’s power supply voltage alarms is 
triggered. This happens if the voltage is too high or too low. For more 
information, see “Supply voltage” on page 145. 

PA temperature high
This input becomes true when the one or more of the PA’s ‘Temperature high’ 
alarms is triggered. For information about this alarm, see “Temperature high” 
on page 146. 

PMU alarm on
This input becomes true when any PMU alarm is triggered.

PMU mains supply failed
This input becomes true when the PMU’s ‘Mains supply failed’ alarm is 
triggered. For information about this alarm, see “Mains supply failed” on 
page 146. 
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PMU output failed
This input becomes true when one of the PMU’s output alarms is triggered, 
because the voltage is high or low or the current is high. For information about 
these alarms, see “Output” on page 147. 

PMU power up fault
This input becomes true when the PMU’s ‘Power up fault’ alarm is triggered. 
For information about this alarm, see “Power up fault” on page 146. 

PMU shutdown imminent
This input becomes true when the PMU’s ‘Shutdown imminent’ alarm is 
triggered. For information about this alarm, see “Shutdown imminent” on 
page 146. 

PMU temperature high
This input becomes true when the PMU’s ‘Temperature high’ alarm is 
triggered. For information about this alarm, see “Temperature high” on 
page 147. 

Reciter alarm on
This input becomes true when any alarm in the channel module is triggered. 

Reverse power high
This input becomes true when the ‘Reverse power high’ alarm is triggered. For 
information about this alarm, see “Reverse power high” on page 145. 

Note: Use the VSWR fault input instead of the Reverse power high 
input if the transmit power is set to less than 20 W or if the base 
station has a 5 W PA. The resolution of the reverse power 

measurement is 1 W; only a very serious antenna fault would trigger the reverse 
power high alarm if the power setting is low.

Synthesizer failed
This input becomes true when a synthesizer goes out of lock or the external 
frequency reference is invalid and the corresponding alarm is triggered. For 
information about these alarms, see “Synthesizer out of lock” on page 148 and 
“External reference invalid” on page 150.

VSWR fault
This input becomes true when the ‘VSWR high’ alarm is triggered. For 
information about this alarm, see “VSWR high” on page 145. 

Analog Line Interface
Analog line inputs are concerned with the state of the analog line interface. 

Channel seized
The Channel seized input becomes true when the analog interface receives a 
channel seize signal. This signal must be received by the means that the network 
element is configured to recognize (digital input, E & M, or tone remote). 
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Tone remote detected
The Tone remote detected (nnn) input becomes true when the network 
element detects function tone number nnn on its analog line. To select this 
input, specify a frequency (Tone 1) for a single tone or a frequency pair (Tone 
1 and Tone 2), depending on whether the analog line is configured for single 
tone or dual tone. 

Network element in Run mode
The Network element in Run mode input becomes true when the network 
element goes into Run mode. This occurs on startup and when the CSS tells a 
network element in Standby mode to change to Run mode. 

Use this input for tasks to be included in Task Manager’s initialization routine, 
to start timers, and to lock functions that will only operate under particular 
circumstances.

Important: The inverse of this input (IF NOT Network element in 
Run mode) must not be used; when the network element is not in 
Run mode, Task Manager is not operating.

Example

IF Network element in Run mode THEN Lock transmitter
IF Network element in Run mode THEN Lock receiver

This example could be used to configure a backup base station with everything 
locked but ready to go into operation when needed.

Channel
The Channel nnn input becomes true when the network element changes 
channel to the channel in the channel table with the name nnn. 

Channel changed
The Channel changed input becomes true when the network element changes 
from one channel to another.

Digital I/O
Digital I/O inputs are concerned with the state of the digital inputs and outputs. 

Digital input (n) high 
The Digital input (n) high input becomes true when digital input n goes high.

Pin 1 can be configured as digital input 4, as an antenna relay driver, or as digital 
output 1. The Task Manager input ‘Digital input 4 high’ reflects the state of pin 
1, no matter how it is configured. It can therefore be used to modify base station 
operation depending on the state of the antenna relay driver. 

Example

As the network element digital inputs float high, you probably want to create 
statements that trigger when the input is pulled low.

IF NOT Digital input (2) high THEN Go to channel 2.
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Digital input value
The Digital input value nn input becomes true when the setting of one or more 
digital inputs is changed so that the binary equivalent of those settings equals nn. 
Low is read as ‘1’ and high as ‘0’. 

Example

IF Digital input value 3 THEN Go to channel 3

Digital output high
The Digital output high (output n) input becomes true when the network 
element sets digital output n high. This can only happen through the Task 
Manager actions Set digital output high and Toggle digital output.

Locks
Lock inputs only change through Task Manager lock actions. All lock inputs 
become true when the network element enters Run mode. A lock input also 
becomes true when its function is unlocked after having been locked. 

The auxiliary power supply is an exception to the above. 

Analog line unlocked
The analog line is unlocked when the network element enters Run mode and 
when Task Manager unlocks the analog line after having previously locked it.

Automatic CWID unlocked
The automatic sending of a CWID is unlocked when the base station enters 
Run mode or when Task Manager unlocks the channel group after having 
previously locked it.

Auxiliary supply unlocked
On entering Run mode, the auxiliary supply is locked. The auxiliary supply is 
unlocked when Task Manager unlocks it. If the Auxiliary power control box 
(Configure > Network Element > Miscellaneous) is set to Task Manager, the 
auxiliary power output is also on.

Channel group unlocked
The channel group is unlocked when the network element enters Run mode 
or when Task Manager unlocks the channel group after having previously 
locked it.

Receiver unlocked
The receiver is unlocked when the base station enters Run mode or when Task 
Manager unlocks the receiver after having previously locked it.

Subaudible encoding unlocked
The encoding of subaudible signaling is unlocked when the base station enters 
Run mode or when Task Manager unlocks this function after having previously 
locked it.
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Subaudible/NAC decoding unlocked
The decoding of subaudible signaling and the NAC is unlocked when the base 
station enters Run mode or when Task Manager unlocks this function after 
having previously locked it.

Transmitter unlocked
The transmitter is unlocked when the base station enters Run mode or when 
Task Manager unlocks the transmitter after having previously locked it.

Network
Network inputs are concerned with network element functioning that affects 
the wider network.

Function code received
The Function code received (nn) input becomes true when the network 
element receives the function code nn from another channel group member. 
This input makes it possible for channel group members that are not connected 
to an analog console system to act on dispatcher wildcard commands. See the 
TaitNet P25 System Manual for details.

Important: Do not use function codes for changing channel, 
enabling/disabling RF repeat, or monitoring. Use collective 
channel control instead. 

Example

IF Function code received (02) THEN Lock subaudible/NAC decoding.

Function code sent
The Function code sent (nnn) input becomes true when Task Manager instructs 
the network element to send function code nnn to the channel group.

Important: Do not use function codes for changing channel, 
enabling/disabling RF repeat, or monitoring. Use collective 
channel control instead. 

Vote won by Analog line
The Vote won by Analog line input becomes true when the network element’s 
voter (switch) declares the signal on the analog line to be the best and the 
channel group repeats that signal. 

Vote won by Digital line
The Vote won by Digital line input becomes true when the network element’s 
voter (switch) declares the signal received on the digital line to be the best and 
the channel group repeats that signal. 

Vote won by Control panel
The Vote won by Control panel input becomes true when the network 
element’s voter (switch) declares the signal received from the control panel 
microphone to be the best and the channel group repeats that signal. 
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Vote won by RF
The Vote won by RF input becomes true when the base station’s voter declares 
the signal received from the base station’s own receiver to be the best and the 
channel group repeats that signal. 

RF interface
RF interface inputs are concerned with the state of things at the base station’s 
RF interface.

Analog received
The Analog received input becomes true when the base station starts receiving 
an analog FM signal on its RF interface.

Analog transmitted
The Analog transmitted input becomes true when the base station starts 
transmitting an analog FM signal on its RF interface.

APCO received
The APCO received input becomes true when the base station recognizes, 
through detecting frame synchronization, that it is receiving a digital P25 digital 
signal on its RF interface. 

APCO transmitted
The APCO transmitted input becomes true when the base station begins 
transmitting a digital P25 signal on its RF interface. 

PA carrier present
Whenever the reciter tells the PA to start transmitting, the PA carrier present 
input becomes true.

Received NAC
The Received NAC nnn input becomes true when the base station begins 
receiving a digital transmission with a NAC of nnn. While the base station can 
only detect the subaudible signaling that it is configured for, it can detect any 
NAC. This means that you can set up any action to be triggered by receiving a 
particular NAC.

Note: If the base station receives a particular NAC and the previous 
call used the same NAC, the action is not triggered. The NAC of 
the previous call must have been different to trigger the action. In 

other words, Task Manager requires a transition from one NAC to another, not 
merely a transition from silence to a NAC. Users can ensure that the NAC 
triggers a Task Manager action by first sending a different NAC. 

RF repeat
The RF repeat input becomes true when RF repeat is enabled in the base 
station. This can occur as a result of a dispatcher command (received via the 
DFSI gateway or implemented using the Task Manager action Enable/Disable/
Toggle RF repeat). It can also occur when the base station changes channel or 
transitions to Run mode, if this enables RF repeat. 
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Rx Gate valid
The Rx Gate valid input becomes true when the criteria for unmuting the 
receiver are met. Rx Gate valid becomes true even if the receiver signal does not 
win the vote. Rx Gate valid becomes true for analog FM and for digital P25 
signals. 

Subaudible tone detected
The Subaudible tone detected input becomes true when the base station 
detects the subaudible tone that is configured for the current channel. The base 
station is only able to detect the one subaudible tone that it is configured for.

Task Manager
Inputs under the Task Manager heading are concerned with special aspects of 
Task Manager: Custom inputs, flags, timers, and counters. 

Counter at maximum
The Counter at maximum (Countername) input becomes true when the 
particular named counter reaches the maximum value set for it in Configure > 
Task Manager > Counters. 

The counter value changes through Task Manager actions such as Increment 
counter. Counter values are read at the beginning of a processing cycle. If the 
counter value changes during the processing cycle, it is immediately available; 
any subsequent tasks will use the new input. When the network element enters 
Run mode, all counters are reset to 0.

Example

IF Counter at maximum (LightTrigger) THEN Set digital output low. 

Custom Inputs
The Custom Inputs submenu contains all the custom inputs that have been 
defined for the network element using Configure > Task Manager > Custom 
Inputs.

Flag set (flagname)
The Flag set (flagname) input becomes true when Task Manager sets the 
corresponding flag. Flagname represents any name that was assigned to the flag 
in Configure > Task Manager > Flags. The state of flags is read at the beginning 
of a processing cycle. If a flag state changes during the processing cycle, it is 
immediately available; any subsequent tasks will use the new input. When the 
network element enters Run mode, each flag is cleared, unless a Task Manager 
task explicitly sets it. 

Timer expired
A timer can only be started by the Task Manager action Start timer. It expires 
when the timer’s maximum time has elapsed. This time was entered in 
Configure > Task Manager > Timers. 

Example

IF Timer expired (CWID timer) THEN Transmit CWID now. 

This input can be used to set up regular actions such as transmitting the CWID. 
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Trunking
Trunking inputs can be used when the base station is part of a trunking system 
and is connected to an external trunking site controller. 

Control channel
The Control channel input becomes true when a base station enters Run mode 
and is handled by the trunking controller as a control channel or when a base 
station, operating as a traffic channel, takes over the control channel function 
when the previous control channel fails. This input makes it possible for Task 
Manager to modify base station operation to suit control channel operation. 

The Control channel input becomes false when a traffic channel enters Run 
mode. The input IF NOT Control channel can be used to configure base 
station operation specifically for traffic channel operation. 

Example

IF Control channel THEN Go to channel 1
IF NOT Control channel THEN Go to channel 2

Site controller present
The Site controller present input becomes true when a base station enters Run 
mode and receives heartbeat messages from an external trunking site controller. 
This input makes it possible for Task Manager to modify base station operation 
to suit trunking operation.

The Site controller present input becomes false if the base station loses contact 
with its site controller. The input IF NOT Site controller present can be used 
to configure base station operation when site controller communications fail.
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Actions

An action is something that Task Manager instructs the network element to do. 

There is often a group of actions relating to a particular network element 
function. For example, Task Manager can lock, unlock, or toggle the automatic 
transmission of a network element identity, or set, clear, or toggle a flag.

To select an action

1. In the Task list item area, click in the Task action box. A menu with 
several submenus appears.

2. Click on an item in the menu or submenu.

To obtain Help on the output of a task

1. In the task list, click the task. The task appears in the Task list item area.

2. Click the Help button beside the Task action box.

Channel Actions
Channel actions make it possible to change the network element’s current 
channel.

Go to channel
The Go to channel action instructs the network element to change channel and 
operate according to the configuration defined by the channel with the name 
specified in the action. It stays on that channel until another Task Manager 
action changes channel (for example following a reset).

The actual change of operating channel happens at the end of a processing 
cycle. This means, for example, that if the task list has a Go to channel channel 
005 action followed by a Go to channel channel 006 action, the network 
element will only ever change to channel 006.

Important: Make sure that Task Manager actions do not ask the 
network element to change channel more often than once every 
500 ms.

Go to next channel
The Go to next channel action instructs the network element to operate on the 
next valid channel in the channel table. If the network element was on Channel 
001, it changes to Channel 002. It stays on that channel until a Task Manager 
action changes channel (for example following a reset).

The actual change of operating channel happens at the end of a processing 
cycle. This means, for example, that if the task list has two Go to next channel 
actions, the network element will move two channels down the channel table. 

If the network element is already operating on the last channel in the channel 
table, the action takes it to the first channel.

Important: Make sure that Task Manager actions do not ask the 
network element to change channel more often than once every 
500 ms.
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Go to previous channel
The Go to previous channel action instructs the network element to operate on 
the previous valid channel in the channel table. If the network element was on 
Channel 002, it changes to Channel 001. It stays on that channel until a Task 
Manager action changes channel (for example following a reset). 

In network elements with a complex set of Task Manager tasks, it is important 
to understand exactly how this action works. It is not a ‘do now’ action; the 
actual change of operating channel happens at the end of a processing cycle. 
This means, for example, that if the task list has two Go to previous channel 
actions, the network element will move two channels up the channel table. 

If the network element is already operating on the first channel in the channel 
table, the action takes it to the last channel.

Important: Make sure that Task Manager actions do not ask the 
network element to change channel more often than once every 
500 ms.

Digital output actions
Task Manager actions can set the digital outputs high or low or toggle them 
between the two states.

Set digital output high
The Set digital output high action sets the selected digital output line high. 

The actual setting of the digital output doesn’t happen till the end of a 
processing cycle. So the task list can set the digital output high or low many 
times, but the output line will only ever be set in the way that the last action in 
the task list specifies. 

When you select this action, a dialog box pops up so that you can select the 
digital output line to use. The Task Manager action will only have an effect if 
the relevant system interface pin has been configured as a digital output. 

Set digital output low
The Set digital output low action sets the selected digital output line low.

The actual setting of the digital output doesn’t happen till the end of a 
processing cycle. So the task list can set the digital output high or low many 
times, but the output line will only ever be set in the way that the last action in 
the task list specifies. 

When you select this action, a dialog box pops up so that you can select which 
digital output line to use. The Task Manager action will only have an effect if 
the relevant system interface pin has been configured as a digital output. 

Example

IF Counter at maximum (LightTrigger) THEN Set digital output low. 

Toggle digital output
The Toggle digital output action changes the state of the selected digital output 
line. If it was low, it become high. If it was high, it becomes low. 
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The actual setting of the digital output doesn’t happen till the end of a 
processing cycle. So the task list can change the state of the digital output many 
times, but the output line will only ever be set in the way that the last action in 
the task list specifies. 

When you select this action, a dialog box pops up so that you can select the 
digital output line to use. The Task Manager action will only have an effect if 
the relevant system interface pin has been configured as a digital output. 

Fan test now
The ‘do now’ action Fan test now instructs the network element to run the fans 
for 5 seconds, irrespective of the temperature. If the fans are already running, 
this has no effect.

Locks
Lock actions lock, unlock or toggle a network element function. By default, 
functions are unlocked (except for the Auxiliary Supply). When Task Manager 
locks a function, that function cannot operate. If Task Manager unlocks a 
function, it is free to operate. (However, for the function to actually operate, it 
may need to be licensed and to be enabled in configuration.) 

Generally speaking, if you create a task that locks a function, you need to create 
at least one equivalent function that unlocks it again.

The current status of Task Manager locks is displayed in Monitor > Task 
Manager > Locks. 

Each lock action has an equivalent lock input. When Task Manager unlocks a 
function (for example automatic CWID), the equivalent input (in this case 
Automatic CWID unlocked) becomes true and any tasks with that input will be 
processed. 

Analog line lock
Task Manager can lock the analog line. This disconnects the dispatch console 
from the network element. No analog voice can pass between the console and 
the network element. Physical signaling on the E line is recognized, but the 
channel cannot be seized.

Automatic CWID lock
Task Manager can lock the automatic transmission of a CWID. This stops the 
base station from transmitting its CWID as configured in Configure > RF 
Interface > CWID. It does not affect the ability of Task Manager to send a 
CWID using the action Transmit CWID now.

Auxiliary supply lock
If the Auxiliary power control box (Configure > Network Element > 
Miscellaneous) is set to Task Manager, locking the auxiliary supply turns it off 
and unlocking it turns it on.

Example

IF Network element in Run mode THEN Unlock auxiliary supply

This task turns the auxiliary output on whenever the network element enters 
Run mode. 
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Channel group lock
Task Manager can lock the current channel group. This disconnects the 
network element from its channel group so that it cannot receive a voice stream 
or function code from other channel group members. 

Changing channel group (by changing channel) has no effect on the lock. 

Example

IF Tone remote detected (650) THEN Lock Channel Group.
IF Tone remote detected (850) THEN Unlock Channel Group.

This pair of tasks makes it possible for the dispatcher to instruct a base station to 
disconnect itself from the channel group, so that dispatcher communications 
only use that base station, and then to re-connect the base station, as needed.

Receiver lock
Task Manager can lock the receiver. This prevents the base station from 
receiving any RF signals. 

Subaudible encode lock
Task Manager can lock the encoding of subaudible signaling. When encoding 
is locked, transmissions do not contain any subaudible signaling.

The transmission of the NAC cannot be locked, because it is not possible to 
send P25 digital transmissions without a NAC.

When decoding is unlocked, the transmitter behaves according to the current 
signaling profile. 

Subaudible/NAC decode lock
Task Manager can lock the decoding of subaudible signaling and the NAC. 
When decoding is locked, the receiver unmutes irrespective of the subaudible 
signaling or the NAC that the received signal contains. 

When decoding is unlocked, the receiver behaves according to the current 
signaling profile. 

Transmitter lock
Task Manager can lock the transmitter. This prevents the base station from 
sending any RF signals. 

RF repeat actions
If the RF Repeat setting of the current channel (in the channel table) is set to 
DispatchControlled, Task Manager can enable, disable, or toggle the base 
station’s RF repeat function. If the control of RF repeat is set to Collective (see 
“RF repeat” on page 126), this action will be passed on to the other members 
of the channel group.

You can create tasks with this action in the P25 Console Gateway, even though 
it has no RF capability. The action has no effect on the console gateway itself, 
but if collective channel control is enabled, the action is passed on to the other 
channel group members.

Example

IF Tone remote detected (550) THEN Enable RF repeat
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IF Tone remote detected (650) THEN Disable RF repeat

Send function code
The Send function code action sends the defined function code over the digital 
line to all channel group members. This action is needed in order to propagate 
a dispatcher wildcard command to the channel group. See the TaitNet P25 
System Manual for details.

Important: Do not use function codes for changing channel, 
enabling/disabling RF repeat, or monitoring. Use collective 
channel control instead. 

Example

IF Tone remote detected (550) THEN Send Function Code 5

Statements of this type make it possible for wildcard commands received over 
the analog line to be relayed to the other channel group members, so that all 
can, for example, unmute to any signal rather than to a particular NAC or 
subaudible tone or code.

Task Manager
Outputs under the Task Manager heading are concerned with special aspects of 
Task Manager: counters, custom outputs, flags and timers. 

Counter actions
Task Manager actions make it possible to increment or decrement a counter 
value, or to reset the value to 0. Before creating statements with these actions, 
set up one or more counters in Configure > Task Manager > Counters. 

Increment counter
The Increment counter (nn) action adds one to counter nn. When a counter 
reaches its specified maximum, it triggers actions with the input Counter at 
maximum (nn). Further Increment counter actions have no effect.

Decrement counter
The Decrement counter action subtracts one from the current value of the 
counter specified. If the counter is at 0, Decrement counter actions have no 
effect.

Reset counter
The Reset counter action sets the value of the counter specified to zero, so that 
it must begin counting anew. 

Flag actions
Task Manager actions can set or clear flags. Before creating statements with flag 
actions, name one or more flags in Configure > Task Manager > Flags.

Set flag
Task Manager can set or clear any of 16 numbered flags. A flag can only have 
one of two states: set or cleared. The state of a flag can be used as an input in 
other tasks.
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Clear flag
Task Manager can set or clear any of 16 numbered flags. A flag can only have 
one of two states: set or cleared. The state of a flag can be used as an input in 
other tasks.

Toggle flag
Task Manager can set or clear any of 16 numbered flags. Toggling a set flag 
clears it. Toggling a cleared flag sets it. The state of a flag can be used as an input 
in other tasks.

Timer actions
Task Manager can start or stop timers. Before creating statements with timer 
actions, set up one or more timers in Configure > Task Manager > Timers.

Start timer
Task Manager can start or stop any of its 16 timers. When a timer is started, it 
is re-initialized, then it begins to count up from zero to the maximum set in 
Configure > Task Manager > Counters and Timers. When it has reached that 
maximum, it expires. You can create tasks that are executed when a timer 
expires.

Stop timer
Task Manager can start or stop any of its 16 timers. When a timer is stopped, it 
ceases to count up, so it does not expire. If it is re-started, it starts counting up 
again from 0. You can create tasks that are executed when a timer expires.

Transmit CWID now
The ‘do now’ action Transmit CWID now instructs the base station to 
immediately transmit the CWID message defined in the CWID form. This 
action enables you to configure CWID transmissions in a way that is not 
otherwise possible. For example, the CWID could be transmitted more than 
once a minute or at every transmit tail. 

Transmit CWID now is not affected by the Task Manager Automatic CWID 
lock. 

Custom Actions
The Custom Actions submenu contains all the custom actions that have been 
defined for the network element using Configure > Task Manager > Custom 
Actions. 
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Task Manager Examples

Task Manager makes it possible for you to build complex functions into a base 
station or P25 Console Gateway. Here are some examples of to give an idea of 
what can be done. 

Important: While Tait has carefully tested Task Manager, no 
guarantee can be given that these examples will work correctly for 
the system. Make sure that you thoroughly test any set of Task 

Manager tasks before commissioning the system.

Scanning Repeater
Task Manager makes it possible for a stand-alone TB9100 to function as a 
scanning repeater.

The set of Task Manager statements below works like this. When the TB9100 
goes into Run mode, the ChangeChannel timer starts. When that timer stops, 
Task Manager instructs the TB9100 to go to the next channel in the channel 
table. If the TB9100 receives a call that wins the vote, it stops scanning. When 
the call ends, a second timer (OnChannel) is started. This timer stops the base 
station scanning long enough to give the called party time to respond.

IF Network element in Run mode THEN Start timer (ChangeChannel)
IF Vote won by RF THEN Stop timer (ChangeChannel)
IF Vote won by RF THEN Stop timer (On Channel)
IF NOT Vote won by RF THEN Start timer (On Channel)
IF Timer expired (ChangeChannel) THEN Go to next channel
IF Timer expired (ChangeChannel) THEN Start timer (ChangeChannel)
IF Timer expired (On Channel) THEN Go to next channel
IF Timer expired (On Channel) THEN Start timer (ChangeChannel)

Important: Set the ChangeChannel timer to at least 350 ms. 
Changing channels too quickly can put excess load on the firmware 
and cause it to miss its deadlines. The consequences could include 

the firmware protection mechanisms restarting the base station. 

Give the On Channel timer a suitable value (for example, 5 seconds), to give 
the called party time to respond before the base station changes channel. 

A small variation on this set of statements can make the base station stay on its 
home channel until an external signal triggers the scanning.
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Customizing Task Manager

Customizing Task Manager adds to its power and flexibility. There are several 
options available. You can create custom inputs or actions and define timers, 
counters, and flags. You can then use them to create tasks that will be executed 
when the custom input becomes true, the timer expires, the counter reaches its 
maximum, or the flag is set. 

Working With Custom Inputs
The Custom Inputs form (Configure > Task Manager > Custom Inputs) lists 
the existing custom inputs. Click an input to see what combination of standard 
inputs it consists of. You can also create new custom inputs and edit or rename 
existing ones. 

A custom input is a user-defined Task Manager input that consists of a 
combination of standard inputs. Custom inputs make it possible to define tasks 
that will be processed when a combination of inputs becomes true. (A Task 
Manager task can only have one input.)

Viewing a Custom Input
1. Click an item in the Custom Input Name column.

2. View the display in the rest of the form. It shows the standard inputs used 
to create the custom input, whether they are negated, and the logic of their 
combination. The standard truth table determines the outcome for the 
different states of any pair. (See “Truth Table” on page 206.)

The Logic column shows graphically how the standard inputs will be com-
bined. First the input is negated, if its Not check box is selected. Then it is 
combined with the adjacent input to which it is joined by a line. The result 
of that combinatorial operation is combined with the input or result that it 
is joined to, and so on, until the final result is obtained. In this way, up to 
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eight standard inputs can be combined to produce an input that can only be 
true or false.

Defining a Custom Input
1. Click New. 

2. Edit the name that appears in the Custom Input Name column.

3. Click in an Input box and select an input from the list. 

4. If you want the negative of the input to contribute to the custom input’s 
logic, select the Not check box alongside.

5. Repeat steps 3 and 4 for all the standard inputs that will go to make up the 
custom input. The Input boxes that you choose will determine the order in 
which the standard inputs are combined. 

6. Under the Logic heading, select the appropriate options in the drop-down 
boxes to give the desired logical combination of inputs. (For information 
about the effect of the different options, see “Truth Table” on page 206.)

7. Click OK.

Truth Table
The truth table below displays the possible individual values for input A and 
input B, and the result when you combine those values using each of the six 
available logic operators. So, for example, if A is true and B is false and we 
combine A and B using XOR, the result is true. 

A B AND NAND XOR XNOR OR NOR

false false false true false true false true

false true false true true false true false

true false false true true false true false

true true true false false true true false
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Working With Custom Actions
The Custom Actions form (Configure > Task Manager > Custom Actions) 
displays the list of existing custom actions. Click a custom action to see what 
combination of standard actions it consists of. You can also create new custom 
actions and edit or rename existing ones. 

A custom action is a user-defined Task Manager action that consists of more 
than one standard action. It saves you writing several different tasks with the 
same input.

Viewing a Custom Action
1. Click an item in the Custom Action Name column.

2. View the Standard Actions column. It lists the standard actions that the 
custom action consists of.

Defining a Custom Action
1. Click New. 

2. Edit the name that appears in the Custom Action Name column.

3. Click in the first row of the Standard Actions column and select an action 
from the list. 

4. Repeat step 3 for all the standard actions that will go to make up the custom 
action. 

5. Click OK.
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Defining Counters, Timers, and Flags
Counters, timers, and flags make it possible for Task Manager to do such things 
as respond to three presses of PTT or to email a status message once a week.

Note: Short timers may not be accurate. This is because it may take 
Task Manager longer than 10 ms to process its tasks, causing it to 
miss the next instruction to go through its task list. We recommend 

that you avoid short timers (< 50 ms) if the task list has more than 10 enabled 
tasks. 

To define a counter

1. Select Configure > Task Manager > Counters.

2. If desired, enter a suitable name for the counter into the Name box.

3. In the Maximum box, enter the highest number that the counter can 
reach. 

When the counter reaches its maximum, the input Counter at maximum 
becomes true for that counter and any tasks containing it are processed.

To define a timer

1. Select Configure > Task Manager > Timers.

2. If desired, enter a suitable name for the timer into the Name box.

3. In the Units box, specify the unit of time for the entered number. 

When the timer reaches its maximum, the input Timer expired becomes 
true for that timer and any tasks containing it are processed.

To define a flag

1. Select Configure > Task Manager > Flags.

2. If desired, enter a suitable name for the flag into the Name box.

3. Click OK.
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Monitoring Task Manager

The items under Monitor > Task Manager provide options for monitoring 
Task Manager. If the network element is behaving unexpectedly, check to see 
whether Task Manager has locked any functions. Alternatively, have a look at 
the system log; it records any actions that Task Manager carries out. You can 
also view the current state of timers, counter, and flags.

Viewing Locks
The Locks form (Monitor > Task Manager > Locks) shows whether Task 
Manager has locked any functions. 

If the function is locked, the form displays a red locked padlock. 

If the function is unlocked, the form displays a green open padlock.

When the network element enters or re-enters Run mode, all functions (except 
for the auxiliary supply) are unlocked. A function can only be locked through 
Task Manager action.

The Locks form is an important place to check, if the network element is not 
behaving as expected. 

Analog line When the analog line is locked, the analog line cannot be used. 

Auxiliary supply By default, the auxiliary supply is locked. 

Locking or unlocking the auxiliary supply only has an effect if the auxiliary 
supply is configured to be under the control of Task Manager (Configure > 
Network Element > Miscellaneous). In this case, when the auxiliary supply is 
locked, the auxiliary power output is turned off. When the auxiliary supply is 
unlocked, it is on and supplying power. 

Channel group When the channel group is locked, the network element cannot input or 
output a voice stream over its digital line.

Automatic CWID When automatic CWID is locked, the base station cannot automatically 
transmit a continuous wave ID (Morse code). However, Task Manager can still 
initiate the sending of the CWID using the action Transmit CWID now.
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Receiver When the receiver is locked, it is unable to pass any received audio.

Transmitter When the transmitter is locked, it is unable to transmit.

Subaudible 
encode

When the encoding of subaudible signaling is locked, subaudible signaling is not 
added to the transmitted signal. (The encoding of the NAC cannot be locked.)

Subaudible/NAC 
decode

When the decoding of subaudible signaling and the NAC is locked, subaudible 
signaling and the NAC are not decoded, which means that the receiver 
unmutes to any CTCSS tone, DCS code, or NAC. 

Viewing Timers
The Timers form (Monitor > Task Manager > Timers) displays the current 
state of any timers configured for Task Manager. 

The Name column lists the timers. A bar graph shows how far each timer has pro-
gressed towards its maximum value, which is displayed in the Maximum column. 

Viewing Counters
The Counters form (Monitor > Task Manager > Timers) displays the current 
state of any counters  configured for Task Manager. 

The Name column lists the counters. A bar graph shows how far each counter 
has progressed towards its maximum value, which is displayed in the Maximum 
column.

Viewing Flag States
The Flags form (Monitor > Task Manager > Timers) displays the current state 
of any custom flags configured for Task Manager. 

Each of the possible flags has an LED alongside it. A flashing red LED means 
that the flag is set. A green LED means that is is cleared.
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TaitNet P25 Glossary

This glossary contains an alphabetical list of terms and abbreviations related to 
the TaitNet P25 network, the CSS, the TB9100 base station, and the P25 
Console Gateway.

A

administrator A special type of access to CSS functions, used for activities such as changing 
passwords.

access code A password required to gain access to a set of privileges.

ADC Analog-to-Digital Converter. A device for converting an analog signal to a 
digital signal that represents the same information.

AES AES (Advanced Encryption Standard) is an encryption algorithm that uses keys 
of up to 256 bits. 

AGC Automatic Gain Control. A device that optimizes signal level.

Algorithm ID The Algorithm ID is an identifier that specifies an encryption algorithm (for 
example, DES or AES).

analog FM mode A mode of operation in which the RF interface transmits and receives analog 
FM signal. The network element’s channel group interface sends and receives 
the analog signal as G. 711 speech packets.

analog valid Analog valid is a signal that indicates that the TB9100 base station or P25 
Console Gateway is presenting a valid output on the analog line. This output 
can originate from an analog FM or from a digital P25 call. The M-line carries 
the analog valid signal. 

ANI Automatic Number Identification. A service that provides the receiver of a call 
with a numerical identifier or alphanumeric label of the caller.

antenna relay A DC-powered device that switches the antenna as needed between the base 
station’s receiver and transmitter. With an antenna relay, a simplex base station 
only needs one antenna. 

APCO The Association of Public Safety Communications Officials in the United 
States. The APCO Project 25 standards committee defined the P25 digital radio 
standard. The standard is often referred to as APCO or P25.
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ARP ARP (Address Resolution Protocol) is a IP protocol used to map IP network 
addresses to the hardware addresses used by a data link protocol. 

B

Base station A radio receiver and transmitter that is located in a specific place (at a site) that 
enables a two-way radio to communicate with a dispatcher or over a larger 
range with other two-way radios. Specifically, Tait TB9100 equipment in a 
subrack.

Battery protection 
mode

A PMU enters battery protection mode when it has AC power but its DC 
power is below the configured power shutdown voltage. In battery protection 
mode, the PMU will shut down to protect the battery if it loses AC power. 

BCD BCD (binary coded decimal) is a code in which a string of four binary digits 
represents a decimal number.

bearer network Telecom equipment that is used to carry user data. 

BER Bit Error Rate. A measure of the quality of digital transmission, expressed as a 
percentage. The BER indicates the proportion of errors to correctly received 
digits in a received signal.

C

C4FM Compatible Four-level Frequency Modulation. A modulation scheme defined 
in the P25 CAI standard for 12.5 kHz bandwidth.

CAI Common Air Interface. The over-the-air data formats and protocols defined by 
the APCO P25 committee.

Calibration 
Software

The TB9100 Calibration Software is a utility for defining the switching ranges 
of the receiver and the exciter and for flattening the receiver response across its 
switching range. It can also be used to calibrate TB9100 modules.

call A complete exchange of information between two or more parties. A call 
requires a receive signal path and a transmit signal path. In trunked systems, a 
call may be a conversation, made up of a number of overs, but in conventional 
systems, a call is an over.

calling profile A group of configuration settings that defines the properties of the TB9100 
analog line, which can be regarded as equivalent to a SU on the network. 

central voting Voting that is centralized at one member of the channel group.
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channel A channel is:
1. A path through which signals can flow.
2. In the RF domain, a frequency pair (or just a single frequency in a simplex 
system).
3. A set of configuration information that defines the frequency pair and other 
related settings (a channel configuration). ‘Channel’ has this meaning in the 
CSS.

channel coordinator A software module within the reciter or gateway module that propagates 
dispatcher channel control commands to the channel group. The channel 
coordinator also ensures that all channel group members have consistent states 
so that they work together properly. 

channel group A channel group is a single logical channel consisting of a set of base stations. 
P25 Console Gateways can also be members. The members of a channel group 
are linked by an IP network and share a common multicast IP address. 

channel module Channel module is a common term used to refer to reciters and gateway 
modules. TB9100 base stations have reciters and P25 Console Gateways have 
gateway modules.

channel profile A channel profile is a named group of configuration settings that help to define 
the properties of a channel. Each channel in the channel table must have a 
channel profile assigned to it.

channel seize Channel seize is a signal received at the analog line interface, requesting the base 
station or P25 Console Gateway to accept the signal on the analog line as an 
input into the channel group. An asserted E-line, LLGT, or LLGT following 
MDC1200 signaling can function as a channel seize signal.

channel spacing Channel spacing is the bandwidth that a channel nominally occupies. If a base 
station has a channel spacing of 12.5 kHz, there must be a separation of at least 
12.5 kHz between its operating frequencies and those of any other equipment. 

channel table The channel table is the base station’s database of channel configurations.

CKR The CKR (common key reference) is a number used by the key fill device and 
by the CSS to indirectly refer to an encryption key without using its Key ID or 
Algorithm ID.

circuit domain The part of the base station processing functionality that processes speech signal 
as a continuous stream of bits – a digital circuit. The opposite of packet domain.

community 
repeater

Repeater that is shared by several user groups.

CODEC A device which combines analog-to-digital conversion (coding) and digital-to-
analog conversion (decoding).
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configuration file A configuration file consists of all the configuration settings needed for a base 
station or P25 Console Gateway, stored as a file in the configurations folder. 
Configuration files have the extension *.apc.

connection list A connection list contains the names and IP addresses of base stations and P25 
Console Gateways that the CSS can connect to.

control bus The control bus is used for communications between modules in a subrack. It 
is an I2C bus, a bi-directional two-wire serial bus which is used to connect 
integrated circuits (ICs). I2C is a multi-master bus, which means that multiple 
chips can be connected to the same bus, and each one can act as a master by 
initiating a data transfer. 

control panel The control panel is an area at the front of the base station or P25 Console 
Gateway with buttons, LEDs and other controls that let a maintainer interact 
with the network element.

conventional 
network

Conventional networks are systems that do not have centralized management 
of channel access. System operation is entirely controlled by system end users. 

CRTP Compressed RTP.

crypto module Module for securely storing encryption keys and for encrypting and decrypting 
signals. 

CSS Customer Service Software. Tait PC-based software for monitoring, 
configuring, and diagnosing a Tait TB9100 base station or P25 Console 
Gateway.

CTCSS CTCSS (continuous tone controlled squelch system), also known as PL (private 
line) is a type of signaling that uses subaudible tones to segregate groups of users.

custom action A custom action is a user-defined Task Manager action that consists of more 
than one pre-defined action.

custom input A custom input is a user-defined Task Manager input that consists of a set of 
pre-defined inputs that are combined using Boolean logic.

CWID CWID (Continuous Wave IDentification) is a method of automatically 
identifying the base station using a Morse code. Continuous wave means 
transmission of a signal with a single frequency that is either on or off, as 
opposed to a modulated carrier. 

D

DAC Digital-to-Analog Converter. A device for converting a digital signal to an 
analog signal that represents the same information.
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DCS DCS (digital coded squelch), also known as DPL (digital private line), is a type 
of subaudible signaling used for segregating groups of users. DCS codes are 
identified by a three-digit octal number, which forms part of the continuously 
repeating codeword. When assigning DCS signaling for a channel, you specify 
the three-digit code.

de-emphasis De-emphasis is a process in the receiver that restores pre-emphasized audio to 
its original relative proportions. 

DES DES (Data Encryption Standard) is an encryption algorithm selected by the P25 
standard.

DDC Digital Down Converter. A device which converts the digitized IF signal of the 
receiver down to a lower frequency (complex baseband) to suit the DSP. 

DFSI The Digital Fixed Station Interface connects digital dispatch equipment with a 
base station or channel group. It is defined in the Project 25 TIA standard. 

digital input value A value that the TB9100 base station computes from the state of a configured 
number of digital inputs. The digital input value is an input into Task Manager.

digital P25 mode A mode of operation in which the RF interface transmits and receives digital 
signal as defined by the APCO P25 CAI. The digital line sends and receives 
IMBE speech packets.

dispatcher A dispatcher is a person who gives official instructions by radio to one or more 
SU users.

distributed voting Voting for the best RF signal that is carried out separately by each channel 
group member using the same voting algorithm. 

dotted quad A method for writing IPv4 addresses. The form is DDD.DDD.DDD.DDD 
where DDD is an 8-bit decimal number.

downlink The transmission path from fixed equipment to SUs.

DSP Digital Signal Processor.

dual mode The ability to operate as a transceiver in two different ways: analog FM and P25 
digital. Dual mode equipment can be configured to support either mode or to 
switch between modes from one over to another.

duplex Providing transmission and reception in both directions simultaneously. 

duty cycle Duty cycle is used in relation to the PA. It is the proportion of time (expressed 
as a percentage) during which the PA is transmitting.
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E

E & M A pair of wires used for DC signaling. For example, the signal to set up a call is 
often sent from the ‘M’ (mouth) end of a wire to the other ‘E’ (ear) end by 
grounding the wire. 

EIA Electronic Industries Alliance. Accredited by the American National Standards 
Institute (ANSI) and responsible for developing telecommunications and 
electronics standards in the USA.

encryption The coding of voice (or data) into unintelligible forms for secure transmission.

EMC Electromagnetic Compatibility. The ability of equipment to operate in its 
electromagnetic environment without creating interference with other devices.

ETSI European Telecommunications Standards Institute. The non-profit 
organization responsible for producing European telecommunications 
standards.

F

FCC Federal Communications Commission. The FCC is an independent United 
States government agency that regulates interstate and international radio 
communications.

Feature Code Code that identifies a software feature license that can be enabled or disabled 
using the Software Feature Enabler.

Feature Code 
Sequence Number

Number that indicates how many times a software feature license has been 
enabled or disabled. 

Feature license key A set of digits purchased from Tait that is required to enable a software feature 
license.

FEC Forward Error Correction. A method of encoding data so that the receiving end 
is able to correct transmission errors. 

fill-in receiver An additional receiver placed within the coverage area of a base station to 
receive SU transmissions that are too weak to be received by that base station. 

FFSK Fast Frequency Shift Keying. A modem encoding scheme for carrying data on 
FM radios.

flag A flag is a programming term for a “yes/no” indicator used to represent the 
current status of something. The network element has a set of flags that Task 
Manager can set and clear.



 

TB9100 Customer Service Software User’s Manual   TaitNet P25 Glossary 217

FLASH Electrically block erasable and programmable read-only memory.

FM Frequency Modulation. Often used as an adjective to denote analog radio 
transmission.

frequency band The range of frequencies that the equipment is capable of operating on.

front panel The cover over the front of the TB9100 base station containing fans for the PA 
and PMU.

FSH Fixed Station Host.

function code A value that Task Manager can send to the channel group that can serve as an 
input to Task Manager actions at other channel group members. 

G

G. 711 The name of the ITU standard that defines how speech is digitally encoded (64 
kbit, A-law or u-law). When the TB9100 base station is in analog FM mode, 
G. 711 speech is sent and received on the channel group interface. 

gating Gating is the process of opening and closing the receiver gate. When a valid 
signal is received, the receiver gate opens, letting the signal through. 

group call A group call is a call that is sent to more than one SUs simultaneously.

H

heartbeat message A message whose purpose is to indicate to the receiver that the sender is 
operational. 

hiccup mode Many power supplies switch off in the event of a short-circuit and try to start 
again after a short time (usually after a few seconds). This “hiccup”-type of 
switching off and on is repeated until the problem is eliminated.

HLGT High level guard tone. A tone that announces the beginning of tone remote 
signaling. 

hostname The unique name by which a network element is known on the network. 

hub A unit for connecting hosts together. It sends all incoming Ethernet packets to 
all the other hosts.
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hysteresis Hysteresis is the difference between the upper and lower trigger points. For 
example, the receiver unmutes when the upper trigger point is reached, but will 
mute again until the level falls to the lower trigger point. An adequate hysteresis 
prevents the receiver gate from repeatedly muting and unmuting when the level 
varies around the trigger point. 

I

IMBE Improved Multiband Excitation. A voice compression technology patented by 
Digital Voice Systems, Inc and used in the vocoders of P25 radios. 

impairment A measure of signal quality used in channel group voting. Impairment is 
inversely related to signal quality. The lowest impairment (0) indicates the 
highest signal quality. The highest impairment (15) indicates the worst signal 
quality. 

inbound Inbound describes the direction of a signal: from a subscriber unit over the air 
interface to the fixed station.

inhibit A control command that can be sent across the CAI to inhibit a SU. An 
inhibited SU appears to the user as if it is powered off. 

IP Internet Protocol. IP is a protocol for sending data packets between hosts.

isolator An isolator is a passive two-port device which transmits power in one direction, 
and absorbs power in the other direction. It is used in a PA to prevent damage 
to the RF circuitry from high reverse power.

K

kernel The kernel is the core executable of an operating system.

key ID The Key ID is the identifier for an encryption key variable.

key fill device A device such as a Motorola KVL3000+ for defining encryption keys and 
transferring them into P25 equipment. 

keytone A signaling tone that accompanies voice on the analog line and is used to key 
the transmitter. Also referred to as LLGT.

key variable The key variable is a parameter used by the encryption algorithm to encrypt or 
decrypt a message. 
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L

LAN Local Area Network

LDU Link Data Unit. Voice calls are sent over the CAI as a series of LDUs. 

LED Light Emitting Diode. Also the screen representation of a physical LED.

LLGT Low level guard tone. One of a set of tones used to remotely control base 
stations.

M

MDC1200 MDC1200 is a proprietary signaling protocol developed by Motorola and used 
in analog PMR to provide subscriber signaling.

monitor The Monitor function unmutes the receiver, so that the user can hear all traffic 
on a channel.

multicast group The group of hosts associated with a specific IP multicast address.

multicast IP address An IP address that refers to a group of hosts rather than a single host. These hosts 
will all accept packets with this IP address. 

mute A mute prevents audio from being passed to the radio’s speaker. 

N

NAC Network Access Code. The 12 most significant bits of the network identifier 
information that precedes every packet sent on the CAI. The NAC identifies 
which network the data belongs to, allowing base stations and mobiles to ignore 
packets belonging to interfering networks.

NAT NAT (network address translation) allows the use of a single IP address for a whole 
network of computers. A NAT sits between the public Internet and the 
network it serves, and works by rewriting IP addresses and port numbers in IP 
headers on the fly so the packets all appear to be coming from (or going to) the 
single public IP address of the NAT device instead of the actual source or 
destination.

navigation pane The navigation pane is the left-hand pane of the CSS application window. It 
displays a hierarchical list of items. When you click an item, the main pane 
displays the corresponding form.



 

220 TaitNet P25 Glossary    © Tait Electronics Limited March 2007

network element A network element is any device that is network-connected. A TaitNet digital 
network consists of a number of network elements. The TB9100 base station 
and the P25 Console Gateway are network elements designed and 
manufactured by Tait.

normal squelch A type of squelch operation in which the receiver unmutes on any signal with 
the correct NAC (digital P25) or subaudible signaling (analog FM).

O

octet A set of 8 bits.

outbound Outbound describes the direction of a signal: from a fixed station over the air 
interface to a SU.

over A single transmission, which begins when a user presses PTT and ends when 
the user stops pressing.

P

P25 Project 25. A suite of standards and requirements endorsed by the TIA and 
intended for digital public safety radio communications systems.

P25 Console 
Gateway

A Tait network element that acts as a gateway between an analog dispatch 
console and a channel group.

PA The PA (power amplifier) is a base station module that boosts the exciter output 
to the required transmit level.

packet domain The speech processing area that deals with speech data that has been collected 
up into a packet. IP networks convey packets. The opposite of circuit domain. 

PCB Printed Circuit Board

PMU The PMU (power management unit) is a module in the TB9100 base station 
that provides power to the subrack and monitors power conditions. P25 
Console Gateways can also have a PMU. 

preamble A well-defined signal that is transmitted at the beginning of digital P25 calls to 
facilitate downlink voting and to allow the transmit buffer to fill. 

pre-emphasis Pre-emphasis is a process in the transmitter that boosts higher audio frequencies 
to improve the audio quality. 

privileges A set of access rights to CSS functions. There are Guest, Maintainer, and 
Administrator privileges. 
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program The act of sending a configuration data set from the CSS to the TB9100 base 
station or P25 Console Gateway.

Project 25 A project set up by APCO (the Association of Public Safety Communications 
Officials International), together with other US governmental organizations, to 
develop standards for interoperable digital radios to meet the needs of public 
safety users.

PSTN Public Switched Telephone Network: The public telephone network.

PTT Push To Talk. The button on a SU that keys the transmitter.

Q

QoS Quality Of Service. A router feature that gives real-time data such as voice calls 
priority over other data. 

R

receiver number A unique number assigned to the members of a channel group and used by the 
DFSI interface. 

reciter The reciter is a module of a TB9100 base station that provides both receiver 
and exciter functionality.

repeater talkaround Repeater talkaround allows the SU user to bypass repeater operation and so 
communicate directly with other SUs. While repeater talkaround is active, all 
transmissions are made on the receive frequency programmed for the channel.

reverse tone burst Reverse tone bursts can be used with CTCSS. When reverse tone bursts are 
enabled, the phase of the generated tones is reversed for a number of cycles just 
before transmission ceases. If the receiver is configured for reverse tone burst, it 
responds by closing its gate.

RISC Reduced instruction set computer. A type of microprocessor that recognizes a 
relatively limited number of instructions. The reciter’s digital board and 
network board both have RISC microprocessors.

router A router is an internetwork packet switch that switches data packets from an 
input interface to an output interface. The interfaces can be of different types.

RS-232 A protocol for serial communications between DTE (data terminal equipment) 
and DCE (data communications equipment).

RSSI RSSI (Received Signal Strength Indicator) is a level that indicates the strength 
of the received signal. 
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RTP RTP (Real Time Protocol) is an Internet protocol that supports the real-time 
transmission of voice and data.

Run mode Run mode is the normal operating mode of the TB9100 base station or P25 
Console Gateway.

Rx Receiver.

S

satellite voter A channel group member that has delegated voting activity to a central voter. 

SAW filter Surface Acoustic Wave filter. A band pass filter that can be used to filter both 
RF and IF frequencies. A SAW filter uses the piezoelectric effect to turn the 
input signal into vibrations that are turned back into electrical signals in the 
desired frequency range. 

selectivity The ability of a radio receiver to select the wanted signal and reject unwanted 
signals on adjacent channels (expressed as a ratio). 

selective squelch A type of squelch operation in which the receiver unmutes only on signals that 
are explicitly addressed to that receiver. This can be done through a talk group 
ID or unit ID (digital P25) or through MDC1200 signaling (analog FM).

sensitivity The sensitivity of a radio receiver is the minimum input signal strength required 
to provide a usable signal.

signaling profile A signaling profile is a named set of configuration items related to signaling that 
can be applied to any channel. Items include subaudible signaling and transmit 
timers. 

simplex Able to provide transmission and reception only in one direction at a time.

SINAD SINAD (Signal plus Noise and Distortion) is a measure of signal quality. It is 
the ratio of (signal + noise + distortion) to (noise + distortion). A SINAD of 
12 dB corresponds to a signal to noise ratio of 4:1.

site 1. The base station equipment at a particular location. This includes power 
supplies, transmitters, receivers, network interfaces and controllers. 2. The 
location of that equipment.

SMR Specialized Mobile Radio. A communications system used by police, 
ambulances, taxis, trucks and other delivery vehicles. 

squelch Squelch is a feature of radio equipment. It ensures that the speaker only 
unmutes when a valid signal is received. To be valid, it must, for example, have 
the correct NAC.
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SSRC Synchronization source. The SSRC is a large number specified by the trunking 
controller in its connection message. It uniquely identifies voice streams sent 
from the master base station.

Standby mode Standby mode is a mode of operation in which active service is suspended so 
that special operations can be carried out, such as programming in a new 
configuration or carrying out invasive diagnostic tests. 

SU Abbreviation for subscriber unit. This is the term used in the APCO P25 
standard documents for a two-way radio (generally a mobile or a portable radio) 
conforming to the CAI specifications.

subaudible 
signaling

Subaudible signaling is signaling that is at the bottom end of the range of audible 
frequencies. The TB9100 base station supports CTCSS and DCS subaudible 
signaling. 

subtone A subtone (subaudible signaling tone) is a CTCSS tone or a DCS code. 

supplementary 
service

A term used in the P25 standards. It refers to a group of services that is additional 
to the basic service that a telecommunications network provides. Examples 
include encryption and SU monitoring.

switching range The switching range is the range of frequencies (about 10 MHz) that the radio 
equipment is tuned to operate on. This is a subset of the equipment’s frequency 
band.

syslog protocol syslog is a standard protocol used for the transmission of event notification 
messages across IP networks. TB9100 base stations and P25 Console Gateways 
can send messages such as alarms to an IP address on the TaitNet P25 digital 
network. The base station’s logs store messages in the syslog format. 

syslog collector A program that can receive, display, and log syslog messages from many devices.

T

TaitNet Brand name for any PMR network designed and manufactured by Tait 
Electronics Limited.

TaitNet P25 
network

A set of Tait base stations interconnected by an IP network that can carry voice 
and data traffic. 

TB9100 Base Station A P25-compliant base station consisting of the equipment necessary to receive 
and transmit on one channel. Generally, this means a reciter, a PA, and a PMU. 
Often abbreviated to TB9100 or base station. 

Task action A task action is the second part of a Task Manager task. It specifies what the 
network element must do when the first part (the input) becomes true.
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Task input A task input is the first part of a Task Manager task. It specifies what must 
become true before the network element carries out the second part. 

Task Manager Task Manager is a part of the network element firmware that carries out tasks 
in response to inputs. These tasks are formulated using the CSS.

TCCP Trunking Channel Control Protocol. A proprietary protocol operating over IP 
for the exchange of channel control messages between a TB9100 base station 
and a trunking site controller. 

TCP Transmission Control Protocol. A complex protocol on top of IP for sending 
reliable streams of data with flow control.

TELCO Telephone company.

TIA Telecommunications Industry Association

toggle The term toggle is used to describe the switching between two states. If 
something is on, toggling it turns it off. If it is off, toggling it turns it on.

tone A tone is a sound wave of a particular frequency.

tone remote 
function tone

An audio tone used for signaling to a TB9100 base station or P25 Console 
Gateway on the analog line. 

TSBK A TSBK (trunking signaling block) is an over-the-air message format used in 
digital P25 mode for setting up trunked calls and for supplementary services 
such as messaging and status updates. 

Tx Transmitter.

U

uninhibit A control command that can be sent across the CAI to restore an inhibited SU 
to normal functioning. 

UDP User Datagram Protocol. A simple protocol on top of IP for sending streams of 
data.

uplink The transmission path from SUs to fixed equipment.

UTC Coordinated Universal Time (word order from French). An international time 
standard that has replaced Greenwich Mean Time.
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V

valid signal A valid signal is a signal that the receiver unmutes to. A signal is valid, for 
example, when it is strong enough to be decoded and when it has the specified 
NAC.

vocoder Voice encoder/decoder. A processing element that compresses/decompresses 
the digital voice signal.

voice stream A digitized voice signal that passes through the main switch.

VoIP Voice over IP. The name for the technology that puts speech signals in packets 
and then routes them over an IP backbone network.

voting Voting is the systematic sampling of a group of channels for the channel with 
the greatest signal strength. Voting provides wide-area coverage and ensures 
that as the user moves throughout the coverage area the strongest channel is 
always available for a call.

VPN Virtual private network. A private communications network used to 
communicate confidentially over a non-private network.

VSWR Voltage Standing Wave Ratio (VSWR) is the ratio of the maximum peak 
voltage anywhere on the transmission line to the minimum value anywhere on 
the transmission line. A perfectly matched line has a VSWR of 1:1. A high ratio 
indicates that the antenna subsystem is poorly matched.

W

watchdog A watchdog circuit checks that the system is still responding. If the system does 
not respond (because the firmware has locked up), the circuit generally resets 
the system. 

Z

zeroize To zeroize one or more encryption keys is to render them useless by 
overwriting the key data with zeros. 
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Index

A
access code 12

changing 48
setting up 48

AC-DC converter 77, 87
actions (Task Manager) 198

channel 198
custom 203

Administrator privilege 12
AES encryption

feature license required 14
AGC 110
air intake temperature 75

alarm 149
alarm 9, 141

adjusting thresholds 152, 154
disabling 151
flashing icon 18
monitoring 143
monitoring from CSS 18
sending to central collector 155
Task Manager inputs 188

Alarm Center 155
Alarm status LED 84
analog FM

feature license for 13, 45
receiving 105

analog line
configuring 128
enabling 132
encryption status of 61, 62
encryption warnings 131
feature license for 13, 45
individual ID of 133
locking 200
loopback test 170
measuring level of 170, 170
monitoring 60, 74
monitoring levels 74
monitoring overload 63
monitoring signaling 63
selecting encryption key 133
setting line levels 128
squelch setting 60, 132
test tone 169
testing 169

analog valid 129
monitoring 62

ANI
configuring 131

antenna relay 99
and RF repeat 7, 99
configuring pin 1 as driver for 98

application log 83
application window 25
audio filter 110
audio input

measuring level of 170
audio output

generating 169
automatic gain control 110
auxiliary power output 87, 100

control of 100
monitoring state of 77
testing 177
turning on and off 200

B
base station

broadcasting identity 116
configuring 89
configuring as linking transceiver 117
connecting to 17, 28
different module combinations 38
disconnecting from 32
feature licenses required 44
IP address 119
list of 39
multicast address of 125
name 119
network identity 119
operational state of 65
password 29
programming configuration into 36
receive only 38
resetting 33
testing 159
upgrading firmware 40

basic inputs 183
basic tasks 23
battery

configuring minimum voltage 100
protection mode 147
state of 77
voltage 76
voltage high 147
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voltage low 147
battery backup

testing 176
battery charger

configuring auxiliary power as 100
battery protection mode 100
baud rate, of serial port 98
BER 150

alarm 150
monitoring 55

buffer underflow 59

C
C4FM modulation

testing 167
calibration

date of 85
call alert 97
call records 79
call statistics 82
calling profile 4, 131

enabling 132
monitoring current 60
selecting by tone remote 136
selecting encryption key 133

carrier gating 106
carrier test 166
Celsius 49
central voting 125

feature license for 14, 45
channel 3

adding 95
collective control of 126
current 3
invalid 148
monitoring current settings 53
monitoring dispatcher control of 73
profiles assigned to 4
prohibited frequencies 94
selecting (by Task Manager action) 198
selecting by configuration 95
selecting by digital inputs 95
selection by dispatcher 95, 96

channel coordinator 72
channel group 4, 123

adding 123
checking configuration settings 70
checking membership of 171
checking settings 58
collective control of 126
configuring for digital P25 and/or analog

FM 124

editing 124
locking 201
monitoring 68, 126
monitoring voting 68
multicast address of 125
networking with distributed voter feature li-

cense required 13, 45
port number of 123
sending function code to 202
simplex or duplex 125
testing for presence of other members 171

channel guard see subaudible signaling
channel module 84

see also reciter or gateway module
channel profile 4, 103

adding 104
editing 105

channel seize 129
monitoring 62

channel spacing
of receiver 109
of transmitter 109

channel table 3, 92
adding a channel 95
arrow in 92

CKR 134
coded squelch see DCS code
comment, in Task Manager 187
community name

in SNMP messages 157
compatibility file 40
computed input value 98

using to select channel 95
viewing 173

configuration 20, 89
creating 34
default file location 49
programming into network element 36
programming into newer network element

37
programming into older base station 37
reading 35
reading from newer network element 37
reading from older base station 37
saving to file 35
selecting 91
synchronizing with network element 36
updating after firmware upgrade 43
viewing 20
ways of working with 34

conformance tests 168
conncfg.dat file 39
connecting to base station 17, 28
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failure reasons 31
from networked PC 29

connecting to P25 Console Gateway 28
connection list 39
control channel

configuring microslots for 111
monitoring status of 66, 71
Task Manager input 197

control panel
disabling 102
status of power supply to 77
testing 178
testing LEDs 178

counter
defining 208
Task Manager action 202
viewing 210

crypto module 40
status of 85

CSS 1
accessing forms in 25
application window 25
event log 83
IP address of 28
monitoring alarms 18
monitoring connection speed 29
monitoring interfaces 53
multiple instances 25, 28
starting 25

CTCSS 6, 114
setting deviation of 110

current channel 3
custom action 183

defining 207
viewing 207

custom input 183, 205
defining 206
viewing 205

CWID 116
can interrupt calls 117
locking automatic transmission of 200
monitoring transmission of 57
transmitting (by Task Manager action) 203

D
data

enabling base station for 97
data logging 10, 79
database version 85
dBm, converting to microvolts 108
DC-DC converter 77, 87
DCS code 6, 114

inverted 114
matching base station’s code to radios’ code 6
setting deviation of 110

DCS end tone 115
De pre emph full filter 110
De pre emph speech filter 110
de-emphasis 110
DES encryption

feature license for 13
deviation

measuring 129
reduced by subaudible signaling 110

DFSI interface
channel control 126
enabling and configuring 120
feature license for 14, 45
monitoring 66

diagnosing 21
how to 161
overview 159

digital board
calibration invalid 148
configuration invalid 148

Digital fixed station interface
see DFSI

digital input
using to compute an input value 98
using to select channel 95
viewing state of 171

digital input value 98
viewing 173

digital line
monitoring 58
monitoring packet loss 59
testing 169
testing links 171

digital output
configuring pin 1 as 98
configuring pin 9 as 98
monitoring 172
setting high (Task Manager action) 199
setting low (Task Manager action) 199
testing 172

digital P25
false detection of 113
feature license for 45
receiver squelch for 106
receiving 105

Digital Private Line see DCS code 6
disconnecting from network element 32
dispatcher

call destination of 133
caller ID of 133
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list of groups to belongs to 135
selecting channel 95
selecting groups to belong to 133
specifying call type for 132
voter control 69

dispatcher interface
see DFSI or analog line

distributed voting 125
do now actions (Task Manager) 183
dual mode 105
duty cycle

monitoring 75

E
E & M lines 130

monitoring status 63
testing 172

E line input
monitoring 63
viewing status of 172

emergency alert 96
Emergency LED 61
enabling additional features 43
encryption

feature license for 13
key empty 61
key mismatch 131
status of line input 61
status of line output 62
warnings 131

encryption key
naming 134
present? 134
selecting 133
unused 134
zeroized by firmware upgrade 39
zeroizing 135

end-to-end delay
increased by MDC1200 130

error codes 32
Ethernet cable 28
EVM 70

monitoring 55
exciter, switching range of 84
external reference

alarm 150
specifying frequency of 102

F
Fahrenheit 49

fan
alarms monitored by current channel mod-

ule only 38
configuring operation of 101
failed (PA) 144
failed (PMU) 146
failed (reciter or gateway module) 148
monitoring 74, 78
rotation detector 101
testing 174, 175, 176
testing (Task Manager action) 200
turning on when PA is on 102

fault diagnosis 21
feature enabler 13
feature license

re-enabling 47
feature licenses

determining which are required 44
disabling 46
enabling the feature in configuration 46

features
list of 13

filter, on audio path 110
firmware

downgrading 39
folder for upgrade files 49
updating configuration after upgrade 43
upgrading 40
upgrading zeroizes encryption keys 39
version 85, 86

firmware version 41
flag

defining 208
viewing 210

forms in CSS, accessing 25
forward power 57, 75

low 144
frequency

prohibited 94
function code

sending to channel group 202
function tone

level of 137
monitoring 63, 138
see also tone remote

G
gateway address 120
gateway module

see also reciter
getting started 15
group membership 4, 135
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groups that dispatcher belongs to 135
Guest privilege 12

H
hang time 116
hardware version 85, 86
heartbeat interval 127
heatsink temperature

of PA 174
HLGT

frequency used 137
level of 137
monitoring 138

hysteresis, in receiver gating 107

I
identity

broadcasting 116
impairment 70
Information messages 81
inhibit 97
initial delay 122

monitoring 59
inputs (Task Manager) 188

alarm 188
Analog line 191
custom 205

invalid channel 53
inverted DCS code 114
IP address

of channel group 58, 125
of CSS 28
of network element 119

isolated control channel 66, 71
isolated traffic channel 66, 71
isolator 86

J
jitter 59

alarm 150
alarm threshold 154

jitter buffer 122
configuring 122
monitoring 59

K
kernel 85

upgrading 42
kernel version 40
Key empty 61
key loading

feature license required for 13
key mismatch 131
key missing 61
key present? 134
keytone

using to signal channel seize 130

L
license file, folder to store in 49
license key 43
licensing features 13
line level 128

and deviation measurement 129
monitoring 62
of MDC1200 signaling 130

line signaling
monitoring 63

link delay
estimating 171

linking infrastructure
options for speech transport 124

LLGT
frequency used 137
level of 137
monitoring 63, 138
using to signal channel seize 130

lock 209
lock actions (Task Manager) 183, 200
lock inputs 183
lock range 84

determining 165
log files, location of 49
Logic box 107
loopback test 170

M
M line output

monitoring 63
testing 172

mains supply
simulating failure 176
state of 77

Maintainer privilege 12
Max Tx deviation box 109
MDC1200

enabling 130
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feature license for 13
increases end-to-end delay 130
line level of 130
monitoring 63
monitoring from CSS 131

MDC1200 signaling on analog line
feature license for 45

message 97
microphone

disabling 102
testing microphone channel switch 178
testing PTT operation 178

microslots per slot 111
microvolts, converting to dBm 108
mid band 109
mode

changing 32
viewing current 27

modulation fidelity test pattern 168
modules

testing 174
Monitor LED 63
monitor squelch 5

collective control of
 126

monitoring 19, 51
gateway module 74
interfaces 53
PA 75
PMU 76
reciter 74

Morse code 116
multicast address 125
multiple block trunking packets 111

N
NAC

configuring 112, 113
locking the decoding of 201
monitoring received 54
monitoring transmitted 56

narrow band 109
navigation pane 19, 25

red item in 161
network board

calibration invalid 148
configuration invalid 148

network element 38
see also base station or P25 Console Gateway

Network Element Thresholds form 152
network identity 119

gateway address may be required 120
network link

monitoring 58
Network Thresholds form 154
networking with centralized voter feature li-

cense 45
networking with distributed voter feature li-

cense 13, 45
No key message 62
no license 61, 62
noise gating 106
normal squelch 5
notch filter 137

O
operating channel 95
operating system kernel version 85
output current 78
output voltage 78

P
P25 AES encryption feature license 14, 45
P25 base encryption and key loading feature li-

cense 13
P25 base encryption feature license 45
P25 common air interface

feature license for 13, 45
P25 Console Gateway 11

channel table in 3
configuring 89
crypto module version 40
feature licenses required 45
using CSS with 38
see also base station

PA
alarms 144
calibration invalid 144
configured power output 93
current alarms 145
disabling alarm if not present 38
firmware invalid 144
invalid hardware configuration 145
monitoring 75
monitoring air intake temperature 75
monitoring duty cycle 75
monitoring temperature of 174
not detected 144
power foldback 145
power rating 86
serial number 86
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shutdown 145
state of power supply to 77
supply voltage alarms 145
temperature 75
temperature alarms 146
testing fault LED 174
version 86
viewing information on 85

packet data
configuring timers 127
feature license for 13

packet loss 59
alarm 150
alarm threshold 154

padlock icon 209
paging 97
password access to base station

new network element has null password 29
password access to network element 33
patch cable 28
ping command

sending from network element 171
PMU

alarms 146
auxiliary power output 100
configuring shutdown voltage 100
current high 147
fan failed 146
firmware invalid 146
mains failed 146
monitor only from channel module 1 38
monitoring 76
monitoring fan 78
monitoring output 78
not detected 146
powerup fault 146
product code 87
serial number 87
shutdown imminent 146
submodules in 87
temperature high 147
testing fault LED 177
version 88
viewing information on 87
voltage high 147
voltage low 147

port number 123
power output

configured value 93
monitoring 75
of PA 75
to channel module 77
to PA 77

Power shutdown voltage box 100

Power startup voltage box 100
preamble 122

antenna relay may affect 122
pre-emphasis 110
presence check 97
Private Line see CTCSS tone
privilege 12

changing 47
obtaining 47

product code 87
profiles 4
programming configuration 36

Q
quality of service

alarms 150
monitoring 58

R
Read icon 35
receive filter 110
receiver

channel spacing 109
current status 53
lock range 165
locking 201
logging raw C4FM data 168
measuring received signal level 164
operating without a configuration 162
selecting mode 105
switching range 85
testing 162
testing sensitivity 163

Receiver channel box 109
receiver gating 106
receiver number 120

monitoring 69
of network element providing the signal 57

receiver squelch 5, 106
reciter

alarms 147
lock range 165
monitoring operational information on 74
power up failure 148
serial numbers of 85
state of power supply to 77
temperature high 148
version 85
viewing information on 84

remote monitor 97
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resetting the network element 33
reverse power 57, 75
reverse power high 145
reverse tone burst 115
RF interface

configuring 103
monitoring 53
testing 162

RF linking 117
RF repeat function 7

affected by channel group 7
and antenna relay 7
collective control of 126
configuring 7, 93
controlling by dispatcher 93
enabling via Task Manager 201
monitoring 56
monitoring (analog line) 60
state of 73

RF Rx impairment 70
RSSI

monitoring 55, 74
RSSI gating 106
RSSI output 99

configuring Pin 9 as 98
Run mode 32

troubleshooting 32

S
satellite voter 68
scanning repeater (Task Manager code) 204
security 12
selective squelch 5
serial number 85, 87
serial port 98
service profile 4, 96

monitoring current 61
signal level

measuring across band 164
signal quality 70
signaling profile 4, 111

adding 112
editing 113

simplex operation 99
simulcast transmitter feature license 14
SINAD

input into voting 70
measurement method 163
monitoring 55, 74

SINAD gating 106
site controller present

Task Manager input 197
skew 70
SNMP 157

configuring agent 157
feature license for 14, 45

Soft-off time 116
software feature enabler 13, 43
speaker

disabling 102
testing 178

speech band filter 110
speech transport over digital line 124
squelch 5, 60, 106, 132
squelch tail 115
SSRC 67
Standby converter 87

state of DC supply to 77
Standby mode 32
status bar 27
Status form 143
status report 97
status request 97
status symbol 111
subaudible band filter 110
Subaudible deviation 110
subaudible signaling 6

locking 201
monitoring received 54
monitoring transmitted 57

subnet mask 120
subtone 6, 114
switching range

determining 165
exciter 84
receiver 85
when last altered 85

synchronizing a configuration file 36
synthesizer

alarm 148
determining lock range 165
out of lock 148

syslog collector 155
system alarms 149
System Interface form 97
system log 10, 80

sending to central collector 155

T
tail timers 115
task

adding 186
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disabling 187
task list 184
Task Manager 8, 179

actions 183
adding comments 187
adding tasks 186
basic inputs 183
custom actions 203
customizing 205
disabling tasks 187
example tasks 204
examples 204
input types 183
inputs 188
introduction 181
lock inputs 183
processing cycle 182
rules 181
viewing locks 209

TCCP interface 126
monitoring 64

temperature
monitoring on PA 174
monitoring on reciter 74
of PA 75
threshold for turning PA fan on 101

temperature alarm
air intake 149

temperature display 49
test tone frequency 129
test tone, generating 169
testing 21

audio output 169
auxiliary power output 177
battery backup 176
control panel 178
digital I/O 171
fan 174, 175, 176
lock range 165
PA fault LED 174
PMU fault LED 177
transmitter 166

timer
defining (Task Manager) 208
starting (by Task Manager action) 203
stopping (by Task Manager action) 203
viewing 210

tone remote
feature licenses required for 45
frequency used 137
making compatible with console system 136
mapping commands to calling profiles 136
monitoring 63, 138
notch filter 137

using to signal channel seize 130
toolbar 26
trace log 10, 81
traffic channel

monitoring status of 66, 71
transmit buffer

monitoring 59
transmit enable feature license 13, 45
transmit filter 110
transmit frequency 93
transmit holdoff 122
transmit tail

monitoring 57
transmit timers 115
transmitter

carrier test 166
disabling 110
FM transmission test 167
initial delay 122
locking 201
maximum deviation 109
monitoring 55
power output 75
source of 57
testing 166
testing C4FM modulation 167
testing conformance to P25 standard 168

trunking
configuring channel group members for 93
enabling TCCP connection to site controller

126
feature license for 13, 45
operational state of 65
setting microslots per slot 111
Task Manager inputs for 197

trunking controller
monitoring connection to 64

trunking interface
see TCCP

trunking master
enabling 13

truth table 206
TSBK

feature licenses required for 45
monitoring sending and receiving 67

U
uninhibit 97
unused keys 134
upgrading

kernel 42
network element firmware 40
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V
version mismatch 36, 37
version number

of channel module 85
of PA 86
of PMU 88

voice delay 122
voice drop-outs

caued by viewing call records 79
caused by viewing system log 80

voice service
configuring 121
monitoring (DFSI interface) 67
monitoring (TCCP interface) 64

voltage
shutdown threshold 100

voter control 69, 73
voting

configuration options 125
monitoring 68

VSWR 57, 145
monitoring 75

W
warn on clear speech 131
warn on key mismatch 131
wide band 109

Z
zeroizing keys 135
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Tait General Software Licence Agreement

This legal document is an Agreement between you (the 
“Licensee”) and Tait Electronics Limited (“Tait”). By using any 
of the Software or Firmware items prior-installed in the related 
Tait product, included on CD or downloaded from the Tait 
website, (hereinafter referred to as “the Software or Firmware”) 
you agree to be bound by the terms of this Agreement. If you do 
not agree to the terms of this Agreement, do not install and use 
any of the Software or Firmware. If you install and use any of the 
Software or Firmware that will be deemed to be acceptance of the 
terms of this licence agreement.
The terms of this Agreement shall apply subject only to any 
express written terms of agreement to the contrary between Tait 
and the Licensee.

Licence
TAIT GRANTS TO YOU AS LICENSEE THE NON-EXCLUSIVE 
RIGHT TO USE THE SOFTWARE OR FIRMWARE ON A SINGLE 
MACHINE PROVIDED YOU MAY ONLY:
1. COPY THE SOFTWARE OR FIRMWARE INTO ANY MACHINE 
READABLE OR PRINTED FORM FOR BACKUP PURPOSES IN 
SUPPORT OF YOUR USE OF THE PROGRAM ON THE SINGLE 
MACHINE (CERTAIN PROGRAMS, HOWEVER, MAY INCLUDE 
MECHANISMS TO LIMIT OR INHIBIT COPYING, THEY ARE 
MARKED “COPY PROTECTED”), PROVIDED THE COPYRIGHT 
NOTICE MUST BE REPRODUCED AND INCLUDED ON ANY SUCH 
COPY OF THE SOFTWARE OR FIRMWARE; 
AND / OR

2. MERGE IT INTO ANOTHER PROGRAM FOR YOUR USE ON 
THE SINGLE MACHINE (ANY PORTION OF ANY SOFTWARE OR 
FIRMWARE MERGED INTO ANOTHER PROGRAM WILL 
CONTINUE TO BE SUBJECT TO THE TERMS AND CONDITIONS 
OF THIS AGREEMENT).

THE LICENSEE MAY NOT DUPLICATE, MODIFY, REVERSE 
COMPILE OR REVERSE ASSEMBLE ANY SOFTWARE OR 
FIRMWARE IN WHOLE OR PART.

Important Notice
THE SOFTWARE OR FIRMWARE MAY CONTAIN OPEN SOURCE 
SOFTWARE COMPONENTS (“OPEN SOURCE COMPONENTS”). 
OPEN SOURCE COMPONENTS ARE EXCLUDED FROM THE 
TERMS OF THIS AGREEMENT EXCEPT AS EXPRESSLY STATED IN 
THIS AGREEMENT AND ARE COVERED BY THE TERMS OF THEIR 
RESPECTIVE LICENCES WHICH MAY EXCLUDE OR LIMIT ANY 
WARRANTY FROM OR LIABILITY OF THE DEVELOPERS AND/OR 
COPYRIGHT HOLDERS OF THE OPEN SOURCE COMPONENT 
FOR THE PERFORMANCE OF THOSE OPEN SOURCE 
COMPONENTS. YOU AGREE TO BE BOUND BY THE TERMS AND 
CONDITIONS OF EACH SUCH LICENCE. FOR MORE 
INFORMATION SEE:
http://support.taitworld.com/go/opensource

Title to Software 
THIS AGREEMENT DOES NOT CONSTITUTE A CONTRACT OF 
SALE IN RELATION TO THE SOFTWARE OR FIRMWARE SUPPLIED 
TO THE LICENSEE. NOT WITHSTANDING THE LICENSEE MAY 
OWN THE MAGNETIC OR OTHER PHYSICAL MEDIA ON WHICH 
THE SOFTWARE OR FIRMWARE WAS ORIGINALLY SUPPLIED, OR 
HAS SUBSEQUENTLY BEEN RECORDED OR FIXED, IT IS A 
FUNDAMENTAL TERM OF THIS AGREEMENT THAT AT ALL 
TIMES TITLE AND OWNERSHIP OF THE SOFTWARE OR 
FIRMWARE, WHETHER ON THE ORIGINAL MEDIA OR 
OTHERWISE, SHALL REMAIN VESTED IN TAIT OR THIRD 
PARTIES WHO HAVE GRANTED LICENCES TO TAIT.

Term and Termination 
THIS LICENCE SHALL BE EFFECTIVE UNTIL TERMINATED IN 
ACCORDANCE WITH THE PROVISIONS OF THIS AGREEMENT. 
THE LICENSEE MAY TERMINATE THIS LICENCE AT ANY TIME BY 
DESTROYING ALL COPIES OF THE SOFTWARE OR FIRMWARE 
AND ASSOCIATED WRITTEN MATERIALS. THIS LICENCE WILL BE 
TERMINATED AUTOMATICALLY AND WITHOUT NOTICE FROM 
TAIT IN THE EVENT THAT THE LICENSEE FAILS TO COMPLY 
WITH ANY TERM OR CONDITION OF THIS AGREEMENT. THE 
LICENSEE AGREES TO DESTROY ALL COPIES OF THE SOFTWARE 
OR FIRMWARE AND ASSOCIATED WRITTEN MATERIALS IN THE 
EVENT OF SUCH TERMINATION.

Limited Warranty 
THE SOFTWARE OR FIRMWARE (INCLUDING OPEN SOURCE 
COMPONENTS) IS SUPPLIED BY TAIT AND ACCEPTED BY THE 
LICENSEE “AS IS” WITHOUT WARRANTY OF ANY KIND EITHER 
EXPRESSED OR IMPLIED, INCLUDING BUT NOT BEING LIMITED 
TO ANY IMPLIED WARRANTIES AS TO MERCHANTABILITY OR 
FITNESS FOR ANY PARTICULAR PURPOSE. THE LICENSEE 
ACKNOWLEDGES THAT THE SOFTWARE OR FIRMWARE 
(INCLUDING OPEN SOURCE COMPONENTS) IS USED BY IT IN 
BUSINESS AND ACCORDINGLY TO THE MAXIMUM EXTENT 
PERMITTED BY LAW NO TERMS OR WARRANTIES WHICH ARE 
IMPLIED BY LEGISLATION SHALL APPLY TO THIS AGREEMENT. 
TAIT DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED 
IN THE SOFTWARE OR FIRMWARE (INCLUDING OPEN SOURCE 
COMPONENTS) WILL MEET THE LICENSEE’S REQUIREMENTS OR 
THAT THE OPERATION OF THE SOFTWARE OR FIRMWARE 
(INCLUDING OPEN SOURCE COMPONENTS) WILL BE 
UNINTERRUPTED OR ERROR FREE.

Exclusion of Liability
IN NO CIRCUMSTANCES SHALL TAIT BE UNDER ANY LIABILITY 
TO THE LICENSEE, OR ANY OTHER PERSON WHATSOEVER, 
WHETHER IN TORT (INCLUDING NEGLIGENCE), CONTRACT 
(EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT), 
EQUITY, UNDER ANY STATUTE, OR OTHERWISE AT LAW FOR 
ANY LOSSES OR DAMAGES WHETHER GENERAL, SPECIAL, 
EXEMPLARY, PUNITIVE, DIRECT, INDIRECT OR 
CONSEQUENTIAL ARISING OUT OF OR IN CONNECTION WITH 
ANY USE OR INABILITY OF USING THE SOFTWARE OR 
FIRMWARE (INCLUDING OPEN SOURCE COMPONENTS).

THE LICENSEE’S SOLE REMEDY AGAINST TAIT WILL BE LIMITED 
TO BREACH OF CONTRACT AND TAIT’S SOLE AND TOTAL 
LIABILITY FOR ANY SUCH CLAIM SHALL BE LIMITED AT THE 
OPTION OF TAIT TO THE REPAIR OR REPLACEMENT OF THE 
SOFTWARE OR FIRMWARE OR THE REFUND OF THE PURCHASE 
PRICE OF THE SOFTWARE OR FIRMWARE.

General
THE LICENSEE CONFIRMS THAT IT SHALL COMPLY WITH THE 
PROVISIONS OF LAW IN RELATION TO THE SOFTWARE 
OR FIRMWARE.

Law and Jurisdiction 
THIS AGREEMENT SHALL BE SUBJECT TO AND CONSTRUED IN 
ACCORDANCE WITH NEW ZEALAND LAW AND DISPUTES 
BETWEEN THE PARTIES CONCERNING THE PROVISIONS 
HEREOF SHALL BE DETERMINED BY THE NEW ZEALAND 
COURTS OF LAW. PROVIDED HOWEVER TAIT MAY AT ITS 
ELECTION BRING PROCEEDINGS FOR BREACH OF THE TERMS 
HEREOF OR FOR THE ENFORCEMENT OF ANY JUDGEMENT IN 
RELATION TO A BREACH OF THE TERMS HEREOF IN ANY 
JURISDICTION TAIT CONSIDERS FIT FOR THE PURPOSE OF 
ENSURING COMPLIANCE WITH THE TERMS HEREOF OR 
OBTAINING RELIEF FOR BREACH OF THE TERMS HEREOF.

No Dealings 
THE LICENSEE MAY NOT SUBLICENSE, ASSIGN OR TRANSFER 
THE LICENCE OR THE PROGRAM EXCEPT AS EXPRESSLY 
PROVIDED IN THIS AGREEMENT. ANY ATTEMPT OTHERWISE TO 
SUBLICENSE, ASSIGN OR TRANSFER ANY OF THE RIGHTS, 
DUTIES OR OBLIGATIONS HEREUNDER IS VOID.

No Other Terms 
THE LICENSEE ACKNOWLEDGES THAT IT HAS READ THIS 
AGREEMENT, UNDERSTANDS IT AND AGREES TO BE BOUND BY 
ITS TERMS AND CONDITIONS. THE LICENSEE FURTHER AGREES 
THAT SUBJECT ONLY TO ANY EXPRESS WRITTEN TERMS OF 
AGREEMENT TO THE CONTRARY BETWEEN TAIT AND THE 
LICENSEE THIS IS THE COMPLETE AND EXCLUSIVE STATEMENT 
OF THE AGREEMENT BETWEEN IT AND TAIT IN RELATION TO 
THE SOFTWARE OR FIRMWARE WHICH SUPERSEDES ANY 
PROPOSAL OR PRIOR AGREEMENT, ORAL OR WRITTEN AND 
ANY OTHER COMMUNICATIONS BETWEEN THE LICENSEE AND 
TAIT RELATING TO THE SOFTWARE OR FIRMWARE.
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